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மநல்஥ில஬ ப௃த஬ாம் ஆண்டு – கணி஦ி ஧னன்஧ாடுகள் 
஧ாைம் 1 . கணி஦ி அ஫ிப௃கம் 

சரினா஦ யிலைலனமதர்ந்ததடுத்து எழுதுக: 
1. ன௅தல் தல஬ன௅ல஫ கணிப்ப஧ள஫ழக஭ில் ஧னன்஧டுத்தப்஧ட்ட ஧குதழப்ப஧ளன௉ள்  

(அ) தயற்஫ிைக் குமல்   (ஆ) தழரிதலடனகம்  
(இ) என௉ங்கழலணந்தச் சுற்றுகள்  (ஈ) நுண்பென஬ழகள் 

2. தற்கள஬ழக ஥ழல஦யகம் ஋து?  
(அ) ROM  (ஆ) PROM  (இ) RAM  (ஈ) EPROM 

3. பய஭ினடீ்டு ெளத஦த்லத அலடனள஭ம் களண்க.  
(அ) யிலெப்஧஬லக  (ஆ) ஥ழல஦யகம்  (இ) திலபனகம்  (ஈ) சுட்டி 

4. உள்஭டீ்டு ெளத஦த்லத அலடனள஭ம் களண்க 
(அ) அச்சுப்ப஧ள஫ழ  (ஆ) சுட்டி   (இ) யலபயி   (ஈ) ஧டயழீ்த்தழ  

5. கட்டிட யலப஧டத் தழட்டம், ஧ி஭க்ஸ் அட்லட க஧ளன்஫யற்ல஫ அச்ெழடப் ஧னன்஧டும் 
பய஭ினடீ்டு ெளத஦ம் ஋து?  
(அ) பயப்஧அச்சுப்ப஧ள஫ழ   (ஆ) யலபயி  
(இ) ன௃ள்஭ி அச்சுப்ப஧ள஫ழ   (ஈ) லந஧சீ்சு அச்சுப்ப஧ள஫ழ  

6. ஌.டி.஋ம் இனந்தழபங்க஭ில், கவழ்க்கண்டயற்றுள் ஋து ஧னன்஧டுத்தப்஧டுகழ஫து?  
(அ) ததாடுதிலப  (ஆ) தழலபனகம்  (இ) எ஬ழ ப஧ன௉க்கழ  (ஈ) அச்சுப்ப஧ள஫ழ 

7. என௉ கணிப்ப஧ள஫ழ நீண்டும் பதளடங்கும் க஧ளது ஋ந்த யலகனள஦ 
பதளடங்குதல஬ப் ஧னன்஧டுத்துகழ஫து.  
அ) உைன் ததாைக்கம்   (ஆ) தண் பதளடக்கம்  
(இ) பதளடு பதளடக்கம்   (ஈ) பநய் பதளடக்கம் 

8. POST ” ன் யிரியளக்கம்.  
(அ) Post on self Test   (ஆ) Power on Software Test  
(இ) Power on Self Test  (ஈ) Power on Self Text 

9. கவழ்யன௉ய஦யற்றுள் ஋து என௉ ன௅தன்லந ஥ழல஦யகநளகும்?  
(அ) ROM   (ஆ) RAM  (இ) Flash drive  (ஈ) Hard disk 

10. ஋ந்த கணிப்ப஧ள஫ழ தல஬ன௅ல஫னில் என௉ங்கழலணந்தசுற்றுகள் 
஧னன்஧டுத்தப்஧ட்டது?  
(அ) ன௅த஬ளம்  (ஆ) இபண்டளம் (இ) ப௄ன்஫ாம் (ஈ) ஥ளன்களம் 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ி என்஫ால் என்஦ ? 

 கணிப்ப஧ள஫ழ ஋ன்஧து, பகளடுக்கப்஧ட்ட கட்டல஭கல஭ உள்஭டீளகப் ப஧ற்று, 
அதழகயகநளகச் பெனல்஧ட்டு, யின௉ம்஧ின பய஭ினடீ்லட யமங்கும் என௉ 
நழன்஦ணு ெளத஦ம் ஆகும். 

2. தபவு நற்றும் தகயல் மயறு஧டுத்துக. 
தபவு தகயல் 

஧ல்கயறு யலகக஭ிலும் தழபட்டப்஧டும் 
பெனற்஧டுத்தப்஧டளத அடிப்஧லட 
பெய்தழத் துணுக்கு தபவு ஋஦ப்஧டும். 

தகயல் ஋ன்஧து ன௅டிவுகல஭ 
஋டுக்கக்கூடின உண்லநக஭ின் 
பதளகுப்஧ளகும். 

(஋.கள) அன௉ண், 16 (஋.கள) அன௉ணின் யனது 16 
3. லநனச்தசன஬கத்தின் (CPU) ஧குதிகள் னாலய? 

 லநனச்பென஬கத்தழல் னென்று ஧குதழகள் உள்஭஦, அலய  
 கட்டுப்஧ளட்டகம் (CU - ControlUnit),  
 கணித ஌பணச் பென஬கம் (ALU - Arithmetic and Logic Unit) நற்றும்  
 ஥ழல஦யகம் (MU - Memory Unit) ஆகும்.  

4. கணித ஏபண தசன஬கத்தின் (ALU) தசனல்஧ாடு னாது? 

 லநனச்பென஬கத்தழன் என௉ ஧குதழனளக உள்஭ கணித ஌பணச் பென஬கம், 
கூட்டல், கமழத்தல், ப஧ன௉க்கல், யகுத்தல் நற்றும் தன௉க்க பெனல்கள் க஧ளன்஫ 
கணிதச் பெனல்஧ளடுகல஭க் தபயின் நீது ஥ழகழ்த்துகழ஫து. 

5. கட்டுப்஧ாட்ைகத்தின் தசனல்கல஭ எழுதுக. 
 லநனச்பென஬கம் - ஥ழல஦யகம் நற்றும் உள்஭டீு பய஭ினடீு ெளத஦ங்கல௃க்கு 

இலடகன ஧ரிநள஫ப்஧டும் தபலயக் கட்டுப்஧ளட்டகம் கட்டுப்஧டுத்துகழ஫து. கநலும், 
கணிப்ப஧ள஫ழனின் ன௅ழுச் பெனல்஧ளடுகல஭னேம் இது கட்டுப்஧டுத்துகழ஫து. 

6. ஥ில஦யகத்தின் தசனல்஧ாடு னாது? 
 ஥ழல஦யகம், பென஬ளக்கத்தழன் க஧ளது தபவு நற்றும் கட்டல஭கல஭ 

தற்கள஬ழகநளக கெநழத்து லயக்கழ஫து. 
7. உள்஭டீ்ைகம் நற்றும் தய஭ினீட்ைகம் மயறு஧டுத்துக. 

உள்஭டீ்ைகம் தய஭ினீட்ைகம் 
அல஦த்து யலகனள஦ தபவுகல஭னேம் 
கணிப்ப஧ள஫ழக்குள் உள்஭ிடப் 
஧னன்஧டுகழ஫து. உள்஭ிடப்஧ட்ட தபவுகள் 
பென஬ளக்கத்தழற்களக ஥ழல஦யகத்தழல் 
கெநழக்கப்஧டுகழன்஫஦.  
஋.கள: யிலெப்஧஬லக, சுட்டி க஧ளன்஫லய. 

஧ன஦ர்கள் ன௃ரிந்து பகளள்஭க்கூடின 
யலகனில் தகயல஬த் பதரியிக்கும் 
஋ந்தபயளன௉ யன்ப஧ளன௉ல௃ம் பய஭ினடீ்டகம் 
஋஦ப்஧டும். 
஋.கள: தழலபனகம், அச்சுப்ப஧ள஫ழ 
க஧ளன்஫லய. 

8. ப௃தன்லந ஥ில஦யகம் நற்றும் இபண்ைாம் ஥ில஬ ஥ில஦யகம் மயறு஧ாடு னாது? 

ப௃தன்லந ஥ில஦யகம் இபண்ைாம் ஥ில஬ ஥ில஦யகம் 

கட்டல஭கள் ஥ழல஫கயற்஫த் தனளபளக 
இன௉க்கும் க஧ளது தபவு நற்றும் 
஥ழபல்கல஭த் தற்கள஬ழகநளகச் கெநழக்க 
ன௅தன்லந ஥ழல஦யகம் ஧னன்஧டுகழ஫து.  
஋.கள: க஥படி அணுகல் ஥ழல஦யகம் 
(RAM - Random Access Memory) 

தபவுகல஭ ஥ழபந்தபநளகச் கெநழத்து 
லயக்க இபண்டளம் ஥ழல஬ ஥ழல஦யகம் 
஧னன்஧டுகழ஫து. 
஋.கள: யன் யட்டு (Hard disk), குறுயட்டு 
(CD-ROM) நற்றும் டியிடி கபளம் (DVD 
ROM) க஧ளன்஫லய. 
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3 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ினின் தன்லநகள் னாலய? 

 கயகம்  *  ஧ிலமனின்லந   *  ஥ழல஦யகத்தழ஫ன்  
 துல்஬ழனம் *  கெளர்யின்லந  *    ஧ல்யலக பென஬ளக்கத்தழ஫ன் 

2. கணிப்த஧ா஫ினின் ஧னன்஧ாடுகல஭ எழுதுக. 
 கணிப்ப஧ள஫ழகள் தபவுகல஭ச் கெநழக்க ஧னன்஧டுகழ஫து. 

 கல்யி, ஆபளய்ச்ெழ, சுற்று஬ள, ெனெக யல஬த஭ம், நழன் யணிகம் க஧ளன்஫ ஧ல்கயறு 

துல஫க஭ில் கணிப்ப஧ள஫ழகள் ஥ீங்கள இடம் ப஧ற்றுள்஭஦. 

 யள஦ில஬ ன௅ன்஦஫ழயிப்ன௃, யிநள஦ம், பனில் க஧ளக்குயபத்து ஧னணச்ெவடடு 

ன௅ன்஧தழவு, தழலபனபங்கு நுலமவுச்ெவடடு ன௅ன்஧தழவு  க஧ளன்஫ ஧஬ ஧ணிகல஭னேம், 

யில஭னளடடு நற்றும் இதப ப஧ளழுதுக஧ளக்கு அம்ெங்கல஭னேம் பெய்னேம் ஧ல்தழ஫ன் 

ப஧ற்஫லயனளக உள்஭து. 

3. உள்஭டீ்டு சாத஦ங்கள் என்஫ால் என்஦? இபண்டு எடுத்துக்காட்டுகள் 
தருக. 
 அல஦த்து யலகனள஦ தபவுகல஭னேம் கணிப்ப஧ள஫ழக்குள் உள்஭ிட 

஧னன்஧டுத்தும் ெளத஦ங்கள் உள்஭டீ்டுச் ெளத஦ங்கள் ஋஦ப்஧டும். 
஋.கள: Éir¥gyif, R£o. 

4. ஏமதனும் ப௄ன்று தய஭ினீட்டு சாத஦ங்கல஭ யி஭க்குக. 

 அச்சுப்த஧ா஫ிகள்: தளள்க஭ில் தகயல்கல஭ அச்ெழட  ஧னன்஧டுத்தப்஧டுகழ஫து.  
யலககள்: தட்டல் அச்சுப்ப஧ள஫ழகள், தட்டள அச்சுப்ப஧ள஫ழகள்  

 யலபயி: தளள்க஭ில் யலபகல஬ பய஭ினடீ்லட அச்ெழட ஧னன்஧டுகழ஫து. இது 
஧டங்கல஭ யலபன எற்ல஫ ஥ழ஫ம் அல்஬து ஧஬ யண்ணம் பகளண்ட 
க஧஦ளக்கல஭ ஧னன்஧டுத்துகழ஫து. 

 ஧ல்லூைகப்஧ையழீ்த்தி: கணிப்ப஧ள஫ழ தழலபனக பய஭ினடீ்லடப் ப஧ரின 
தழலபனில் தழலபனிடப் ஧னன்஧டுகழன்஫து. இலயகள் யகுப்஧ல஫க஭ில் அல்஬து 
கூட்ட அபங்குக஭ில் யி஭க்கக் களட்ெழகல஭க் களட்ெழப்஧டுத்தப் 
஧னன்஧டுத்தப்஧டுகழன்஫஦. 

5. ஒ஭ினினல் சுட்டி நற்றும் ம஬சர் சுட்டி மயறு஧டுத்துக. 
ஒ஭ினினல் சுட்டி ம஬சர் சுட்டி 

சுட்டி ஥கர்யலத தீர்நள஦ிக்க எ஭ி 
஧னன்஧டுத்தப்஧டுகழ஫து. 

அகச்ெழயப்ன௃ கதழர்கல஭ 

஧னன்஧டுத்துகழ஫து. 

இதழல் னென்று ப஧ளத்தளன்கள் உள்஭஦. அதழக஭யளக 12 ப஧ளத்தளன்கள் யலப 

இன௉க்கும். 

குல஫யள஦ உணர்தழ஫ன் பகளண்டது. நழகுந்த உணர்தழ஫ன் பகளண்டது. ஋ந்த 

கடி஦நள஦ கநற்஧பப்஧ிலும் பெனல்஧டும். 

6. தட்ைல்யலக அச்சுப்த஧ா஫ிலனப் ஧ற்஫ி கு஫ிப்பு யலபக. 

 தட்டல்யலக அச்சுப்ப஧ள஫ழனில் என௉ ெழறு கம்஧ி, லந நாடா (ribbon) நீது தட்டி என௉ 

ன௃ள்஭ிலன ஌ற்஧டுத்தும் அல்஬து என௉ ன௅ழு ஋ழுத்லத தட்டி அந்த ஋ழுத்லத 
஌ற்஧டுத்தும்.  

 இந்த அச்சுப்ப஧ள஫ழகள் இனந்தழப அழுத்தத்லதப் ஧னன்஧டுத்தழ எகப ெநனத்தழல் ஧஬ 
஧டிகள் ஋டுக்க யலக பெய்கழ஫து.  

எ.கா: யரி அச்சுப்ப஧ள஫ழ நற்றும் யரின௃ள்஭ி அச்சுப்ப஧ள஫ழ  
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7. ஆ஫ாயது தல஬ப௃ல஫னின் தன்லநகல஭ ஧ற்஫ி சிறு கு஫ிப்பு யலபக. 
 பெனற்லக ஥பம்஧ினல் யல஬னலநப்஧ின் அடிப்஧லடனில் ஆ஫ளயது 

தல஬ன௅ல஫ கணிப்ப஧ள஫ழகள், அ஫ழவு ெளர்ந்த கணிப்ப஧ள஫ழகள் ஋஦ 
யலபனறுக்கப்஧டுகழ஫து.  

 ஆ஫ளயது தல஬ன௅ல஫ கணிப்ப஧ள஫ழக஭ின் யினத்தகு நளற்஫ங்க஭ில் என்று 
஧பந்த யல஬னலநப்஧ின் ய஭ர்ச்ெழ ஆகும்.  

 இனற்லக பநளமழ பென஬ளக்கம் ஋ன்஧து பெனற்லக நுண்ண஫ழயின் என௉ 
அங்கநளகும். இது ந஦ித பநளமழலனப் ன௃ரிந்து பகளள்஭க் கூடின என௉ 
கணிப்ப஧ள஫ழ ஥ழபல஬ உன௉யளக்குயதற்கள஦ தழ஫ல஦ யமங்குகழ஫து. 

8. திலபனகத்தின் கு஫ிப்஧ிைத்தக்க சி஫ப்஧ினல்புகல஭ ஧ற்஫ி எழுதுக. 
 தகயல஬ தழலபனில் களட்ட ப஧ளதுயளகப் ஧னன்஧டுத்தப்஧டும் பய஭ினடீ்டு 

ெளத஦ம் தழலபனகம் ஆகும். இது பதளல஬க்களட்ெழ ப஧ட்டிலனப் க஧ளன்஫து.  
 தழலபனகத்தழல் ஧டங்கள் ஧ிக்பெல்ஸ் (PIXELS) ஋஦ப்஧டும் ஧டக் கூறுகல௃டன் 

உன௉யளக்கப்஧டுகழன்஫஦.  
 எகப யண்ணன௅லடன தழலபனகம் கன௉ப்ன௃ நற்றும் பயள்ல஭ ஥ழ஫த்தழல் 

களட்டுகழ஫து. யண்ணத் தழலபனகம் ஧஬ ஥ழ஫ங்க஭ில் களட்டுகழ஫து.  
 தழலபனகம் தகயல஬ யிஜழ஌ -VGA (Video Graphics Array) னெ஬ம் தழலபனில் 

களட்டுகழ஫து. 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஒரு கணிப்த஧ா஫ினின் அடிப்஧லை ஧ாகங்கல஭ தத஭ியா஦ 

யி஭க்கப்஧ைத்துைன் யி஭க்குக. 
 கணிப்ப஧ள஫ழனில், பகளடுக்கப்஧ட்ட எவ்பயளன௉ ஧ணினேம், உள்஭டீு- 

பென஬ளக்கம்-பய஭ினடீு ஋ன்஫ சுமற்ெழலன அடிப்஧லடனளகக் பகளண்டு 
பென஬ளற்றுகழ஫து. 

 
 உள்஭டீ்ைகம்: அல஦த்து யலகனள஦ தபவுகல஭னேம் கணிப்ப஧ள஫ழக்குள் 

உள்஭ிடப் ஧னன்஧டுகழ஫து. உள்஭ிடப்஧ட்ட தபவுகள் பென஬ளக்கத்தழற்களக 
஥ழல஦யகத்தழல் கெநழக்கப்஧டுகழன்஫஦.  
எ.கா: யிலசப்஧஬லக, சுட்டி ம஧ான்஫லய . 

 லநனச்தசன஬கம்: லநனச்பென஬கம் ஋ன்஧து, கணிப்ப஧ள஫ழக்கு யமங்கப்஧டும் 
கட்டல஭கல஭க், கணிப்ப஧ள஫ழ ன௃ரிந்துபகளள்ல௃ம் யலகனில் நளற்஫ழ அதல஦ 
பென஬ளக்கம் பெய்னேம் ன௅தன்லநனள஦ ஧குதழனளகும். 
லநனச்தசன஬கத்தில் ப௄ன்று ஧குதிகள் உள்஭஦, அலய  
1. கட்டுப்஧ளட்டகம் (CU - ControlUnit),  
2. கணித ஌பணச் பென஬கம் (ALU - Arithmetic and Logic Unit) நற்றும்  
3. ஥ழல஦யகம் (MU - Memory Unit) ஆகும்.  

 ஥ில஦யகம்: ன௅தன்லந ஥ழல஦யகம் நற்றும் இபண்டளம் ஥ழல஬ ஥ழல஦யகம் 
஋஦ இன௉யலக ஥ழல஦யகங்கள் உள்஭஦. 

 கட்டல஭கள் ஥ழல஫கயற்஫த் தனளபளக இன௉க்கும் க஧ளது தபவு நற்றும் 
஥ழபல்கல஭த் தற்கள஬ழகநளகச் கெநழக்க ன௅தன்லந ஥ழல஦யகம் 
஧னன்஧டுகழ஫து.  

஋.கள: க஥படி அணுகல் ஥ழல஦யகம் (RAM - Random Access Memory) 
 தபவுகல஭ ஥ழபந்தபநளகச் கெநழத்து லயக்க இபண்டளம் ஥ழல஬ 

஥ழல஦யகம் ஧னன்஧டுகழ஫து.  
஋.கள: யன்யட்டு (Hard disk), குறுயட்டு (CD-ROM) நற்றும் டியிடி கபளம் (DVD 
ROM) க஧ளன்஫லய. 

 தய஭ினீட்ைகம்: ஧ன஦ர்கள் ன௃ரிந்து பகளள்஭க்கூடின யலகனில் தகயல஬த் 
பதரியிக்கும் ஋ந்தபயளன௉ யன்ப஧ளன௉ல௃ம் பய஭ினடீ்டகம் ஋஦ப்஧டும். 
஋.கள: தழலபனகம், அச்சுப்ப஧ள஫ழ க஧ளன்஫லய. 
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2. கணிப்த஧ா஫ினின் ஧ல்மயறு தல஬ப௃ல஫கல஭ யி஭க்குக. 

கணிப்ப஧ள஫ழனின் ய஭ர்ச்ெழலனப் ஧ல்கயறு ஥ழல஬க஭ின் அடிப்஧லடனில் ஆறு 
தல஬ன௅ல஫க஭ளகப் ஧ிரிக்க஬ளம். 

தல஬ப௃ல஫ கா஬ம் 
஧னன்஧டுத்தின 

சாத஦ம் 
஥ில஫/ குல஫ 

ன௅த஬ளம் 
தல஬ன௅ல஫ 

(1940-1956) பயற்஫ழடக் 
குமல்கள்  

அ஭யில் ப஧ரினது. அதழக அ஭வு 
நழன்ெளபத்லத ஋டுத்துக்பகளண்டது. 
இனந்தழப பநளமழ ஧னன்஧டுத்தப்஧ட்டது. 

ன௅தல் தல஬ன௅ல஫ கணிப்ப஧ள஫ழகள் - ENIAC , EDVAC , UNIVAC 1 
இபண்டளம் 
தல஬ன௅ல஫ 

(1956-1964) தழரிதலடனங்கள்  அ஭யில் ெழ஫ழனது. 
குல஫ந்த நழன்ெளபத்லத ஋டுத்துக்பகளண்டது. 
ன௅தல் இனக்கஅலநப்ன௃  உன௉யளக்கப்஧ட்டது. 
இனந்தழப பநளமழ நற்றும் அபெம்஧஭ி பநளமழ 
஧னன்஧டுத்தப்஧ட்டது. 

இபண்டளம் தல஬ன௅ல஫ கணிப்ப஧ள஫ழகள் - IBM 1401, IBM 1620, UNIVAC 1108 
னென்஫ளம் 
தல஬ன௅ல஫ 

(1964-1971) என௉ங்கழலணந்த 
சுற்றுகள்  

கணிப்ப஧ள஫ழகள் யிலபயளக பெனல்஧டும் 
நற்றும் அதழக ஥ம்஧கத் தன்லநனேலடனது. 
உனர்஥ழல஬ பநளமழ ஧னன்஧டுத்தப்஧ட்டது. 

னென்஫ளம் தல஬ன௅ல஫ கணிப்ப஧ள஫ழகள் - IBM 360 series, Honeywell 6000 series 
஥ளன்களம் 
தல஬ன௅ல஫ 

(1971-1980) நுண் பென஬ழ ெழ஫ழனது நற்றும் கயகநள஦து. 
IBM நற்றும் APPLE க஧ளன்஫ நுண் 
கணிப்ப஧ள஫ழகள் உன௉யளக்கப்஧ட்டது. 
லகனடக்க கணிப்ப஧ள஫ழகள் 
அ஫ழன௅க஧டுத்தப்஧ட்டது. 

஍ந்தளம் 
தல஬ன௅ல஫ 

1980 - 
இன்றுயலப 

நீப்ப஧ன௉ 
அ஭யி஬ள஦ 
என௉ங்கழலணந்த 
சுற்றுகள் 

இலண பென஬ளக்கம்.  
஥ழமற்஧டங்கள் நற்றும் யலப஧டங்கல஭ப் 
ன௃ரிந்து பகளள்ல௃ம் தழ஫ன்.  
பெனற்லக நுண்ண஫ழவு நற்றும் ஥ழன௃ணர் 
அலநப்ன௃ அ஫ழன௅கம். 

ஆ஫ளயது 
தல஬ன௅ல஫ 

஋தழர் 
கள஬த்தழல் 
 

 இலண நற்றும் ஧கழர்வு கணிப்஧டீு. 
கணிப்ப஧ள஫ழகள் தழ஫லநனளகவும், 
யிலபயளகவும் நற்றும் ெழ஫ழனதளகவும் 
இன௉க்கும். 
பெனற்லக ந஦ிதர்கள் (Robots) 
உன௉யளக்குதல். 
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3. ஧ின்யருய஦யற்ல஫ யி஭க்குக. 
அ) லந஧ீச்சு அச்சுப்த஧ா஫ி,  
ஆ) ஧ல்லூைக ஧ையழீ்த்தி,  
இ) ஧ட்லைக் கு஫ினீடு / QR கு஫ினீடு ஧டிப்஧ான் 

 

அ) லந஧ீச்சு அச்சுப்த஧ா஫ி:  
 லந஧சீ்சு அச்சுப்ப஧ள஫ழகள் கன௉ஞ்ெழயப்ன௃, நஞ்ெள் நற்றும் ெழனளன் உள்஭டக்கழன 

லநகுப்஧ிலனப் ஧னன்஧டுத்தழ யண்ண ெளனல஬  உன௉யளக்குகழ஫து. என௉ ஥ழ஫ 
யண்ணத்தழல் அச்ெழடுயதற்கு கன௉ப்ன௃ லநகுப்஧ிலன ஧னன்஧டுத்துகழ஫து.  

 லநப்஧சீ்சு அச்சுப்ப஧ள஫ழகள் என௉ களகழதத் தள஭ில் நழன்னூட்டம் 
ப஧ற்஫லநலனத் பத஭ிப்஧தன் னெ஬ம் பெனல்஧டுகழ஫து.  

 இதன் அச்ெழடும் கயகம் ப஧ளதுயளக என௉ ஥ழநழடத்தழற்கு 1 ன௅தல் 20 
஧க்கங்கல஭ அச்ெழடும்  

ஆ) ஧ல்லூைக ஧ையழீ்த்தி: 
1) கணிப்ப஧ள஫ழ தழலபனக பய஭ினடீ்லடப் ப஧ரின தழலபனில் தழலபனிடப் 

஧னன்஧டுகழன்஫து.  
2) இலயகள் யகுப்஧ல஫க஭ில் அல்஬து கூட்ட அபங்குக஭ில் யி஭க்கக் 

களட்ெழகல஭க் களட்ெழப்஧டுத்தப் ஧னன்஧டுத்தப்஧டுகழன்஫஦. 
இ) ஧ட்லைக் கு஫ினீடு / QR கு஫ினீடு ஧டிப்஧ான்: 

 ஧ட்லடக்கு஫ழனடீு ஋ன்஧து பயவ்கயறு தடிநன் யரிலெனில் அச்ெழடப்஧டும் என௉ 

யடியம் ஆகும்.  

 ஧ட்லடக் கு஫ழனடீ்டு ஧டிப்஧ளன், ஧ட்லடக் கு஫ழனடீ்லடப் ஧டித்து அயற்ல஫ நழன் 

துடிப்ன௃க஭ளக நளற்஫ழ கணிப்ப஧ள஫ழ பென஬கத்தழற்கு அனு஧ன௃ம் என௉ 

கன௉யினளகும்.  
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஧ாைம் 2. எண் ப௃ல஫கள் 
சரினா஦ யிலைலனமதர்ந்ததடுத்து எழுதுக: 

1. கணிப்ப஧ள஫ழனின் லநனச் பென஬கத்தழல் ஧ிட்டுக஭ின் ஋ண்ணிக்லக ஋வ்யளறு 
கு஫ழப்஧ிடப்஧டுகழ஫து?  
(அ) ல஧ட்  (ஆ) ஥ழ஧ில்   (இ) மயர்டு ஥ீ஭ம்   (ஈ) ஧ிட் 

2. என௉ கழக஬ள ல஧ட் ஋ன்஧து ஋த்தல஦ ல஧ட்டுகல஭க் பகளண்டது?  
(அ) 1000  (ஆ) 8  (இ) 4   (ஈ) 1024 

3. ASCII ஋ன்஧தன் யிரியளக்கம்:  
(அ) American School Code for Information Interchange  
(ஆ) American Standard Code for Information Interchange  
(இ) All Standard Code for Information Interchange  
(ஈ) American Society Code of Information Interchange 

4. 2^50 ஋ன்஧து ஋லத கு஫ழக்கும்?  
(அ) கழக஬ள (Kilo)  (ஆ) படபள(Tera)  (இ) ஧ீட்ைா(Peta)  (ஈ) ஜடீ்டள(Zetta) 

5. Binary Coded Decimal ன௅ல஫னில் ஋த்தல஦ ஋ழுத்துன௉க்கல஭க் லகனள஭ ன௅டினேம்?  
(அ) 64  (ஆ) 255  (இ) 256  (ஈ) 128 

6. 11012-க்கு ஥ழகபள஦ ஧தழ஦ளறு஥ழல஬ நதழப்ன௃ ஋து?  
(அ) F   (ஆ) E  (இ) D   (ஈ) B 

7. 00100110 க்கள஦ 1-ன் ஥ழபப்஧ி ஋து?  
(அ) 00100110   (ஆ) 11011001   (இ) 11010001   (ஈ) 00101001 

8. கவழ்க்கண்டயற்஫ழல் ஋து ஋ண்ணில஬ ஋ண் அல்஬?  
(அ) 645  (ஆ) 234  (இ) 876  (ஈ) 123 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. தபவு என்஫ா ல் என்஦ ? 

 தபவு ஋ன்஧தற்கள஦ ஆங்கழ஬ யளர்த்லதனள஦ Data ஋ன்஫ பெளல் Datum ஋ன்஫ 
பெளல்஬ழ஬ழன௉ந்து யந்தது. அதன் ப஧ளன௉ள் "பெனல்஧டுத்தப்஧டளத னெ஬ தகயல்" 
஋ன்஧தளகும்.  

 தபவு ஋ன்஧து நக்கள், இடங்கள் அல்஬து ப஧ளன௉ட்க஭ின் ஧஬ தகயல்கல஭ 
பகளண்டது. 

2. 1-ன் ஥ிபப்பு ப௃ல஫ க்கா஦ யமிப௃ல஫ கல஭ எழுதுக. 

 பகளடுக்கப்஧ட்ட ஧தழன்ந ஋ண்ணுக்கு ஥ழகபள஦ இன௉஥ழல஬ ஋ண்ணளக நளற்஫ 
கயண்டும். 

 நளற்஫ப்஧ட்ட இன௉஥ழல஬ ஋ண் 8 ஧ிட்டுக஭ளக உள்஭தள ஋ன்஧லதச் ெரி஧ளர்த்து,  
8 ஧ிட்டுக்கும் குல஫யளக இன௉ப்஧ின், ன௅ன்ப஦ளட்டளக 0-க்கல஭ச் கெர்த்து      
8 ஧ிட்டுக஭ளக நளற்஫ கயண்டும். 

 அல஦த்து ஧ிட்டுகல஭னேம், தல஬கவமளக நளற்஫ கயண்டும். அதளயது 1 
஋ன்஧லத 0 ஋஦வும், 0 ஋ன்஧லத 1 ஋஦வும் நளற்஫ கயண்டும். 

3. (46)10க்கு ஥ிகபா஦ இரு஥ில஬ எண்ணா க நாற் றுக. 

2   46 

2   23 – 0 

2   11 – 1 

2    5 – 1 

2    2 – 1 

     1 – 0 
 

 

(46)10 = 1011102 

4. (28)10 க்கு 1-ன் ஥ிபப்பு ப௃ல஫ னில் யிலை காண ப௃டினாது. ஏன் காபணம் கூறு. 

 (28)10 க்கு 1-ன் ஥ழபப்ன௃ ன௅ல஫ னில் யிலட களண ன௅டினளது. 

 1 ” ன் ஥ழபப்ன௃ ன௅ல஫னள஦து ஋தழர்நல஫ ஋ண்கல௃க்கு நட்டுகந ப஧ளன௉ந்தும். 

5. எழுத்துருக்கல஭ ஥ில஦யகத்தில் லக னால௃யதற்கா஦ கு஫ினீட்டு ப௃ல஫ 

கல஭ப் ஧ட்டின஬ிடுக. 

 ASCII 

 BCD 

 EBCDIC 

 ISCII 

 Unicode 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. எண் ப௃ல஫னில் அடிநா஦ம் என்஫ால் என்஦ ? எடுத்துக்காட்டு தருக. 

 அடிநள஦ம் ஋ன்஧து எவ்பயளன௉ ஋ண்ன௅ல஫னிலும் உள்஭ பநளத்த ஋ண் 
உன௉க்க஭ின் ஋ண்ணிக்லகலனக் கு஫ழக்கும். 

 எவ்பயளன௉ ஋ண் ன௅ல஫னேம், அதன் அடிநள஦ நதழப்ல஧ பகளண்டு அலடனள஭ம் 
களணப்஧டும். 
எ.கா: இன௉஥ழல஬ ஋ண் ன௅ல஫னில் 0 நற்றும் 1 ஋ன்஫ இபண்டு ஋ண் உன௉க்கள் 
நட்டுகந உள்஭தளல் அதன் அடிநள஦ம் ” 2, ஧தழன்ந ஋ண் 0 ன௅தல் 9 யலப 
பநளத்தம் 10 ஋ண் உன௉க்கல஭ பகளண்டுள்஭து. ஋஦கய, இதன் அடிநள஦ம் ” 10. 
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2. இரு஥ில஬ எண் ப௃ல஫ – கு஫ிப்பு யலபக. 
 இன௉஥ழல஬ ஋ண் ன௅ல஫னில் 0 நற்றும் 1 ஋ன்஫ இபண்டு ஋ண் உன௉க்கள் 

நட்டுகந உள்஭து. இந்த ன௅ல஫ , 2 லன அடிநள஦நளகக் பகளண்டுள்஭து.  
 என௉ இன௉஥ழல஬ ஋ண் பதளடரின் இடது ஏப ஧ிட், அதழக ஥ழல஬ ஥ழல஫ நதழப்ல஧ 

பகளண்டுள்஭தளல், அது ‚நழகு நதழப்ன௃ ஧ிட்‛ (Most Significant Bit ” MSB) ஋஦வும், 
ய஬து ஏப ஧ிட் குல஫ந்த நதழப்ல஧ப் ப஧றுயதளல், அது ‚குல஫ நதழப்ன௃ ஧ிட்‛ 
(Least Significant Bit ” LSB) ஋஦வும் அலமக்கப்஧டுகழன்஫து. 
 

3. (150)10 க்கு ஥ிகபா஦ இரு஥ில஬ எண்ணாக நாற்஫ி, அதல஦ எண்ணில஬ 
எண்ணாக நாற்றுக. 
15010 f;F epfuhd ,Uepiy vz;: 

2   150 

2    75    – 0 

2    37    – 1 

2    18    – 1 

2     9     – 0 

2     4     – 1 

2     2     – 0 

      1      – 0 
 

15010 = 100101102 

15010 f;F epfuhd vz;zpiy vz;: 

 பகளடுக்கப்஧ட்ட இன௉஥ழல஬ ஋ண்கல஭ ய஬நழன௉ந்து இடநளக னென்று ஧ிட்டுக஭ளக 

குழுயளக்கவும். இடது ஏப குழு னென்று ஧ிட்டுக஭ளக அலநனயில்ல஬ ஋஦ில் 
அதல஦ னென்று ஧ிட்டளக நளற்஫ 0 ன௅ன்ப஦ளட்டளக கெர்க்க கயண்டும்.  

 எவ்பயளன௉ குழுயிலும் உள்஭ இன௉஥ழல஬ நதழப்ன௃க்கல௃க்கு ஥ழகபள஦ ஧தழன்ந 
஋ண்கல஭ கணக்கழட கயண்டும். 

010  010  110 

  2     2     6 

15010 = 2268  

4. ISCII கு஫ிப்பு யலபக. 

 இந்தழன பநளமழக஭ின் ஧ல்கயறு ஋ழுத்துன௉க்கல஭ நட்டும் லகனளல௃ம் 
க஥ளக்கழல் யடியலநக்கப்஧ட்ட ஏர் ன௅ல஫ ISCII ஆகும்.  

 இது 8 ஧ிட் கு஫ழனடீ்டு ன௅ல஫னளகும். ஋஦கய, இந்த ன௅ல஫னில் 256 
஋ழுத்துன௉க்கல஭க் லகனள஭ ன௅டினேம். 

 இந்தழன அபெழன் நழன்஦ணு துல஫னளல் 1986-88 ஆண்டுயளக்கழல் இந்த ன௅ல஫ 
உன௉யளக்கப்஧ட்டு, இந்தழன தப஥ழர்ணனக் குழுநத்தளல், (Bureau of Indian Standards ” 
BIS) ஌ற்றுக்பகளள்஭ப்஧ட்டுள்஭து.  

 தற்க஧ளது இந்த கு஫ழனடீ்டு ன௅ல஫ னே஦ிககளட் கு஫ழனடீ்டு ன௅ல஫னில் 
இலணந்துயிட்டது. 
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5. கூட்டுக: (அ) -2210 + 1510  (ஆ) 2010 + 2510 

(அ) -2210 + 1510 
22 ” ன் இன௉஥ழல஬஋ண்: 10110 
15 ” ன் இன௉஥ழல஬ ஋ண்: 1111 
-22 ஋தழர்நல஫ ஋ண் ஋ன்஧தளல் அதற்கள஦ 2-ன் ஥ழபப்஧ி களண்க: 
22 ” ன் 8 ” ஧ிட் இன௉஥ழல஬ ஋ண்: 00010110 
22 ” ன் 1”ன் ஥ழபப்஧ி:  11101001 
1-ன் ஥ழபப்஧ினேடன் 1-஍க் கூட்ட:        1 
-22 ன் 2-ன் ஥ழபப்஧ி:   11101010 
-22  =  1110 1010 
15 =  0000 1111 

-2210 + 1510 =  1111 1001 
 

(ஆ) 2010 + 2510 

2010 - ன் இன௉஥ழல஬஋ண் =  10100 
2510 - ன் இன௉஥ழல஬஋ண்  =  11001 
2010 + 2510   =     101101 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. (அ) நிதப்புப் புள்஭ி ஧தின்ந எண்லண, இரு஥ில஬ எண்ணாக 

நாற்றுயதற்கா஦ யமிப௃ல஫கல஭ யியரி. 
(ஆ) (98.46)10 க்கு ஥ிகபா஦ இரு஥ில஬ எண்ணாக நாற்றுக. 

நிதப்புப் புள்஭ி ஧தின்ந எண்லண, இரு஥ில஬ எண்ணாக நாற்றுயதற்கா஦ 
யமிப௃ல஫:  
2 ன் பதளடர்ப஧ன௉க்கல் ன௅ல஫லனப் ஧னன்஧டுத்தழ பகளடுக்கப்஧ட்ட நழதப்ன௃ப்ன௃ள்஭ி 
஧தழன்ந஋ண்லண இன௉஥ழல஬ ஋ண்ணளக நளற்஫஬ளம். 
 நழதப்ன௃ப்ன௃ள்஭ி ஧தழன்ந ஋ண்லண 2 ஆல் ப஧ன௉க்கழ யன௉ம் யிலட நதழப்஧ின் 

ன௅ழு ஋ண் ஧குதழலனத் த஦ினளக கு஫ழத்து லயக்க கயண்டும்.  
 நீதன௅ள்஭ நழதப்ன௃ப்ன௃ள்஭ி நதழப்ன௃கல஭ நீண்டும் 2 ஆல் ப஧ன௉க்கழ, அதன் 

யிலடநதழப்஧ின் ன௅ழு ஋ண் ஧குதழலனத் த஦ினளக கு஫ழத்து லயக்க கயண்டும்.  
 இறுதழ நதழப்ன௃ 0 ஋஦ யன௉ம் யலபகனள அல்஬து பதளடர்ந்து ெழ஬ இ஬க்கங்கள் 

யலபகனள நீண்டும், நீண்டும் கநற்கண்ட ன௅ல஫லன ஧ின்஧ற்஫ கயண்டும். 
 த஦ிகன ஋ழுதழ லயக்கப்஧ட்டுள்஭ அல஦த்து 0 நற்றும் 1-கல஭ கந஬ழன௉ந்து 

கவமளக ஋ழுதகயண்டும். இதுகய, பகளடுக்கப்஧ட்ட நழதப்ன௃ப்ன௃ள்஭ி ஋ண்ணுக்கு 
஥ழகபள஦ இன௉஥ழல஬஋ண் ஆகும். 

  (98.46)10 க்கு ஥ிகபா஦ இரு஥ில஬ எண்: 
ப௃ழுஎண் ஧குதிலன நாற்றுதல்: (98)10 

 

2   98 

2   49 – 0 

2   24 – 1 

2   12 – 0 

2    6 – 0 

2    3 – 0 

     1 – 1 
 

98 க்கு ஥ிகபா஦ இரு஥ில஬ எண்: 11000102 
நிதப்புப் புள்஭ி ஧குதிலன நாற்றுதல்: (0.46)10 

KOvz; gFjp 

0.46 x 2 =  0.92   0 

0.92 x 2 =  1.84   1 

0.84 x 2 =  1.68   1 

0.68 x 2 =  1.36   1 

0.36 x 2 =  0.72   0 
 

0.46f;F epfuhd ,Uepiy vz;: (0.01110 . . .)2 
 

(98.46)10 = (1100010. 0111 0. . .)2 
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3. (அ) கூட்டுக: 11010102 + 1011012  

(ஆ) கமழக்க: 11010112 ” 1110102 

 அ) கூட்டுக:  1101010 

       101101 

                   10010111  

 
ஆ) கமழக்க:  1101011 

     111010 

     110001 

 

 

 

 

 

 

 

 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 16 

 

஧ாைம் 3. கணி஦ி அலநப்பு 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. ஧ின்யன௉ய஦யற்றுள் ஋து கணிப஧ள஫ழனின் னெல஭ ஋஦ அலமக்கப்டுகழி்஫து?  
(அ) உள்஭டீ்டுச் ெளத஦ஙகள் (ஆ) பய஭ினடீ்டுச் ெளத஦ஙகள்  
(இ) ஥ில஦யக சாத஦ஙகள் (ஈ) நுண்பென஬ழ 

2. ஧ின்யன௉ய஦யற்றுள் ஋து நுண்பென஬ழனின் ஧ளகம் அ஬஬?  
(அ) கணித ஌பணச்பென஬கம்  (ஆ) கட்டுப்஧ளட்டகம்      
(இ) மகச் ஥ில஦யகம்   (ஈ) ஧தழகயடு  

3. ஋த்தல஦ ஧ிட்டுகள் என௉ கயர்லட கட்டலநக்கும்?  
(அ) 8     (ஆ) 16     (இ) 32  (ஈ) ஧னன்஧டுத்தும் தசன஬ிலன த஧ாருத்தது  

4. ஧ின்யன௉ம் ஋ந்த ெளத஦ம், ஥ழல஦யக ன௅கயரி ஧தழகயட்டில் ன௅கயரிலனக் 
கு஫ழக்கும் க஧ளது அதன் இன௉ப்஧ிடத்லத அலடனள஭ம் களட்டும் ?  
(அ) ப஬ளககட்டர்(Locator) (ஆ) ஋ன்ககளடர்(Encoder)  
(இ) டிமகாைர்(Decoder)  (ஈ) நல்டி ஃ஧ி஭க்ெர்(Multiplexer) 

5. ஧ின்யன௉ய஦ற்றுள் ஋து என௉ CISC பென஬ழ ஆகும்?  
(அ) Intel P6   (ஆ) AMD K6   (இ) Pentium III  (ஈ) Pentium IV 

6. ஋து கயகநளக பெனல்஧டும் ஥ழல஦யகம் ஆகும்?  
(அ) யன் யட்டு  (ஆ) ன௅தன்லந ஥ழல஦யகம்  
(இ) மகச் ஥ில஦யகம்  (ஈ) ன௃ல௃- கப ஥ழல஦யகம் 

7. என௉ 8 ” ஧ிட் ஥ழல஦யக ஧ளட்லட உள்஭ பென஬ழ ஋த்தல஦ ஥ழல஦யக இடங்கல஭ 
அலடனள஭ம் களணும்?  
(அ) 28  (ஆ) 1024  (இ) 256  (ஈ) 8000 

8. எற்ல஫ ஧க்க நற்றும் எற்ல஫ அடுக்கு 12 பெ.நீ யிட்டம் உள்஭ DVD-னின் பநளத்த 
பகளள்஭஭வு ஋வ்ய஭வு?  
(அ) 4.7 GB  (ஆ) 5.5 GB  (இ) 7.8GB  (ஈ) 2.2 GB  

9. CD னின் குல஫ந்த அ஭யி஬ள஦ தபயின் அ஭வு னளது ?  
(அ) பதளகுதழ  (ஆ) ஧குதழ  (இ) ஧ிட்ஸ்   (ஈ) தடங்கள் 

10. கணிப்ப஧ள஫ழனின் தழலபச்ெளத஦த்லத இலணக்க உதவும் பதளடர்ன௃ ெளத஦ம் ஋து?  
(அ) USB  (ஆ) Ps/2   (இ) SCSI   (ஈ) VGA 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஒரு த௃ண்தசன஬ினின் ஧ண்புகல஭க் கு஫ிக்கும் காபணிகள் னாலய? 

 கடிகளப கயகம் (Clock Speed)  
 கட்டல஭ பதளகுப்ன௃ (Instruction Set) 
 கயர்டு அ஭வு (Word Size) 

2. அ஫ிவுறுத்தல் என்஫ால் என்஦? 
 என௉ தபயின் நீது பெனல்஧ளடுகல஭ச் பெனல்஧டுத்துயதற்களக கணிப்ப஧ள஫ழக்கு 

பகளடுக்கப்஧டும் கட்டல஭கக஭ அ஫ழவுறுத்தல் ஋஦ப்஧டும். 
3. ஥ிபல்கவுண்ட்ைர் என்஫ால் என்஦? 

 ஥ழப஬ழன் அடுத்து பெனற்஧டுத்த கயண்டின கட்டல஭னின் ன௅கயரிலன 
லநனச்பென஬கத்தழல் கெநழத்து லயக்கும் என௉ ெழ஫ப்ன௃ ஧தழகயடு தளன் ஥ழபல் 
஧தழகயடு ஋஦ப்஧டும்.  

4. உனர்யலபனல஫ ஧ல்லூைக இலைப௃கம் (HDMI) என்஫ால் என்஦? 
 உனர் யலபனல஫ ஧ல்லூடக இலடன௅கம் ஋ன்஧து எ஭ிக்களட்ெழ 

கட்டுப்஧டுத்தழனி஬ழன௉ந்து யன௉ம் சுன௉க்கப்஧டளத  எ஬ழ / எ஭ி தபவுகல஭ 
கணிப்ப஧ள஫ழ தழலபனகம், LCD ன௃பபளஜக்டர், டிஜழட்டல் பதளல஬க்களட்ெழக்கு 
பகளடுக்கப் ஧னன்஧டும் என௉ எ஬ழ / எ஭ி இலடன௅கம் ஆகும். 

5. EPROM – ல் உள்஭ தபலய எவ்யாறு அமிப்஧ாய்? 
 EPROM ” ல் தகயல்கள் ன௃஫ஊதளஎ஭ி பெலுத்தும் யலப கெநழத்து 

லயக்கப்஧டுகழன்஫஦. ன௃஫ஊதள எ஭ிலன பெலுத்தழ PROM-ன் உள்஭டக்கத்லத 
அமழத்து, நீண்டும் கயறு ஥ழபல்கல஭ ஋ழுத஬ளம். 
 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ி அலநப்பு, கணிப்த஧ா஫ி கட்ைலநப்பு மயறு஧டுத்துக. 

கணிப்த஧ா஫ி அலநப்பு கணிப்த஧ா஫ி கட்ைலநப்பு 
கணிப்ப஧ள஫ழ அலநப்ன௃ ஋ன்஧து 

கணி஦ினின் யன்ப஧ளன௉ள் கூறுகல஭ 

உள்஭டக்கழனது. இது ஥ழப஬ன௉க்கு 

யன்ப஧ளன௉ள் கூறுகல஭ 

பய஭ிப்஧லடனளக யி஭க்குகழ஫து. 

கணிப்ப஧ள஫ழ கட்டலநப்ன௃  ஋ன்஧து 
கணிப்ப஧ள஫ழலன யடியலநப்஧தழல் 
ஈடு஧ட்டின௉க்கும் ப஧ள஫ழனினல் 
கன௉துககளல஭  உள்஭டக்கழனது. 

2. தபயின் அ஭லயப் த஧ாறுத்து த௃ண்தசன஬ிலன யலகப்஧டுத்துக. 
பென஬ளக்கப்஧டும் தபயின் அக஬த்லத ப஧ளறுத்து நுண்பென஬ழலன 
யலகப்஧டுத்த஬ளம். 
 8 - ஧ிட் நுண்பென஬ழ  *   16 - ஧ிட் நுண்பென஬ழ 
 32 - ஧ிட் நுண்பென஬ழ  *   64 - ஧ிட் நுண்பென஬ழ 

3. கட்ைல஭னின் ததாகுதினின் அடிப்஧லைனில் த௃ண்தசன஬ினின் யலககல஭ 
எழுதுக. 
கட்டல஭க஭ின் பதளகுதழ அடிப்஧லடனில் நுண்பென஬ழலன இன௉ 
யலகப்஧டுத்த஬ளம். 
1. குல஫க்கப்஧ட்ட கட்டல஭ பதளகுதழ கணி஦ிகள் (RISC) 
2. ெழக்க஬ள஦ கட்டல஭ அலநக்கப்஧ட்ட கணி஦ிகள் (CISC)  
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4. PROM நற்றும் EPROM மயறு஧டுத்துக. 
PROM EPROM 

இது என௉ அமழனள ஥ழல஦யகம் 
ஆகும்.  

இது என௉ PROM யலகனள஦ ெழ஫ப்ன௃ 
஥ழல஦யகம் ஆகும்.  

இதழல் தபவுகள் என௉ ன௅ல஫ 
நட்டுகந ஋ழுத ன௅டினேம். PROM ” ல் 
என௉ ன௅ல஫ ஥ழபல்கள் 
஋ழுதழயிட்டளல் ஋ப்ப஧ளழுதும் 
அமழனளந஬ழன௉க்கும். 
 

EPROM ” ல் தகயல்கள் ன௃஫ஊதளஎ஭ி 
பெலுத்தும் யலப கெநழத்து 
லயக்கப்஧டுகழன்஫஦. EPROM ” ல் ன௃஫ஊதள 
எ஭ிலன பெலுத்தழ PROM-ன் உள்஭டக்கத்லத 
அமழத்து, நீண்டும் கயறு ஥ழபல்கல஭ 
஋ழுத஬ளம். 

5. கணிப்த஧ா஫ினில் ஧னன்஧டுத்தப்஧டும் இலைப௃கம் நற்றும் 
ததாைர்புப௃கங்கல஭ எழுதுக. 
 பதளடர் பதளடர்ன௃ ன௅கம் *   இலணனள஦ பதளடர்ன௃ ன௅கம்  
 USB பதளடர்ன௃ ன௅கம்   *   USB 3.0  
 VGA இலணப்஧ளன்  *   ஆடிகனள ஧ி஭க்ஸ்  
 PS/2 Port     *   SCSI Port  
 உனர் யலபனல஫ ஧ல்லூடக இலடன௅கம் (HDMI) 

6. CD நற்றும் DVD மயறு஧டுத்துக. 
CD DVD 

CD ஋஦ப்டும் CD-ROM 1.2 நழல்஬ழநீட்டர் 
஧ன௉நன் அ஭யில் ஧ள஬ழகளர்஧க஦ட் 
஧ி஭ளஸ்டிக் ப஧ளன௉஭ளல் ஆ஦தளகும்.  

இது கண்ணளடினிலம யட்டு ஆகும்.  

பநல்஬ழன அ஭யி஬ள஦ அலுநழ஦ினம் 
அ஬஬து தங்க ன௅஬ளம் அதன் 
கநல்஧குதழனில் ன௄ெப்஧ட்டின௉க்கும். 

இவ்யலக யட்டு என்று அ஬஬து 
இபண்டு ஧க்கங்கல஭க் பகளண்டு, 
கநலும் என௉ ஧க்கத்தழற்கு என்று 
அ஬஬து இபணடு அடுக்குக஭ில் 
இன௉க்கும். இன௉ அடுக்கு DVD தங்க 
஥ழ஫த்தழலும் என௉ அடுக்கு DVD பயள்஭ி 
஥ழ஫த்தழலும் கழலடக்கும். 

CD - ன் பகளள்஭஭வு 700 MB ஆகும். இது 4.7 GB யலப தபவுல஭ கெநழக்கும். 
7. ஃ஧ி஭ாஷ் ஥ில஦யகம் நற்றும் EEPROM எவ்யாறு மயறு஧டுத்துயாய்? 

ஃ஧ி஭ாஷ் ஥ில஦யகம் EEPROM 
ஃ஧ி஭ளஷ் ஥ழல஦யகம் என௉ நழன்஦னு 

அமழவு஫ளத கெநழக்கும் ெளத஦நளகும். 

கநலும் நழன்ெளபத்தழன் னெ஬ம் ஥ழபல்கல஭ 

அமழத்து, நறு஧டினேம் ஥ழப஬ளக்க ன௅டினேம். 

என௉ ெழ஫ப்ன௃ PROM யலகலன ெளர்ந்த  
஥ழல஦யகம் ஆகும். இதழல் உள்஭ 
தபவுகல஭ நழன்ெளபத்லதச் பெலுத்தழகன 
அமழக்க஬ளம் 

கயகநள஦ அணுகல் க஥பத்லத 
யமங்குகழ஫து. 

EEPROM பநதுயளக இனங்கும் 
஥ழல஦யகம் ஆகும். 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. த௃ண்தசன஬ினின் ஧ண்பு கூறுகல஭ யி஭க்குக. 

என௉ நுண்பென஬ழனின் பெனல்஧ளடு, கவழ்களணும்  ஧ண்஧ினல்ன௃கல஭ 
அடிப்஧லடனளகக் பகளண்டது. 

 கடிகளப கயகம் (Clock Speed)  
 கட்டல஭ பதளகுப்ன௃ (Instruction Set) 
 கயர்டு அ஭வு (Word Size) 

கடிகாப மயகம்:  
 எவ்பயளன௉ நுண்பென஬ழனிலும் உள்க஭ என௉ கடிகளபம் உள்஭து.  
 கணிப்ப஧ள஫ழனின் எவ்பயளன௉ கட்டல஭னேம் ஥ழல஫கயற்றுத஬ழன் கயகத்லத 

இந்தக் கடிகளபம் கட்டுப்஧டுத்துகழ஫து. இதுகய கடிகளபத்தழன் கயகம் ஋஦ப்஧டும். 
 கணிப்ப஧ள஫ழனின் கயகம் பநகளபலர்ட்ஸ் (Mega Hertz) நற்றும் ஜழகளபலர்ட்ஸ் 

(Giga Hertz) அ஭யில் அ஭க்கப்஧டுகழ஫து. 
கட்ைல஭ ததாகுப்பு :  
 நுண்பென஬ழலன பெனல்஧டுத்துயதற்களக யடியலநக்கப்஧ட்ட அடிப்஧லட 

இனந்தழப ஥ழல஬ அ஫ழவுறுத்தல் பதளகுதழகல஭க் கட்டல஭த்பதளகுப்ன௃ 
஋ன்கழக஫ளம்.  

 இந்த கட்டல஭க஭ின் பதளகுதழ ஧ின்யன௉ம் பெனல்கல஭ பெனல்஧டுத்துகழ஫து. 
 தபவு நளற்஫ம் 
 ஋ண்கணித பெனல்ன௅ல஫கள் 
 தன௉க்கபெனல்ன௅ல஫கள் 
 கட்டுப்஧ளட்டு ஥கர்வு 
 உள்஭டீு / பய஭ினடீு 

மயர்டு அ஭வு : 
 என௉ கயர்டு அ஭வு ஋ன்஧து  என௉ தடலய பென஬ழ பெனல்஧டுத்தும் 

஧ிட்டுக஭ின் அ஭யளகும். 
 என௉ கயர்டு அ஭வு ஋ன்஧து கணிப்ப஧ள஫ழனின் ன௅தன்லந ஥ழல஦யகம் (RAM) 

பெனற்஧டுத்தும் கட்டல஭னின் அ஭லயனேம், நுண்பென஬ழனில் உள்஭ 
ஊெழக஭ின் (Pins) ஋ண்ணிக்லகலனனேம் ப஧ளறுத்ததளகும்.  

 உள்஭டீு நற்றும் பய஭ினடீு ஊெழக஭ின் பநளத்த ஋ண்ணிக்லக நுண்பென஬ழனின் 
கட்டலநப்ல஧ தீர்நள஦ிக்கழ஫து. 

2. ஧டித்தல்/ எழுதுதல் (READ / WRITE) தசனல்கல஭ தசன஬ி எவ்யாறு தசய்கி஫து? 
யி஭க்குக. 
 ஧டித்தல் (READ) பெனல்஧ளடு தபவுகல஭ (஧ிட்டுகல஭) கயர்டில் இன௉ந்து 

஥ழல஦யக தபவு ஧தழகயடுகல௃க்கு அனுப்ன௃ம்.  
 ஋ழுதுதல் (WRITE) பெனல்஧ளடு தபவுகல஭ (஧ிட்டுகல஭) ஥ழல஦யக தபவு 

஧தழகயடுக஭ில்இன௉ந்து கயர்டிற்கு அனுப்ன௃ம். 
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3. இனக்கம஥பத்தின் அடிப்஧லைனில் ஥ில஦யக சாத஦ங்கல஭ ஏறுயரிலசனில் 
அலநக்கவும். 
஧஬ யலகனளக ஥ழல஦யகச் ெளத஦ங்கள், அதன் பகளள்஭஭வு, கயகம் நற்றும் 
யில஬னின் அடிப்஧லடனில் யரிலெப்஧டுத்தப்஧ட்டுள்஭து. 

 
 

4. ROM ன் யலககல஭ப்஧ற்஫ி யி஭க்கநாக எழுதுக 
஧டிக்கநட்டும் ஥ில஦யகம் (ROM - Read-Only Memory): 
 கணிப்ப஧ள஫ழனின்  ெழ஫ப்ன௃ ஥ழல஦யகம் ஆகும். 
 ROM ” ல் கணி஦ிலனத் துயங்குயதற்கள஦ நழக ன௅க்கழன ஥ழபல்கள் கெநழத்து 

லயக்கப்஧டுகழன்஫஦. இதழல் என௉ ன௅ல஫ தபவுகல஭ ஋ழுதழ யிட்டளல் அலத 
நளற்஫கயள அல்஬து அமழக்ககயள ன௅டினளது. ஆ஦ளல் ஧டிக்க நட்டும் ன௅டினேம். 

 ROM ” ன் உள்஭டக்கம் நழன்ெளபம் ஥ழறுத்தப்஧ட்டளலும் அமழயதழல்ல஬, இத஦ளல் 
ROM அமழனள ஥ழல஦யகம் ஋஦ அலமக்கப்஧டுகழ஫து. 

஥ிப஬ாக்கு ஧டிக்கநட்டும் ஥ில஦யகம் (PROM):  
 ஥ழப஬ளக்கு ஧டிக்கநட்டும் ஥ழல஦யகம் என௉ அமழனள ஥ழல஦யகம் ஆகும். 
 இதழல் தபவுகள் என௉ ன௅ல஫ நட்டுகந ஋ழுத ன௅டினேம். PROM ” ல் என௉ ன௅ல஫ 

஥ழபல்கள் ஋ழுதழயிட்டளல் ஋ப்ப஧ளழுதும் அமழனளந஬ழன௉க்கும். 
அமிக்கக்கூடின ஥ிப஬ாக்கு ஧டிக்கநட்டும் ஥ில஦யகம் (EPROM):  
 இது என௉ PROM யலகனள஦ ெழ஫ப்ன௃ ஥ழல஦யகம் ஆகும்.  
 EPROM ” ல் ன௃஫ஊதள எ஭ிலன பெலுத்தழ PROM-ன் உள்஭டக்கத்லத அமழத்து, 

நீண்டும் கயறு ஥ழபல்கல஭ ஋ழுத஬ளம். 
 EPROM ப஧ளதுயளக த஦ினளள் கணிப்ப஧ள஫ழனில் ஧னன்஧டுத்தப்஧டுகழ஫து. 
நின்சாபத்தால் அமிக்கும் நற்றும் ஥ிப஬ாக்கு ஧டிக்கநட்டும் ஥ில஦யகம் 
(EEPROM):  
 என௉ ெழ஫ப்ன௃ PROM யலகலன ெளர்ந்த  ஥ழல஦யகம் ஆகும்.  
 இதழல் உள்஭ தபவுகல஭ நழன்ெளபத்லதச் பெலுத்தழகன அமழக்க஬ளம் 
 EEPROM பநதுயளக இனங்கும் ஥ழல஦யகம் ஆகும். 
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஧ாைம் 4. இனக்க அலநப்஧ின் மகாட்஧ாட்டுக் கருத்துக்கள் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. இனக்க அலநப்஧ள஦து ------------------  
அ) ஧னன்஧ளட்டு பநன்ப஧ளன௉ள்  ஆ) யன்ப஧ளன௉ள்  
இ) அலநப்பு தநன்த஧ாருள்  ஈ) உ஧கபணம்  

2. இனக்க அலநப்ன௃க஭ின் ஧னன்஧ளட்லட கண்ட஫ழனவும்  
அ) ந஦ித நற்றும் கணி஦ி இலடகன ஋஭ிதளக பதளடர்ன௃  
ஆ) உள்஭டீு நற்றும் பய஭ினடீு ெளத஦ங்கள் கட்டுப்஧டுத்தும்  
இ) ன௅தன்லந ஥ழல஦யகத்லத கந஬ளண்லந பெய்ன  
ஈ) இலய அல஦த்தும்  

3. ஧ின்யன௉ம் ஋து, இனக்க அலநப்ன௃ பெனல்஧ளடு அல்஬?  
அ) பெனல்ன௅ல஫ கந஬ளண்லந  ஆ) ஥ழல஦யக கந஬ளண்லந  
இ) ஧ளதுகளப்ன௃ கந஬ளண்லந  ஈ) ஥ிபல் த஧னர்ப்஧ி சூமல்  

4. ஧ின்யன௉ம் ஋ந்த இனக்க அலநப்ன௃ யணிக ரீதழனளக உரிநம் ப஧ற்஫ இனக்க 
அலநப்ன௃ ஆகும்?  
அ) யிண்மைாஸ்  ஆ) உன௃ண்டு   இ) ப஧கடளகபள  ஈ) பபட்பலட்  

5. ஧ின்யன௉ம் இனக்க அலநப்ன௃க஭ில் பநளல஧ல் ெளத஦ங்கல஭ ஆதரிப்஧து ஋து?  
அ) யிண்கடளஸ் 7   ஆ) ஬ழ஦க்ஸ்  இ) ஧ளஸ்  ஈ) iOS  

6. ககளப்ன௃ கந஬ளண்லந ஋யற்ல஫ ஥ழர்யகழக்கழ஫து ?  
அ) ககளப்ன௃கள்ஆ) ககளப்ன௃ல஫கள் இ) அலடவு அலநப்ன௃கள் ஈ) இலயஅல஦த்தும் 

7. ஊடளடு இனக்க அலநப்ன௃ யமங்கும் யெதழ.  
அ) யலபகல஬ ஧ன஦ர் இலைப௃கம் (GUI) ஆ) தபவு யி஥ழகனளகம்  
இ) ஧ளதுகளப்ன௃ கந஬ளண்லந  ஈ) உண்லநனள஦ க஥பம் பென஬ளக்க 

8. எற்ல஫ ஧ன஦ர் இனக்க அலநப்஧ிற்கு ஋டுத்துக்களட்டு  
அ) ஬ழ஦க்ஸ்  ஆ) யிண்கடளஸ்  இ) MS DOS   ஈ) னே஦ிக்ஸ் 

9. ஬ழ஦க்ஸ் ஋ந்தயலக ககளப்ன௃ கந஬ளண்லநலன ஧னன்஧டுத்துகழ஫து  
அ) ext2  ஆ) NTFS  இ) FAT  ஈ) NFTS 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஥ில஦யக மந஬ாண்லநனின் ஥ன்லநகள் ஏமதனும் இபண்லை கூறு ? 

 லநன பென஬கத்தழன் ஧னன்஧ளட்லட கநம்஧டுத்துதல், 
 ன௅தன்லந ஥ழல஦யகத்தழன் யமழனளக கணிப்ப஧ள஫ழனின் கயகத்லத 

அதழகப்஧டுத்துதல் 
2. ஧஬ ஧ன஦ர் இனக்க அலநப்பு என்஫ால் என்஦? 

 எகப க஥பத்தழல் என்றுக்கும் கநற்஧ட்ட ஧ன஦ர்கள், எகப நளதழரினள஦ 
தபவுகல஭னேம் ஧னன்஧ளடுகல஭னேம் கணிப்ப஧ள஫ழனில் ஧னன்஧டுத்த 
அனுநதழக்கும் இனக்க அலநப்ன௃ ‚஧஬ ஧ன஦ர் இனக்க அலநப்ன௃‛ ஋஦ப்஧டும். 
஋.கள: Windows, Unix, Linux 

3. GUI என்஫ால் என்஦? 
 யலபகல஬ ஧ன஦ர் இலடன௅கம் (GUI) ென்஦ல் தழலப அடிப்஧லடனி஬ள஦, 

க஥படினளக உள்஭டீ்டு / பய஭ினடீுகல஭ லகனளள்யதற்கும், ஧ட்டிக஭ி஬ழன௉ந்து 
கதர்வு பெய்யதற்கும், கதர்ந்பதடுப்஧தற்கு கதலயனள஦ சுட்டும் கன௉யிகல஭க் 
(Pointing devices) பகளண்டது. 

 யலபகல஬ ஧ன஦ர் இலடன௅கத்தழன் கயன௉ம் யண்ணங்கள், ஧ன஦லப ஋஭ிதளக 
ஈர்க்கழன்஫து. 

4. ஧ாதுகாப்பு மந஬ாண்லநனின் ஥ன்லநகள் னாலய? 
இனக்க அலநப்ன௃ ஧ன஦ன௉க்கு னென்று ஥ழல஬ப் ஧ளதுகளப்ல஧ யமங்குகழ஫து. 

1. ககளப்ன௃ ஥ழல஬ 
2. அலநப்ன௃ ஥ழல஬ 
3. யல஬ ஥ழல஬ 

5. கணிப்த஧ா஫ினில் ஧னன்஧டுத்தப்஧டும் தயவ்மயறு இனக்க அலநப்புகள் 
னாலய? 
 னை஦ிக்ஸ் 
 லநக்கபளெளஃப்ட் யிண்கடளஸ் 
 ஬ழ஦க்ஸ் 
 Mac OS 
 MS - DOS 

 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. ம஥பம் ஧கிர்தல் இனக்க அலநப்஧ின் ஥ன்லநகள் நற்றும் தலீநகள் என்஦?  

஥ன்லநகள்: 
 எகப க஥பத்தழல் ஧஬ ஧ணிகல஭ அல்஬து பெனல்கல஭ பெனல்஧டுத்துகழ஫து. 
 எவ்பயளன௉ ஧ணிக்கும் என௉ கு஫ழப்஧ிட்ட க஥பம் எதுக்கவடு பெய்னப்஧டுயதளல் 

஋ந்த ஧ணிக்கும் தலட ஌ற்஧டுயதழல்ல஬. 
தலீநகள்: 
 க஥பப்஧கழர்வுக்கு அதழக ய஭ங்கள் கதலயப்஧டுயதளல், உனர்தழ஫ன் நழக்க 

யன்ப஧ளன௉ள் ெளத஦ங்கள் கதலய. 
 அதழப்஧டினள஦ ஧ணிகல஭ அல்஬து ஧னன்஧ளடுகல஭ இனக்கும் க஧ளது, ெழ஬ 

க஥பங்க஭ில் கணி஦ி பெனல் இமக்க க஥ரிடும். 
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2. இனக்க அலநப்஧ின் ப௃க்கின சி஫ப்஧ினல்புகல஭ ஧ட்டின஬ிடுக. 
 ஧ன஦ர் இலடன௅கம் 
 ககளப்ன௃ கந஬ளண்லந 
 ஥ழல஦யக கந஬ளண்லந 
 ஧ிலம ப஧ளறுப்ன௃ 
 பெனல் கந஬ளண்லந 
 ஧ளதுகளப்ன௃ கந஬ளண்லந 

3. ஧஬ தசன஬ாக்க இனக்க அலநப்பு சிறு கு஫ிப்பு யலபக. 
 ஧஬ பென஬ளக்க பெனல்ன௅ல஫ இபண்டு அல்஬து அதற்கு கநற்஧ட்ட 

பென஬ழகல஭க் பகளண்டுள்஭து. பென஬ளக்கம் இலணனளக பெனல்஧டுயதளல் 
இது இலணனளக்க பென஬ழ ஆகும்.  

 எவ்பயளன௉ பென஬ளக்கன௅ம் எகப கயல஬னில் பயவ்கயறு ஧குதழக஭ில் 
அல்஬து இபண்டு அல்஬து அதற்கு கநற்஧ட்ட பயவ்கயறு ஧ணிகல஭ 
பெய்கழ஫து.  

 ஧஬ பெனல்கள் இலணனளக ஥ழல஫கயற்஫ப்஧டுயதளல், இந்த அம்ெநள஦து 
அதழக஧ட்ெ இனக்கத்தழற்கு ஧னன்஧டுத்தப்஧டுகழ஫து. இது கணி஦ிப்஧ணினின் 
தழ஫ல஦ கநம்஧டுத்துகழ஫து. 

5 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஧பயல் இனக்க அலநப்஧ின் கருத்துரு ஧ற்஫ி யி஭க்குக. மநலும் அதன் 

஧னன்஧ாடுகள் னாலய? 
 டிஜழட்டல் இலணனம் யமழனளக உ஬பகங்கழலும் ஧஬ இடங்க஭ில் 

கெநழக்கப்஧ட்டு பென஬ளக்கப்஧ட்ட தபவுகள் நற்றும் ஧னன்஧ளட்டுகல஭ இந்த 
அம்ெம் கய஦ித்து பகளள்கழ஫து. 

஧பயல் இனக்க அலநப்஧ின் ஥ன்லநகள்: 
 எகப இடத்தழல் உள்஭ என௉ ஧ன஦ர், யல஬னலநப்஧ின் னெ஬ம் நற்ப஫ளன௉ 

இடத்தழலுள்஭ ஋ல்஬ள ய஭ங்கல஭னேம் ஧னன்஧டுத்த஬ளம். 
 ஧஬ கணி஦ி ய஭ங்கல஭ யல஬னலநப்஧ில் ஋஭ிதளக இலணக்க ன௅டினேம் 
 யளடிக்லகனள஭ர்கல௃டன் உள்஭ பதளடர்ன௃கல஭ கநம்஧டுத்துகழ஫து. 
 ன௃பய஬ர் (Host) கணி஦ினில் உள்஭ சுலநலனக் குல஫க்கழ஫து 

2. ஒரு இனக்க ப௃ல஫லநக்கா஦ ஧ன஦ர் இலைப௃கத்லத உருயாக்கும் ம஧ாது 
கய஦த்தில் தகாள்஭ மயண்டின ப௃க்கின கருத்துக்கல஭ ஧ட்டின஬ிடுக. 
 ஧ன஦ர் இலடன௅கநள஦து, ஥ீண்டகள஬த்தழற்கு ஧னன்஧ளட்டில் இன௉க்க கயண்டும்.  
 இலடன௅கம் ஧ன஦ரின் கதலயகல஭த் தழன௉ப்தழ பெய்னகயண்டும். 
 ஧ன஦ர் இலடன௅கநள஦து, ஧ன஦ரின் யில஬நதழப்஧ற்஫ க஥பத்லதகெநழக்கழ஫து. 

யலபகல஬கூறுக஭ள஦ ஧ட்டிகள், ென்஦ல் தழலபகள், தத்தல், ஧ணிக்கு஫ழகள் 
நற்றும் தட்டச்சு பெய்னேம் கயல஬லனக் குல஫த்தல் க஧ளன்஫லய இனக்க 
அலநப்஧ின் கூடுதல் ஧ன஦ளகும். 

 ஋ந்த என௉ தனளரிப்஧ின் உனரின க஥ளக்கன௅ம், யளடிக்லகனள஭லபத் 
தழன௉ப்தழப்஧டுத்த கயண்டும் ஋ன்஧தளகும். அகதக஧ளல், ஧ன஦ர் இலடன௅கன௅ம் 
யளடிக்லகனள஭லபத் தழன௉ப்தழப்஧டுத்துநளறு யடியலநக்கப்஧டகயண்டும் 

 ஧ன஦ர் பெய்னேம் தயறுகல஭ இலடன௅கம் குல஫க்க கயண்டும். அகதக஧ளல் 
஧ன஦ர் குல஫ந்த஧னிற்ெழனிலும், தயறுகல஭த் தயிர்க்கும் யண்ணம் இன௉த்தல் 
கயண்டும்.  
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3. இனக்க அலநப்஧ின் தசனல் மந஬ாண்லந த஥஫ிப௃ல஫கல஭ யி஭க்குக. 
என௉ கணிப்ப஧ள஫ழனின் பென஬கத்தழற்குத் கதலயனள஦ பெனல்ன௅ல஫கல஭ 
எதுக்கவடு பெய்யதற்கு கவழ்க்களணும் ப஥஫ழன௅ல஫கள் (Algorithms) ன௅தன்லநனளகப் 
஧ின்஧ற்஫ப்஧டுகழன்஫து. 

1. ன௅த஬ழல் யந்த து ன௅த஬ழல் பெல்லும் (FIFO) 
2. ெழ஫ழனது ன௅த஬ழல் (Shortest Job First) 
3. யட்ட யரிலெ (Round Robin) 
4. ன௅ன்னுரிலநக்கு ஌ற்஧ (Based on Priority) 

 ப௃த஬ில் யந்தது ப௃த஬ில் தசல்லும் (FIFO - First In First Out): 
ன௅த஬ழல் யந்தது ன௅த஬ழல் பெல்லும் ப஥஫ழன௅ல஫, யரிலெ நுட்஧த்லத 
அடிப்஧லடனளகக் பகளண்டது.  
஋.கள: நுட்஧ ரீதழனளக, யரிலெனில் ன௅த஬ழல் நுலமனேம் பெனல்ன௅ல஫ ன௅த஬ழல் 
CPU-யில் பெனல்஧டுத்தப்஧ட்டு, அடுத்தடுத்து யரிலெனளக 
பெனல்஧டுத்தப்஧டுகழன்஫஦. 

 சி஫ினது ப௃த஬ில் (Shortest Job First) 
இந்த ப஥஫ழன௅ல஫, லநனச் பென஬கத்தளல் இனக்கப்஧டும் என௉ கயல஬னின் 
அ஭லய அடிப்஧லடனளகக் பகளண்டது.  
எ.கா: A நற்றும் B ஋஦ இபண்டு கயல஬கல஭ ஋டுத்துக்பகளள்கயளம். இதழல், 
A கயல஬னின் அ஭வு 6KB நற்றும் B கயல஬னின் அ஭வு 9 KB. இந்த இபண்டு 
கயல஬க஭ில், A கயல஬னின் அ஭வு, B கயல஬லன யிடகுல஫யளக 
இன௉ப்஧தளல், ன௅த஬ழல் A கயல஬ இனக்கப்஧டும். 

 யட்ை யரிலச திட்ைநிைல் (Round Robin) 
யட்ட யரிலெ தழட்டநழடல் ‚க஥பப் ஧கழர்வு அலநப்ன௃‛-கல௃க்கு (Time Sharing 
System) ெழ஫ப்஧ளக யடியலநக்கப்஧ட்ட ப஥஫ழன௅ல஫ ஆகும். சுமற்ெழ ன௅ல஫னில், 
எவ்பயளன௉ ஧ணிக்கும், என௉ கு஫ழப்஧ிட்ட க஥பம் எதுக்கப்஧டும்.  
஋.கள: A, B, C ஋஦ னென்று கயல஬கள் இன௉ப்஧தளக ஋டுத்துக்பகளள்கயளம். 
இதழல், ன௅த஬ளயது A ஧ின்஦ர் B அலத பதளடர்ந்து C ஋஦ எவ்பயளன௉ 
கயல஬க்கும் என௉ கு஫ழப்஧ிட்ட க஥பம் சுமற்ெழ ன௅ல஫னில் லநனச் 
பென஬கத்தளல் எதுக்கப்஧டும். நீண்டும் அடுத்த சுமற்ெழனில் யட்டயரிலெ 
ன௅ல஫னில் கயல஬ எதுக்கவடு பெய்னப்஧டும். 

 ப௃ன்னுரிலநக்கு ஏற்஧ (Based on Priority) 
பகளடுக்கப்஧ட்ட கயல஬ ன௅ன்னுரிலந அடிப்஧லடனில் எதுக்கப்஧ட்டுள்஭து. 
நற்஫ கயல஬கல஭ யிட அதழக ன௅ன்னுரிலந பகளண்டின௉க்கும் கயல஬ 
நழகவும் ன௅க்கழனநள஦து. 
஋.கள: இபண்டு கயல஬கள் A நற்றும் B ஋஦ ஋டுத்துக்பகளள்கயளம். A-க்கு 
ன௅ன்னுரிலந ஋ண் 5 ஋஦வும், B-க்கு 7 ஋஦வும் இன௉ந்தளல், ன௅த஬ழல் B-
க்குதளன் பென஬கம் எதுக்கப்஧டும். 
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஧ாைம் 5 . யிண்மைாஸ் - ல் மயல஬ தசய்தல் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. கவகம பகளடுக்கப்஧ட்டுள்஭யற்றுள் இனக்கஅலநப்ன௃ ஥ழர்யகழக்கும் பெனல்கல஭த் 
கதர்வு பெய்னவும்  
(அ) ஥ழல஦யகம் (ஆ) பென஬ழ (இ) I/O ெளத஦ங்கள் (ஈ) இலயஅல஦த்தும் 

2. யிண்கடளஸ் ஧னன்஧ளட்டில் ககளப்ன௃கள் பகளடள஥ழல஬னளக ஋ந்த ககளப்ன௃ல஫னில் 
கெநழக்கப்஧டும்?  
(அ) My document (ஆ) My Picture (இ) Document and settings  (ஈ) My Computer 

3. ஋ந்த இனக்கலநப்஧ில் shift + delete ஋ன்஫ கதர்வு ககளப்ன௃ நற்றும் ககளப்ன௃ல஫லன 
஥ழபந்தபநளக ஥ீக்கும்?  
(அ) windows 7 (ஆ) windows 8 (இ) windows 10 (ஈ) இலயஅல஦த்தும் 

4. Windows XP/Windows 7 ல் ‚லல஧ர்க஦ட்‛஋ன்஧தன் ப஧ளன௉ள் ஋ன்஦?  
அ) Safe mode ல் கணி஦ிலன நறுபதளடக்கம் பெய்தல்.  
ஆ) hibernate mode ல் கணி஦ிலன ஥ழறுத்துதல்.  
இ) இனக்கத்தழல் இன௉க்கும் ஧னன்஧ளடுகல஭ ஥ழறுத்தழன ஧ி஫கு கணி஦ிலன 
஥ழறுத்துதல்.  
ஈ) இனக்கத்தில் இருக்கும் ஧னன்஧ாடுகல஭ ஥ிறுத்தாநல் கணி஦ிலன 
஥ிறுத்துதல். 

5. ெள஭பங்க஭ில் என௉ ககளப்஧ின் நறுப஧னரிட ஧னன்஧டுத்தப்஧டும் குறுக்குயமழ யிலெ 
(அ) F2  (ஆ) F4  (இ) F5  (ஈ) F6 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஧ல்஧ணினாக்கம் என்஫ால் என்஦ ? 

 யிண்கடளஸ் - ல் எகப க஥பத்தழல் என்றுக்கும் கநற்஧ட்ட ஧னன்஧ளடுகல஭ 
இனகக ன௅டினேம் இதற்கு ‚஧ல்஧ணினளக்கம்‛ (Multitasking) ஋ன்று ப஧னர். 

2. தசந்தப஧ணிக்கு஫ி என்஫ால் என்஦ ? 
 யிண்கடளஸ் இனக்க அலநப்ன௃ ஥ழறுயப்஧டும் க஧ளது உன௉யளக்கப்஧டும் 

பகளடள஥ழல஬ ஧ணிக்கு஫ழகள், "பெந்தப஧ணிக்கு஫ழகள்" ஋஦ அலமக்கப்டுகழி்஫து.  
஋.கள: MyComputer, Documents நற்றும் Recycle Bin க஧ளன்஫லய.  

3. மகாப்பு நற்றும் மகாப்புல஫க்கு உள்஭ யித்தினாசங்கள் னாலய? 
மகாப்பு மகாப்புல஫ 

கணிப்ப஧ள஫ழனில் அல஦த்து 
தகயல்கல௃ம் ககளப்ன௃க஭ளக 
கெநழக்கப்஧டுகழ஫து. 

ககளப்ன௃கல஭ என௉ங்கலநக்க 
ககளப்ன௃ல஫கள் ஧னன்஧டுகழ஫து. 

4. Save நற்றும் Save As - க்கு உள்஭ யித்தினாசங்கள் னாலய? 
Save Save As 

என௉ ககளப்ல஧ ன௅தன்ன௅த஬ழல் 
கணிப்ப஧ள஫ழனில் கெநழக்க Save  
கட்டல஭ ஧னன்஧டுகழ஫து. 

஌ற்க஦கய கெநழக்கப்஧ட்ட ககளப்ல஧ 
கயப஫ளன௉ ப஧னரில் கெநழக்க Save As 
கட்டல஭ ஧னன்஧டுகழ஫து. 

5. ஒரு மகாப்ல஧ எவ்யாறு நறுத஧னரிடுயரீ்கள்? 
நறுப஧னரிட கயண்டின ககளப்ல஧ கதர்வு பெய்து,  
 File -> Rename ஋ன்஫ ஧ட்டிப்஧ட்லட கதர்யின் னெ஬ன௅ம், 
 ககளப்஧ின் நீது ய஬து கழ஭ிக் பெய்து யன௉ம் ஧ட்டின஬ழல் Rename ஋ன்஫ கதர்லய 

கழ஭ிக் பெய்யதன் னெ஬ன௅ம், 
 யிலெப்஧஬லகனில் உள்஭ F2 ப஧ளத்தளல஦ அழுத்துயதன் னெ஬ன௅ம் 

நறுப஧னரிட஬ளம். 
 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. யிண்மைாஸ் இனக்கஅலநப்஧ின் தசனல்஧ாடுகள் னாலய? 

 பெளற்பென஬ழகள், அட்டயலணச்பென஬ழகள், கணிப்஧ளன், யில஭னளட்டுகள் 
க஧ளன்஫ ஧னன்஧ளடுல஭ இனக்குகழ஫து. 

 கணிப்ப஧ள஫ழனில் ன௃தழன ஧னன்஧ளடுல஭ ஥ழறுவுயதற்கு ஧னன்஧டுகழ஫து. 
 அச்சுப்ப஧ள஫ழ, யன௉டி, சுட்டி, இ஬க்கயலக ககநபள க஧ளன்஫ யன்ப஧ளன௉ள்கல஭ 

கந஬ளண்லந பெய்கழ஫து. 
 ககளப்ன௃ ந஫றும் ககளப்ன௃ல஫கள் உன௉யளக்குதல், ஧தழப்஧ளய்வு பெய்தல், 

கெநழத்தல், அமழத்தல் க஧ளன்஫ ககளப்ன௃ கந஬ளண்லந பெனல்஧ளடுகல஭ 
பெய்கழ஫து. 
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2. நறுசுமற்சி த஧ட்டிலன ஧ற்஫ி ஒரு கு஫ிப்பு யலபக. 
 நறுசுமற்ெழ பதளட்டி ஋ன்஧து, ஧ன஦பளல் ஥ீக்கப்஧ட்ட ககளப்ன௃ அல்஬து 

ககளப்ன௃ல஫கல஭, தற்கள஬ழகநளக கெநழத்து லயக்க ஧னன்஧டும் ெழ஫ப்ன௃ 
ககளப்ன௃ல஫னளகும்.  

 அமழக்கப்஧ட்ட ககளப்ன௃கல஭ நீட்படடுக்க இது நீண்டும் என௉ யளய்ப்ல஧ 
யமங்குகழ஫து.  

 நறுசுமற்ெழத் பதளட்டினிலுள்஭ ககளப்ன௃கள் நற்றும் ககளப்ன௃ல஫கல஭ 
நீட்படடுக்களநல் இனக்க ன௅டினளது. 
 

3. யிண்மைாஸ் சன்஦ல் திலபக்கூறுகல஭ப் ஧ற்஫ி கு஫ிப்பு யலபக. 
 தல஬ப்புப்஧ட்லை: தழ஫ந்துள்஭ஆயணத்தழன் ப஧னர் அல்஬து ஧னன்஧ளட்டின் 

ப஧னர் தல஬ப்ன௃ப் ஧ட்லடனில் கதளன்றும்.  கநலும் ெழ஫ழதளக்கு, ப஧ரினதளக்கு நற்றும் 

னெடு ப஧ளத்தளன்கல௃ம் தல஬ப்ன௃ ஧ட்லடனில் உள்஭஦.  

 ஧ட்டிப்஧ட்லை: தல஬ப்ன௃ ஧ட்லடனின் கவழ் ன௃஫ம் ஧ட்டிப்஧ட்லட களணப்஧டும்.  
 ஧ணித்த஭ம்: என௉ ஆயணத்தழல் உலபலனத் தட்டச்சு பெய்னேம் ஆயண ென்஦ல் 

தழலபனின் ஧குதழ ஧ணித்த஭ம் ஆகும்.  
 உரு஭ல் ஧ட்லை: உன௉஭ல் ஧ட்லடகள் ஧ணித்த஭த்லதச் பெங்குத்தளகவும், 

கழலடநட்டநளகவும் உன௉஭ பெய்னப் ஧னன்஧டுகழ஫து 
 ப௄ல஬கள் நற்றும் எல்ல஬கள்: யிண்கடளறழல் அ஭லய நளற்஫ழ அலநக்க 

னெல஬ நற்றும்  ஋ல்ல஬ உதயி  பெய்கழ஫து. 

4. ஒரு மகாப்புலபலன உருயாக்கும் இபண்டு யமிப௃ல஫கல஭ எழுதுக. 
யமிப௃ல஫ 1: 
 கம்ப்னைட்டர் குறும்஧டத்லத கழ஭ிக் பெய்து, ன௃தழன ககளப்ன௃ல஫லன உன௉யளக்க 

யின௉ம்ன௃ம் இனக்கழலன தழ஫க்கவும்.  
 File → New → Folder ஋ன்஧லத கழ஭ிக் பெய்தளல் ன௃தழன ககளப்ன௃ல஫, தள஦லநயளக 

‚New Folder‛ ஋஦ உன௉யளகும். 
யமிப௃ல஫ 2: 
 தழலபன௅கப்஧ில் நற்றும் கதலயனள஦ இடத்தழல் சுட்டினின் ய஬து 

ப஧ளத்தளல஦க் கழ஭ிக்பெய்து, New → Folder ஋ன்஫ கட்டல஭லனக் கழ஭ிக் 
பெய்தளல் ப஧னரிடப்஧டளத new folder ககளப்ன௃ல஫ கதளன்றும்.  

 

5. தயட்டுதல் நற்றும் ஥கத஬டுத்தல்- க்கு உள்஭ மயறு஧ாடுகள் னாலய? 
தயட்டுதல் ஥கத஬டுத்தல் 

ககளப்ன௃ அல்஬து ககளப்ன௃ல஫கல஭ னெ஬ 
இடத்தழ஬ழன௉ந்து ன௃தழன இடத்தழற்கு 
஥கர்த்துதல் பயட்டுதல் ஋஦ப்஧டும். 

ககளப்ன௃ அல்஬து ககளப்ன௃ல஫க஭ின் 
஧ிபதழலன ன௃தழன இடத்தழற்கு ஥கர்த்துதல் 
஥கப஬டுத்தல் ஋஦ப்஧டும். 

னெ஬க் ககளப்ன௃கள் அமழக்கப்஧டும். னெ஬க் ககளப்ன௃கள் 
அமழக்கப்஧டுயதழல்ல஬. 

கட்டல஭: Edit → Cut (or) Ctrl + X 
         Edit → Paste (or) Ctrl + V          

கட்டல஭: Edit → Copy (or) Ctrl + C 
         Edit → Paste (or) Ctrl + V          
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. யிண்மைாஸ் இனக்கஅலநப்஧ின் ஧஬யலகனா஦ ஧திப்புகல஭ யியரி. 

஧திப்புகள் ஆண்டு ப௃க்கின சி஫ப்஧ினல்புகள் 
யிண்மைாஸ் 1.x 1985 16 ஧ிட்டுக஭ில் யலபகல஬ ஧ன஦ர் இலடன௅கம் 

அ஫ழன௅கம் பெய்னப்஧ட்டது. 
உள்஭டீ்டு ெளத஦நளக சுட்டி அ஫ழன௅கநள஦து. 

யிண்மைாஸ் 2.x 1987 ென்஦ல் தழலபலன ெழ஫ழதளக்குதல் அல்஬து 
ப஧ரிதளக்குதல் யெதழ. 
கட்டுப்஧ளட்டகம் அ஫ழன௅கம் பெய்னப்஧ட்டது. 

யிண்மைாஸ் 3.x 1992 
 

‚஧ல்஧ணி கன௉த்துன௉‛ அ஫ழன௅கநள஦து. 
256 யண்ணங்கல஭ இனக்கும் தழ஫க஦ளடு நழக஥ய஦ீ 
யண்ணநனநள஦து. 

யிண்மைாஸ் 95 1995 பதளடக்க ப஧ளத்தளன், பதளடக்கப்஧ட்டி, ஧ணிப்஧ட்லட, 
யிண்கடளஸ் ஋க்ஸ்ப்க஭ளபர் அ஫ழன௅கநள஦து. 
32஧ிட் நுண்பென஬ழ அ஫ழன௅கநள஦து. 

யிண்மைாஸ் 98 1998 
 

Internet Explorer ஋ன்னும் உ஬யி அ஫ழன௅கநள஦து. 
யிண்கடளஸ் அடிப்஧லடனி஬ள஦ யில஭னளட்டுகள் 
கநம்஧டுத்தப்஧ட்டது. 

யிண்மைாஸ் NT 
 

 யல஬னலநப்஧ில் கெலயனகநளக 
யடியலநக்கப்஧ட்டது. 

யிண்கடளஸ் 2000 2000 ஥ளன்கு ஧தழப்ன௃கள் பய஭ினிடப்஧ட்ட஦. 
யிண்மைாஸ் XP 2001 64-஧ிட் நுண்பென஬ழகள் அ஫ழன௅கம். 

யிண்கடளஸ் கதளற்஫ம் நற்றும் ஧ணித்த஭ம் 
கநம்஧டுத்தப்஧ட்டது. 

யிண்மைாஸ் 7 2009 கணிப்ப஧ள஫ழனின் பதளடங்குதல் க஥பம் 
கநம்஧டுத்தப்஧ட்டது. 
஌கபள ஧கீ், ஧ணிப்ப்லடனில் ஧னன்஧ளடுகல஭ 
இலணத்தல், லகபனழுத்து உணர்தல், இன்டர்ப஥ட் 
஋க்ஸ்ப்க஭ளபர் 8 க஧ளன்஫ ன௃தழன ஧ன஦ர் இலடன௅க 
யெதழகள் அ஫ழன௅கப்஧டுத்தப்஧ட்டது. 

யிண்மைாஜ் 8 2012 ஧ல் அடுக்கு நுண்பென஬ழ, பதளடுதழலப, நளற்று 
உள்஭டீ்டு ன௅ல஫கள் க஧ளன்஫ ெழ஫ப்஧ம்ெங்கள் 
கெர்க்கப்஧ட்டது. 
லகக஧ெழ நற்றும் கணிப்ப஧ள஫ழகல௃க்கள஦ ப஧ளதுயள஦ 
஧ணிகநலடனளக பெனல்஧டுகழ஫து. 

யிண்மைாஸ் 10 2015 என்றுக்கும் கநற்஧ட்ட தழலப ன௅கப்ன௃. 
‚பென஬ழ அ஫ழயிப்ன௃‛ நற்றும் ‚யிலபவு ஥டயடிக்லக 
பென஬ழக்கள஦ நத்தழன அ஫ழயிப்ன௃ லநனம்‛ அ஫ழன௅கம். 
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2. ஒரு மகாப்பு அல்஬து மகாப்புலபலன மதடிக்கண்டு஧ிடிக்கும் ஧ல்மயறு 
யமிப௃ல஫கல஭ யி஭க்குக.  
கணி஦ினில் அல்஬து கு஫ழப்஧ிட்ட இனக்கழக஭ில் உள்஭ ககளப்ன௃ அல்஬து 
ககளப்ன௃ல஫லன யிலபயளக கதடுயதற்கு பதளடக்கப் ப஧ளத்தள஦ிலுள்஭ Search 
ப஧ட்டி ஧னன்஧டுத்தப்஧டுகழ஫து. 
மகாப்பு அல்஬து மகாப்புல஫லனக் கண்டு஧ிடிக்க, 
 Start ப஧ளத்தளல஦ கழ஭ிக் பெய்தளல், பதளடக்கப஧ட்டினின் கலடெழனில் Search 

ப஧ட்டி களணப்஧டும். 
 அதழல், கதடப்஧ட கயண்டின ககளப்ன௃ அல்஬து ககளப்ன௃ல஫னின் ப஧னலப 

தட்டச்சு பெய்ன கயண்டும். 
 கு஫ழப்஧ிடப்஧ட்ட ப஧னரிலுள்஭ ககளப்ன௃ அல்஬து ககளப்ன௃ல஫கள் தழலபனில் 

கதளன்றும். அதல஦ கழ஭ிக்பெய்தளல், ககளப்ன௃ க஥படினளக தழ஫க்கும். 
 Search ப஧ட்டிக்கு கநக஬ ‚See more results‛ ஋ன்஫ நற்ப஫ளன௉ கதர்வும் உள்஭து. 
 இந்த கதர்லயக் கழ஭ிக்பெய்னேம் க஧ளது, Search Results உலபனளடல் ப஧ட்டி 

கதளன்றும். இதன் னெ஬ன௅ம், ககளப்ன௃ அல்஬து ககளப்ன௃ல஫கல஭ கதடி 
தழ஫க்க஬ளம். 
 

3. யிண்மைாஸ் இனக்க அலநப்஧ில் குறுக்கு யமி ஧ணிக்கு஫ிகல஭ 
உருயாக்கும் தசனல் ப௃ல஫லன யி஭க்குக.  
 ஥நது கயல஬லனத் தள஦ினங்கழனளக நளற்றுயதற்கு ஥நக்கு அடிக்கடி 

஧னன்஧டும் ககளப்ன௃கள் நற்றும் ககளப்ன௃ல஫க஭ின் குறுக்கு யமழகல஭ 
உன௉யளக்கழ, அலத ன௅கப்ன௃த்தழலபனில் லயக்க஬ளம்.  

 ன௅த஬ழல் ககளப்ன௃ அல்஬து ககளப்ன௃ல஫லன கதர்வு பெய்து, அதன் நீது ய஬து 
கழ஭ிக் பெய்ன கயண்டும். 

 அப்ப஧ளழுது என௉ கநல்நீட்ன௃ப் ஧ட்டி கதளன்றும். அதழ஬ழன௉ந்து Send to → Desktop 
(Create Shortcut) ஋ன்஫ கதர்லய கழ஭ிக்பெய்தளல் யிண்கடளஸ் தழலபன௅கப்஧ில், 
ககளப்ன௃ அல்஬து ககளப்ன௃ல஫னின் குறுக்குயமழ ஧ணிக்கு஫ழ கதளன்றும்.  
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஧ாைம் 6. தசாற்தசன஬ி 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. ஏ஧ன் ஆஃ஧றீழன் யபகயற்ன௃த் தழலப ஋து? 
அ) ஸ்டளர் படக்ஸ்டளப்   ஆ) ஸ்ைார் தசன்ைர்  
இ) ஸ்டளர் தழலப    ஈ) ஸ்டளர் யிண்கடள 

2. இயற்றுள் ஋ந்த யின௉ப்஧ம் ஧ன஦பளல் ெளயி அல்஬து ெளயி கெர்நள஦ம் னெ஬ம் 
உலப, அட்டயலணகள் நற்றும் யலப஧டங்கள் (graphics) க஧ளன்஫யற்ல஫ 
இலணக்க ன௅டினேம்? 
அ) Autoformat   ஆ) Automatic   இ) Auto text   ஈ) Autographics 

3. ஋ண் யரிலெனிடும் யின௉ப்஧த்லத பகளண்ட ஧ட்டிப்஧ட்லட ஋து? 
அ) File   ஆ) Edit   இ) Tools   ஈ) Format 

4. இயற்றுள் ஋து தழலபனின் கநல் ஧குதழனில் கதளன்றும்? 
அ) ஧ட்டிப்஧ட்லட  ஆ) கன௉யிப்஧ட்லட 
இ) தல஬ப்புப் ஧ட்லை ஈ) யடிவூட்டல் ஧ட்லட 

5. இயற்றுள் ஋து உலபனின் பகளடள ஥ழல஬ கதளற்஫ம் ? 
அ) உலப யடிவூட்ைம்  ஆ) ஧க்க யடிவூட்டம்  
இ) ெழ஫ப்ன௃ யடிவூட்டம்  ஈ) ஧த்தழ யடிவூட்டம் 

6. Find & Replace அம்ெம் ஋ந்த ஧ட்டிப்஧ட்லடனில் உள்஭து? 
அ) File  ஆ) Edit  இ) Tools  ஈ) Format 

7. ஆயணத்தழல் உள்஭ கதடப்஧டும் யளர்த்லத கதளன்றும் ஋ல்஬ள இடங்கல஭னேம் 
கதர்வு பெய்னேம் ப஧ளத்தளன் ஋து? 
அ) Find  ஆ) Find All  இ) Replace  ஈ) Replace All 

8. ஆயணத்தழன் பதளடக்கத்தழற்கு பெல்஬ குறுக்கு யமழ ெளயி ஋து ? 
அ) Ctrl + Home  ஆ) Ctrl + End  இ) Home  ஈ) End 

9. என௉ ஆயணத்தழல் கதடல் நற்றும் நளற்஫ழனலநத்தலுக்கள஦ குறுக்குயமழ ெளயி 
஋து? 
அ) Ctrl + F1   ஆ) Ctrl + F4   இ) Ctrl + F5   ஈ) Ctrl +F 

10. ஌ற்க஦கய பெய்த பெனல஬ தயிர்க்க உதவும் குறுக்கு யமழ ெளயி கெர்நள஦ம் 
னளது? 
அ) Ctrl +E   ஆ) Ctrl + U   இ) Ctrl + Z   ஈ) Ctrl + n 

 
 
 
 
 
 
 
 
 
 
 
 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 31 

 

2 நதிப்த஧ண் யி஦ாக்கள்: 
1. உங்கள் ஆயணத்தில் ஧ைங்கல஭ எவ்யாறு மசர்ப்஧ாய்? 

 ஋ந்த இடத்தழல் ஧டத்லத கெர்க்க கயண்டுகநள அந்த இடத்தழல் பென௉கும் 

ன௃ள்஭ிலன லயத்துக் பகளண்டு Insert → Picture →From file ஋ன்஫ கட்டல஭லனத் 

கதர்வு பெய்ன கயண்டும். 
 Insert Picture உலபனளடல் ப஧ட்டி ஧டத்பதளகுப்ன௃டன் கதளன்றும். அதழல் கதலயனள஦ 

஧டத்லதத் கதர்வு பெய்து Open ப஧ளத்தளல஦ கழ஭ிக் பெய்தளல் கதர்வு 

பெய்னப்஧ட்ட ஧டம் ஆயணத்தழல் கெர்க்கப்஧ட்டின௉க்கும்.  

2. ஓ஧ன் ஆஃ஧ீஸ் - ல் உள்஭ ஧ல்மயறு ததாகுப்புகள் னாலய?  

 ஏ஧ன் ஆஃ஧ஸீ் லபட்டர் (OpenOffice Writer) - உலப ஆயணங்கல஭ உன௉யளக்கப் 

஧னன்஧டும் பெளற்பென஬ழ. 
 ஏ஧ன் ஆஃ஧ஸீ் களல்க் (OpenOffice Calc) - அட்டயலணத் தளள்கல஭ உன௉யளக்கப் 

஧னன்஧டும் அட்டயலணச் பென஬ழ. 
 ஏ஧ன் ஆஃ஧ஸீ் க஧ஸ் (OpenOffice Base) – தபவுத்த஭ங்கல஭ உன௉யளக்கப் ஧னன்஧டும். 

 ஏ஧ன் ஆஃ஧ஸீ் இம்ப்பபஸ் (OpenOffice Impress) - ஥ழகழ்த்துதல஬ உன௉யளக்கப் 

஧னன்஧டும். 

 ஏ஧ன் ஆஃ஧ஸீ் ட்பள (OpenOffice Draw) - ஧டங்கள் யலபன ஧னன்஧டும்.  
 ஏ஧ன் ஆஃ஧ஸீ் ஧ளர்ன௅஬ள (OpenOffice Formula) - யளய்ப்஧ளடுகள் நற்றும் 

ெநன்஧ளடுகல஭ உன௉யளக்க ஧னன்஧டும்.  

3. லபட்ைரில் தா஦ினங்கு உலப (Auto Text) என்஫ால் என்஦? 

 Auto Text ஋ன்஧து அடிக்கடி ஧னன்஧டுத்தப்஧டும் ெழ஬ உலபக்கு குறுக்கு யமழகல஭ 
எதுக்க உதவுகழ஫து. 

4. அட்ையலணனில் சிற்஫ல஫கல஭ எவ்யாறு இலணப்஧ாய்? 

 என்஫ளக இலணக்கப்஧ட கயண்டின ெழற்஫லபகல஭ கதர்வு பெய்னகயண்டும். 

 ய஬து கழ஭ிக்பெய்து அதழல் Cell → Merge  அல்஬து ஧ட்டி ஧ட்லடனிலுள்஭  Table → 

Merge cells ஋ன்஫ கட்டல஭லன ஧னன்஧டுத்தழ ெழற்஫ல஫கல஭ இலணக்க஬ளம். 

5. த஦ிப௅ரிநம் த஧ற்஫ தநன்த஧ாருள் நற்றும் தி஫ந்தப௄஬ தநன்த஧ாருள் ஧ற்஫ின 

மயறு஧ாடுகல஭ எழுதுக. 

த஦ிப௅ரிநம் த஧ற்஫ தநன்த஧ாருள் தி஫ந்தப௄஬ தநன்த஧ாருள் 

஧ன஦ர், பநன்ப஧ளன௉ல஭ உன௉யளக்கழன 
஥ழறுய஦த்தழற்கு ஧ணம் பெலுத்தழ 
஧னன்஧டுத்த கயண்டும். 

இலணனத்தழல் இ஬யெநளக கழலடக்கும். 

஧ன஦ர், பநன்ப஧ளன௉ல஭ 
நளற்஫ழனலநக்க ன௅டினளது. 

஧ன஦ர், பநன்ப஧ளன௉ல஭ 
நளற்஫ழனலநக்க ன௅டினேம். 

 
3 நதிப்த஧ண் யி஦ாக்கள்: 

1. ஥கர்த்தல் நற்றும் ஥கத஬டுத்தல் ஧ற்஫ின மயறு஧ாடுகல஭ எழுதுக. 

஥கர்த்தல் ஥கத஬டுத்தல் 

கதர்வு பெய்னப்஧ட்ட உலபனள஦து னெ஬ 
இடத்தழ஬ழன௉ந்து ஥ீக்கப்஧ட்டு, இ஬க்கு 
இடத்தழல் லயக்கப்஧டும். 

கதர்வு பெய்னப்஧ட்ட உலபனள஦து னெ஬ 
இடத்தழ஬ழன௉ந்து ஥கப஬டுக்கப்஧ட்டு, 
இ஬க்கு இடத்தழற்கு அனுப்஧ப்஧டும். 

Edit → cut & Edit → paste ஋ன்஫ கட்டல஭ 
னெ஬ம் ஥ழல஫கயற்஫ப்஧டுகழ஫து. 

Edit → copy & Edit → paste ஋ன்஫ கட்டல஭ 
னெ஬ம் ஥ழல஫கயற்஫ப்஧டுகழ஫து. 
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2. ஧க்கஅலநவுகள் எத்தல஦ யலகப்஧டும்? 

஧க்கஅலநவுகள் இபண்டு யலகப்஧டும். அலய, 

 ஧க்கயாக்கு யடியம் (Landscape):  

ஆயணத்தழன் அக஬ம் அதன் ஥ீ஭த்லத யிட ப஧ரிதளக இன௉ந்தளல் அது ஧க்கயளக்கு 

யடியம் ஋஦ப்஧டும். பதளமழல் ன௅ல஫ ன௃லகப்஧டங்கள், அலமப்஧ிதழ்கள் 

க஧ளன்஫யற்஫ழற்கு  இந்த அலநவு நழகவும் ஧னனுள்஭தளக இன௉க்கும். 

 ஥ீ஭யாக்கு யடியம் (Portrait): 

பகளடள஥ழல஬னளக என௉ ஆயணத்தழன் ஧க்கலநயள஦து ஥ீ஭யளக்கழல் இன௉க்கும். 

இந்த அலநயில் ஆயணத்தழன் ஥ீ஭ம் அதன் அக஬த்லத யிட ப஧ரிதளக இன௉க்கும். 

ன௃த்தகங்கள், பெய்தழத்தளள்கள் க஧ளன்஫லய ப஧ளதுயளக இந்த யடியத்தழல் 

அச்ெழடப்஧டும். 
3. அட்ையலணனில் யரிலசகள் நற்றும் த஥டுயரிலசகல஭ எவ்யாறு 

மசர்க்க஬ாம்? 

 யரிலெ நற்றும் ப஥டுயரிலெகல஭ உன௉யளக்க, அட்டயலணனில் கதலயனள஦ 
இடத்தழல் ய஬து கழ஭ிக் பெய்ன கயண்டும். 

 யரிலெலன உன௉யளக்க Row → Insert ஋ன்஫ கட்டல஭லனனேம், ப஥டுயரிலெலன 
உன௉யளக்க Column → Insert ஋ன்஫ கட்டல஭லனனேம் கழ஭ிக் பெய்ன கயண்டும்.  

 கதளன்றும் உலபனளடல் ப஧ட்டினில் ஧ன஦ன௉க்கு கதலயனள஦ யரிலெ அல்஬து 

ப஥டுயரிலெக஭ின் ஋ண்ணிக்லககல஭ கெர்க்க஬ளம்.  
4. ஆயணத்லத மசநிக்ககூடின ஧ல்மயறு யமிகள் னாலய? 

 File → Save அல்஬து File → Save As அல்஬து Ctrl + S கழ஭ிக்பெய்தளல் “Save As” ஋ன்஫ 

உலபனளடல் ப஧ட்டி கதளன்றும். 

 ஆயணத்லத கெநழக்கும் இடத்லத கதர்வு பெய்து, File Name ஋ன்஫ உலபப் 

ப஧ட்டினில் ஆயணத்தழன் ப஧னலப தட்டச்சு பெய்து Save ப஧ளத்தளல஦ கழ஭ிக் 
பெய்ன கயண்டும். 

 கெநழக்கும் இடம் கதர்வு பெய்னளயிடில் அல஦த்து ஆயணங்கல௃ம் தள஦லநயளக 
யிண்கடளறழல் உள்஭ “Documents”  ககளப்ன௃ல஫னில் கெநழக்கப்஧டும். 

 

5. உலபனில் யரி இலைதய஭ிலன நாற்றும் யமிகள் ஧ற்஫ி எழுதுக. 

யமிப௃ல஫ 1: 
 கதலயனள஦ உலபலன கதர்வு பெய்து, ய஬து ப஧ளத்தளல஦க் கழ஭ிக் பெய்தளல் 

கதளன்றும் கநல் நீட்ன௃ ப஧ட்டினில் உள்஭ line spacing ஋ன்஫ கதர்லய கழ஭ிக் பெய்ன 
கயண்டும். 

 இப்க஧ளது கதளன்றும் Single, 1.5 அல்஬து Double க஧ளன்஫ ஌கதனும் யரி 

இலடபய஭ிலனத் கதர்வு பெய்ன஬ளம். 

யமிப௃ல஫ 2: 
 Edit → Select All கட்டல஭லனப் ஧னன்஧டுத்தழ ன௅ழு ஆயணத்லதனேம் கதர்வு பெய்ன 

கயண்டும்.  

 Format → paragraph ஋ன்஫ கட்டல஭லனக் கழ஭ிக் பெய்தளல் Paragraph உலபனளடல் 

ப஧ட்டி கதளன்றும்.  

 இதழல் Indents & Spacing பதளகுதழலனக் கழ஭ிக் பெய்து, Line Spacing யலகனிழு 

஧ட்டினில் கதலயனள஦ யரி இலடபய஭ிலனத் கதர்வு பெய்து OK ப஧ளத்தளல஦க் 
கழ஭ிக் பெய்ன கயண்டும். 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. லபட்ைரில் ஧க்கஓபங்கல஭ நாற்றும் யமிகல஭ப் ஧ற்஫ி எழுதுக. 

஧க்கத்தழன் ஏபங்கல஭ நளற்஫ ஏ஧ன் ஆஃ஧ஸீ் லபட்டரில் இன௉ யமழகள் உள்஭஦: 

1) ரூ஬ரின் உதயிப௅ைன் ஧க்கத்தின் ஓபங்கல஭ நாற்஫: 
ஏபத்தழன் அ஭வுகள் ெரினளகத் பதரினளத ப஧ளழுது னொ஬ர்கள் பகளண்டு 

யிலபயளகவும் நற்றும் ஋஭ிதளகவும் நளற்஫஬ளம். 

 னொ஬ரின் நங்க஬ளக உள்஭ ஧குதழகக஭ ஏபங்க஭ளகும். 

 சுட்டினின் சுட்டிலன ெளம்஧ல் ஥ழ஫ப்஧குதழக்கும் பயள்ல஭ ஥ழ஫஧குதழக்கும் 

இலடகன லயத்தளல் சுட்டின் சுட்டினள஦து இன௉ தல஬ பகளண்ட 

அம்ன௃க்கு஫ழனளக நளறும். 

 சுட்பட஬ழனின் இடது ன௃஫ ப஧ளத்தளல஦ அழுத்தழக் பகளண்கட சுட்பட஬ழலன 
ஏபங்கள் நீது ஥கர்த்தழ, கதலயனள஦ இடத்தழல் அழுத்துதல஬ யிடுயித்தளல் 

ன௃தழன ஏபங்கள் அலநனேம். 

2) Page style உலபனாைல் த஧ட்டினின் ப௄஬ம் ஒபங்கல஭ நாற்஫: 
ஏபத்தழன் அ஭வுகள் ெரினளகத் பதரிந்தளல் Page style உலபனளடல் ப஧ட்டி பகளண்டு 

ஏபங்கல஭ நளற்஫஬ளம். 

 ஧க்கத்தழல் ஌கதனும் ஏரிடத்தழல் சுட்பட஬ழனின் ய஬து ப஧ளத்தளல஦ கழ஭ிக் 
பெய்தளல் கநல் நீட்ன௃ப் ஧ட்டி கதளன்றும். அதழல் page கதர்வு பெய்னவும் 

அல்஬து Page Style உலபனளடல் ப஧ட்டினில் page பதளகுதழலனத் கதர்வு 

பெய்னவும். 

 Margins ப஧ட்டினில் இடது, ய஬து, கநல் நற்றும் கவழ் ஏபங்கல௃க்கு உரின 

நதழப்ல஧ தட்டச்சு பெய்த OK ப஧ளத்தளல஦ கழ஭ிக் பெய்ன கயண்டும். 

 

2. தல஬ப்பு நற்றும் அடிக்கு஫ிப்பு என்஫ால் என்஦? இயற்஫ில் எவ்யாறு 

஧க்கஎண்கல஭ மசர்ப்஧ாய்? 

 தல஬ப்ன௃ ஋ன்஧து என௉ ஧க்கத்தழன் கநல் ஧குதழலனக் கு஫ழக்கும், தல஬ப்ன௃ ஧குதழனில், 

தல஬ப்ன௃ நற்றும் நூ஬ளெழரினர் ப஧னர் க஧ன்஫யற்ல஫ கெர்க்க஬ளம்.  

 அடிக்கு஫ழப்ன௃ ஋ன்஧து ஧க்கத்தழன் கவழ் ஧குதழலனக் கு஫ழக்கும், அடிக்கு஫ழப்஧ில் 

஧க்க஋ண்கள், கததழ, க஥பம் க஧ளன்஫யற்ல஫ கெர்க்க஬ளம்.  

தல஬ப்பு உருயாக்க: 
 Insert → Header → Default ஋ன்஫ கட்டல஭லன ஧ட்டிப்஧ட்லடனி஬ழன௉ந்து கதர்வு பெய்ன 

கயண்டும். 

அடிக்கு஫ிப்புகல஭ உருயாக்க: 
 Insert → Footer → Default ஋ன்஫ கட்டல஭லன ஧ட்டிப்஧ட்லடனி஬ழன௉ந்து கதர்வு 

பெய்தளல் அடிக்கு஫ழப்ன௃ உன௉யளகும். 

அடிக்கு஫ிப்஧ில் ஧க்கஎண்கல஭ மசர்க்க: 
 பென௉கும் ன௃ள்஭ிலன அடிக்கு஫ழப்஧ில் பகளண்டு பென்று கழ஭ிக் பெய்ன கயண்டும். 

 Insert → Fields → Page Number ஋ன்஫ கட்டல஭லன ஧னன்஧டுத்தழ஦ளல் ஋ல்஬ள 
஧க்கங்க஭ிலும் ஧க்க஋ண்கள் கெர்க்கப்஧டும். 

 
 
 
 
 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 34 

 

3. ஓ஧ன் ஆஃ஧ீஸ் லபட்ைரில் ஒரு தசால்ல஬ மதடி நற்த஫ாரு தசால்஬ாக நாற்றும் 

யமிகல஭ப் ஧ற்஫ி எழுது. 

ஏ஧ன் ஆஃ஧ஸீ் லபட்டரில் உள்஭ Find and Replace யெதழ, ஆயணத்தழல் உள்஭ என௉ 

பெளல்ல஬க் கண்டு஧ிடித்து அதல஦ கயப஫ளன௉ பெளல்஬ளக நளற்஫ழனிட உதவுகழ஫து.  

 யமிப௃ல஫: 
 Edit → Find & Replace அல்஬து Ctrl+F கழ஭ிக் பெய்தளல் Find & Replace உலபனளடல் 

ப஧ட்டி கதளன்றும். 

 Search for ப஧ட்டினில் கதடகயண்டின பெளல்ல஬னேம்,  

 Replace with ப஧ட்டினில் நள஫ழ யபகயண்டின பெளல்ல஬ தட்டச்சு பெய்ன கயண்டும். 
 Find ப஧ளத்தளல஦ கழ஭ிக் பெய்தவுடன், கதடல் பதளடங்கழ, அந்த யளர்த்லதலன 

கண்டு஧ிடித்து அதன் ன௅தல் இன௉ப்஧ிடத்தழல் நட்டும் உனர்த்தழக்களட்டப்஧டும். 

 உனர்த்தழக் களட்டப்஧ட்ட பெளல்ல஬ நட்டும் நளற்஫ழனிடுயதற்கு Replace 

ப஧ளத்தளல஦ கழ஭ிக் பெய்ன கயண்டும்.  

 Find All கழ஭ிக் பெய்தளல் ஆயணத்தழல் ஋ல்஬ள இடங்க஭ிலும் கதடப்஧ட்டு அந்த 
பெளல்஬ள஦து அல஦த்து இடத்தழலும் கதர்வு பெய்னப்஧ட்டு 

உனர்த்தழக்களட்டப்஧டும்.. 

 Replace All ப஧ளத்தளல஦ கழ஭ிக்பெய்தளல் உனர்த்தழக்களட்டப்஧ட்ட ஋ல்஬ள 
இடத்தழலும் நளற்஫ப்஧ட்டின௉க்கும். 

 Close  ப஧ளத்தளல஦ கழ஭ிக் பெய்ன கயண்டும். 

4. லபட்ைரில் ஧க்கயடிவூட்ைல் ஧ற்஫ி யிரியாக எழுதுக. 
 ஧க்கயடிவூட்டல் ஋ன்஧து ஧க்கத்தழன் ஏபம், ஧க்க஋ண், ஧க்கஅலநப்ன௃, தல஬ப்ன௃ 

நற்றும் அடிக்கு஫ழப்ன௃ க஧ளன்஫ ஧க்கத்தழன் ஧ண்ன௃கல஭ யடிவூட்டல் பெய்யதளகும்.  

 யடிவூட்டல் பெய்னப்஧ட்ட ஧க்கங்கள் ஧டிப்஧தற்கு ஋஭ிலநனளகவும் 

ஆர்யனெட்டுயதளகவும் அலநனேம். 

 Format → Page, ஋ன்஫ கட்டல஭லனத் கதர்வு பெய்தளல் Page Style உலபனளடல் ப஧ட்டி 

கதளன்றும். 

 அதழல், Page  பதளகுதழலனக் கழ஭ிக் பெய்னவும். 

 ஧க்க அ஭லய நாற்஫, Paper format குழுயில் A4, Legal க஧ளன்஫ யடிவூட்டல் 

கதர்வுக஭ி஬ழன௉ந்கதள அல்஬து width நற்றும் Height ஋ன்஫ யின௉ப்஧த்லத கதர்வு 
பெய்ன கயண்டும். 

 ஧க்க ஓபங்கல஭ நாற்஫, Margins ப஧ட்டினில் இடது, ய஬து, கநல் நற்றும் கவழ் 

ஏபங்கல௃க்கு உரின நதழப்ல஧ தட்டச்சு பெய்ன கயண்டும். 

 ஧க்கத்தின் அலநலய நாற்஫, Orientation குழுயில் ஥ீ஭யளக்கு அல்஬து 

஧க்கயளக்கு ப஧ளத்தளல஦ கதர்வு பெய்ன கயண்டும். 
 Page style உலபனளடல் ப஧ட்டினில் Background பதளகுதழனிலுள்஭ Color கவமழ஫ங்கு 

ப஧ட்டிலன கழ஭ிக் பெய்து, அதழல் கதலயனள஦ யண்ணத்லத கதர்வு பெய்து 

஧க்கத்தின் ஧ின்஦ணினில் யண்ணத்லத கெர்க்க஬ளம். 

 Page Style உலபனளடல் ப஧ட்டினிலுள்஭ Borders பதளகுதழலனத் கதர்வு பெய்து, 

஧ன஦ர் யலபனறுத்த ஧குதழனில் உள்஭ ஋ல்ல஬க஭ின் அ஭வு, எல்ல஬க் 
மகாடுக஭ின் ஧ாணி, எல்ல஬க஭ின் ஥ி஫ம் ஆகழனயற்ல஫ நளற்஫ழனலநக்க஬ளம். 

 Page Style உலபனளடல் ப஧ட்டினிலுள்஭ Header & Footer பதளகுதழலனத் கதர்வு 

பெய்து, ஆயணத்தழற்கு தல஬ப்பு நற்றும் அடிக்கு஫ிப்ல஧ உன௉யளக்க஬ளம். 
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஧ாைம் 7. ஓ஧ன் ஆஃ஧ீஸ் கால்க்-ல் மயல஬ தசய்தல் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. ன௅தல் அட்டயலண பென஬ழ ஋து? 
(அ) ஋க்பறல் (Excel)  (ஆ) க஬ளட்டஸ் 1-2-3 (Lotus 1-2-3) 
(இ) யிசிகால்க் (Visicalc)  (ஈ) ஏ஧ன் ஆஃ஧ஸீ் களல்க் (OpenOffice Calc) 

2. ஏ஧ன் ஆஃ஧ஸீ் களல்க்-ன் னெ஬ப்஧னன்஧ளடு ஋து? 
(அ) யிெழ களல்க் (Visicalc)   (ஆ) ஬ழப்கப களல்க் (LibreCalc) 
(இ) க஬ளட்டஸ் 1-2-3 (Lotus 123)  (ஈ) ஸ்ைார் ஆஃ஧ீஸ் கால்க் (StarOffice Calc) 

3. கட்டங்கல௃டன் கூடின ஥ழப஬ளக்கப்஧ட கணிப்஧ளன்: 
(அ) அட்ையலணச் தசன஬ி  (ஆ) தபவுத்த஭ம் 
(இ) பெளற்பென஬ழ    (ஈ) ஬ழ஦க்ஸ் 

4. களல்க்-ல் என௉ ப஥டுயரிலெனின் தல஬ப்ன௃ ஋ன்஧து: 
(அ) ஋ண்  (ஆ) கு஫ழனடீு  (இ) கததழ  (ஈ) எழுத்து 

5. அட்டயலணத்தள஭ிற்குள் நுண்ணல஫ சுட்டிலன ன௅ன்க஦ளக்கழ ஥கர்த்தும் 
ப஧ளத்தளன் ஋து? 
(அ) Enter  (ஆ) Tab   (இ) Shift + Tab  (ஈ) Delete 

6. என௉ யளய்஧ளடு இயற்றுள் ஋தழல் பதளடங்க஬ளம்? 
(அ) =   (ஆ) +   (இ) -    (ஈ) இலயனல஦த்தும் 

7. + A1^B2 ஋ன்஫ யளய்஧ளட்டுகள஦ பய஭ினடீ்டு நதழப்ன௃ ஋து? (A1=5, B2=2 ஋ன்க) 
(அ) 7   (ஆ) 25   (இ) 10   (ஈ) 52 

8. = H1<>H2 ஋ன்஫ கூற்றுக்கள஦ பய஭ினடீ்டு நதழப்ன௃ ஋ன்஦? (H1=12, H2=12 ஋ன்க) 
(அ) True  (ஆ) False   (இ) 24   (ஈ) 1212 

9. த஦ித்த நுண்ணல஫ப் ஧ளர்லயனிடலுக்கு ஧னன்஧டுத்தப்஧டும் கு஫ழனடீு ஋து? 
(அ) +   (ஆ) %   (இ) &    (ஈ) $ 

10. அட்டயலணத்தள஭ில் யடிகட்டல் ஋த்தல஦ யலகப்஧டும்? 
(அ) 3   (ஆ) 2   (இ) 4    (ஈ) 5 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஓ஧ன் ஆஃ஧ீஸ் கால்க்-ல் எத்தல஦ யலகனா஦ கருயிப்஧ட்லைகள் உள்஭து?  

 ஏ஧ன் ஆஃ஧ஸீ் களல்க்-ல் பகளடள ஥ழல஬னளக னென்று கன௉யிப்஧ட்லடகள் 
உள்஭஦. அலய: 

 பெந்தபக் கன௉யிப்஧ட்லட(Standard Tool bar) 
 யடிவூட்டல் கன௉யிப்஧ட்லட(Formatting Tool bar) 
 யளய்ப்஧ளட்டு ஧ட்லட(Formula bar) 

2. த௃ண்ணல஫ச் சுட்டி என்஫ால் என்஦?  
 அட்டயலணத்தளள் ன௅ழுயதும் ஥கர்த்தக்கூடின பெவ்யக யடியி஬ள஦ ப஧ட்டி 

க஧ளன்஫ அலநப்ன௃ நுண்ணல஫ச்சுட்டி ஋ன்று அலமக்கப்஧டுகழ஫து. 
3. ஓ஧ன் ஆஃ஧ீஸ் கால்க்-ன் உலப தசனற்கு஫ிலனப் ஧ற்஫ி கு஫ிப்பு யலபக. 

 ஏ஧ன் ஆஃ஧ஸீ் களல்க்-ல், & ஋ன்஫ கு஫ழனடீு உலப பெனற்கு஫ழனளகும்.  
 இபண்டு அல்஬து அதற்கு கநற்஧ட்ட உலபகல஭ என்஫ளக கெர்க்க இந்த 

பெனற்கு஫ழ ஧னன்஧டுகழ஫து. இபண்டு உலபகல஭ என்஫ளக கெர்த்தல் ‚உலப 
இலணத்தல்‛ (Text Concatenation) ஋஦ப்஧டும். 

4. கால்க்-ல் ஒரு யாய்ப்஧ாட்லை உருயாக்குயதற்கா஦ த஧ாது கட்ைல஭ 
அலநப்ல஧ எழுதுக.  
கட்ைல஭ அலநப்பு: 

= த௃ண்ணல஫ ப௃கயரி 1 <தசனற்கு஫ி> த௃ண்ணல஫ ப௃கயரி 2 
 களல்க்”ல் உள்஭ிடப்஧டும் யளய்ப்஧ளடுகள், = அல்஬து + அல்஬து - கு஫ழனேடன் 

பதளடங்கழ நதழப்ன௃கள், பெனற்கு஫ழகள் நற்றும் நுண்ணல஫ ன௅கயரிகல௃லடன 
பதளகுப்஧ளக அலநனேம்.  

5. ஥கத஬டுத்தல், தயட்டுதல் நற்றும் ஒட்டுயதற்கா஦ குறுக்குயமி சாயி 
மசர்நா஦ங்கள் னாலய? 

1. ஥கப஬டுத்தல்   - Ctrl + C  
2. பயட்டுதல்    - Ctrl+X  
3. எட்டுதல்   - Ctrl + V  

6. ஒரு த௃ண்ணல஫னிலுள்஭ தபவுகல஭ ஧திப்஧ாய்வு தசய்ன ப௃டிப௅நா? ஆம் 
எ஦ில் எவ்யாறு?  
 என௉ நுண்ணல஫னிலுள்஭ தபவுகல஭ ஧தழப்஧ளய்வு பெய்ன ன௅டினேம்.  
 தபவு நளற்஫ப்஧ட கயண்டின நுண்ணல஫லன கதர்வு பெய்து ன௃துத்தபலய 

தட்டச்சு பெய்தளல் ன௃துத்தபவுகள் ஧லமன தபயின் நீது ஋ழுதப்஧டும். 
7. “Insert Cells” உலபனாைல் த஧ட்டினிலுள்஭ மதர்வுகள் னாலய? 

‚Insert Cells‛ உலபனளடல் ப஧ட்டினில் ஥ளன்கு யின௉ப்஧த் கதர்வுகள் உள்஭஦. அலய: 
(1) Shift cells down  (2) Shift cells right  (3) Entire row  (4) Entire Column 

8. த஧ாருத்துக. 
 பயட்டுதல்,஥கப஬டுத்தல் 
நற்றும் எட்டுதல் 

த஦ித்த நுண்ணல஫          ” (4) 

 நுண்ணல஫சுட்டி  ஥ழல஬லநப்஧ட்லட           ” (3) 
 க஥ர்ந்பதடுப்ன௃ ஥ழல஬ பெந்தபக் கன௉யிப்஧ட்லட      - (1) 
 $A$5 இனங்கு க஬ம்               ” (2) 
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9. யலபனறுக்க: அட்ையலண தசன஬ினில் யரிலச நற்றும் த஥டுயரிலச. 
 அட்டயலணத்தளள், என௉ கு஫ழப்஧ிட்ட ஋ண்ணிக்லகனி஬ள஦ யரிலெகல஭னேம், 

ப஥டுயரிலெகல஭னேம் பகளண்டின௉க்கும்.  
 எவ்பயளன௉ ப஥டுயரிலெனேம், A, B, C, D …….. AA, AB, AC …… ஋ன்஫ யரிலெனில் 

ப஧னரிடப்஧ட்டின௉க்கும். யரிலெகள் எவ்பயளன்றுக்கும் 1, 2, 3 ……. ஋஦ 
஋ண்ணிடப்஧ட்டின௉க்கும். 

10. ஥கத஬டுத்து ஒட்டுதல் நற்றும் தயட்டி ஒட்டுதல் மயறு஧டுத்துக. 
஥கத஬டுத்து ஒட்டுதல் தயட்டி ஒட்டுதல் 

நுண்ணல஫னின் உள்஭டக்கத்லத ஥கல் 
஋டுக்க ஧னன்஧டுகழ஫து. 

நுண்ணல஫னின் உள்஭டக்கத்லத 
஥கர்த்த ஧னன்஧டுகழ஫து. 

நுண்ணல஫னின் உள்஭டக்கம், னெ஬ 
நுண்ணல஫னிலும், இ஬க்கு 
நுண்ணல஫னிலும் இன௉க்கும்.  

நுண்ணல஫னின் உள்஭டக்கம், னெ஬ 
நுண்ணல஫னில் இன௉ந்து ஥ீக்கப்஧ட்டு, 
இ஬க்கு நுண்ணல஫னில் லயக்கப்஧டும். 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஓ஧ன் ஆஃ஧ீஸ் கால்க் – கு஫ிப்பு யலபக.  

 ஏ஧ன் ஆஃ஧ஸீ் களல்க் (Calc) ஋ன்஧து ஏ஧ன் ஆஃ஧ஸீ் (Open Office) பதளகுப்஧ில் 
உள்஭ அட்டயலணபென஬ழனளகும். 

 ஏ஧ன் ஆஃ஧ஸீ் களல்க் என௉ ஧ிப஧஬நள஦ தழ஫ந்த னெ஬ (Open Source) 
அட்டயலணச்பென஬ழ ஆகும்.  

 இதல஦ தற்க஧ளது அ஧ளச்ெழ (Apache) ஥ழறுய஦ம் ஧பளநரித்து யன௉கழ஫து.  
2. கால்க்-ல் த஥டுயரிலச நற்றும் த௃ண்ணல஫கல஭ மசர்த்தல் ஧ற்஫ி எழுதுக. 

த஥டுயரிலசலன மசர்த்தல்:  
 ன௃தழன ப஥டுயரிலெ கெர்க்கப்஧ட கயண்டின ப஥டுயரிலெனில் கழ஭ிக் பெய்து, 

அதல஦ கதர்ந்பதடுத்து, சுட்டினில் ய஬து கழ஭ிக் பெய்தளல் கதளன்றும் 
கநல்நீட்ன௃ ப஧ட்டினி஬ழன௉ந்து, ‚Insert Columns‛ ஋ன்஫ கட்டல஭லன கதர்வு பெய்ன 
கயண்டும் 

 இப்ப஧ளழுது, என௉ ன௃தழன ப஥டுயரிலெ ஥டப்ன௃ ப஥டுயரிலெக்கு இடது ஧க்கத்தழல் 
கெர்க்கப்஧ட்டின௉க்கும்.  

த௃ண்ணல஫கல஭ மசர்த்தல்: 
 ஌ற்க஦கய உள்஭ நுண்ணல஫கல௃க்கு இலடகன என௉ ன௃தழன நுண்ணல஫லன 

கெர்க்க, நுண்ணல஫னின் கநல் ய஬து கழ஭ிக் பெய்து கதளன்றும் கநல்நீட்ன௃ 
ப஧ட்டினி஬ழன௉ந்து ‚Insert‛ கட்டல஭லன கழ஭ிக் பெய்ன கயண்டும்.  

 இப்க஧ளது ‚Insert Cells‛ உலபனளடல் ப஧ட்டி, ஥ளன்கு யின௉ப்஧த் கதர்வுகல௃டன் 
கதளன்றும்.  

 அதழ஬ழன௉ந்து ஌கதனும் என்ல஫ கதர்ந்பதடுத்து கதலயனள஦ நுண்ணல஫கல஭ச் 
கெர்க்க஬ளம்.  

3. Backspace நற்றும் Delete த஧ாத்தான்கல஭ ஧னன்஧டுத்தி தபவுகல஭ அமித்தல஬ 
மயறு஧டுத்துக.  

Backspace த஧ாத்தான் Delete த஧ாத்தான் 
Backspace ப஧ளத்தளன் களட்டிக்கு 
இடப்ன௃஫ம் உள்஭ ஋ழுத்துக்கல஭ 
அமழக்கும். 

Delete ப஧ளத்தளன் களட்டிக்கு ய஬ப்ன௃஫ம் 
இன௉க்கும் ஋ழுத்துக்கல஭ அமழக்கும். 
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4. ஏமதனும் ப௄ன்று யடிவூட்ைல் மதர்வுகல஭ எழுதுக.  
 எழுத்துரு யலக  - ஋ழுத்துன௉ யலகலன நளற்஫ப்஧னன்஧டுகழ஫து. 
 எழுத்துரு அ஭வு - ஋ழுத்துன௉க்க஭ின் அ஭லய நளற்றுயதற்கு  

  ஧னன்஧டுகழ஫து. 
 தடிந஦ாக்குதல்  - தபலய தடிந஦ளக்குயதற்கு ஧னன்஧டுகழ஫து. 

5. த௃ண்ணல஫ A1, A2 நற்றும் A3 னில் ப௃ல஫மன 34, 65 நற்றும் 89 ஆகின உள்஭து. 
அதன் சபாசரிலன காணும் யாய்஧ாட்லை எழுதுக.  
 =Average(A1: A3)  
 = (A1 + A2 + A3) / 3 

5 நதிப்த஧ண் யி஦ாக்கள்: 
1. கால்க்-ல் த஥டுயரிலசனின் அக஬த்லத எவ்யாறு நாற்஫஬ாம் என்஧லத 

யி஭க்குக. 
யமிப௃ல஫ 1.: 
 ஋ந்த ப஥டுயரிலெனின் அக஬த்லத நளற்஫ யின௉ம்ன௃கழன்க஫ளகநள அந்த 

ப஥டுயரிலெலன கதர்வு பெய்து, format → column → width ஋ன்஫ கட்டல஭ 
அல்஬து சுட்டிலன லயத்து ய஬து கழ஭ிக் பெய்ன கயண்டும். 

 கதளன்றும் column width உலபனளடல் ப஧ட்டினில் கதலயனள஦ அ஭லயக் 
பகளடுத்து OK ப஧ளத்தளல஦ கழ஭ிக் பெய்ன கயண்டும். 

யமிப௃ல஫ 2.: 
 ஋ந்த ப஥டுயரிலெனின் அக஬த்லத நளற்஫ யின௉ம்ன௃கழன்க஫ளகநள அந்த 

ப஥டுயரிலெலன, அடுத்த ப஥டுயரிலெனி஬ழன௉ந்து ஧ிரிக்கும் ககளட்டிற்கு 
சுட்டிலன ஋டுத்துச் பெல்஬வும். 

 சுட்டினின் சுட்டி இன௉தல஬ அம்ன௃க்கு஫ழனளக நளறும். 
 அந்த ஥ழல஬னில் கழ஭ிக் பெய்து சுட்டிலன இடப்ன௃஫ம் அல்஬து ய஬ப்ன௃஫ம் 

இழுத்து அக஬த்லத குல஫க்ககயள அல்஬து கூட்டகயள பெய்ன஬ளம். 
2. 5, 10, 20 ….. 2560 என்஫ எண் யரிலசலன உருயாக்கும் யமிப௃ல஫லன 

யி஭க்குக. 
அட்டயலணனில் கயண்டின அ஭வு நுண்ணல஫கல஭ கதர்வு பெய்து பகளள்஭ 
கயண்டும். 
எ.கா: A1 ன௅தல் A20 யலபனி஬ள஦ நுண்ணல஫ப் ஧பப்ல஧ கதர்வு பெய்ன஬ளம். 
 Edit → Fill → Series கட்டல஭லன கதர்வு பெய்தளல், Fill Series உலபனளடல் 

ப஧ட்டி கதளன்றும். அதழல், 
 Direction ஋ன்஧தழல் Down ஋ன்஧லதனேம், 
 Series type ஋ன்஧தழல் Growth ஋ன்஧லதனேம், 
 Start value ஋ன்஧தழல் 5 ஋ன்றும், 
 End value ஋ன்஧தழல் 2560 ஋ன்றும் 
 Increment ஋ன்஧தழல் 2 ஋஦வும் உள்஭ிட்டு Ok ப஧ளத்தளல஦ கழ஭ிக் பெய்ன 

கயண்டும். 
இப்ப஧ளழுது கதலயனள஦ ஋ண்யரிலெ உன௉யளக்கப்஧ட்டின௉க்கும். 
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஧ாைம் 8. ஥ிகழ்த்துதல் (Basics) 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. என௉ ெழல்லுயி஬ழன௉ந்து கயப஫ளன௉ ெழல்லுயிற்கு யிலபயளக ஥கர்த்துயதற்கு இதழல் 
஋து ஧னன்஧டுத்தப்஧டுகழ஫து? 
அ) தழலெகளட்டி  ஆ) ம஥யிமகட்ைர்  இ) Fill Color   ஈ) Page Border 

2. ஸ்ல஬டு கரளலயக் களணும் குறுக்கு யமழ யிலெ ஋து? 
அ) F6   ஆ) F9   இ) F5    ஈ) F10 

3. கதளற்஫த்தழல் கதளற்஫ந஭ிக்கும் அல஦த்து ஸ்ல஬டுக஭ின் ெழறு ஧தழப்ன௃கள் 
கழலடநட்ட யரிலெனில் அலநக்கப்஧ட்டின௉க்கும். 
அ) Notes   ஆ) Outline   இ) Handout   ஈ) Slide Sorter 

4. Impress-ல் பகளடள஥ழல஬ ஧ளர்லய அலடனள஭ம் களணவும்? 
அ) Normal   ஆ) Outline   இ) Handout   ஈ) Slide Sorter 

5. ஋ந்த ஧ட்டின஬ழல் ஸ்ல஬டு நளற்஫ யின௉ப்஧த்லதக் பகளண்டுள்஭து? 
அ) Slide Show   ஆ) View   இ) Tools   ஈ) Format 

6. Impress-ல் யி஭க்கக் களட்ெழனின் ஥ீட்டிப்ல஧ (extension) அலடனள஭ம் களணவும்? 
அ) .odp   ஆ) .ppt   இ) .odb   ஈ) .ood 

7. யி஭க்கக் களட்ெழக் கன௉யிக஭ில், என௉ ஸ்ல஬ட்டின் நுலமவு யில஭வு நற்ப஫ளன௉ 
ஸ்ல஬லட ஸ்ல஬டு கரளயில் நளற்றுகழ஫து.  
அ) Animation   ஆ) Slide Transition இ)Custom Animation  ஈ) Rehearse Timing 

8. யன்஦ினள "உ஬க பயப்஧ நனம்" ஋ன்஫ என௉ யி஭க்கக் களட்ெழலன பெய்துள்஭ளர். 
அயர் யகுப்஧ில் தல஬ப்ன௃ க஧சும்க஧ளது தள஦ளககய த஦து ஸ்ல஬டுகரள 
ன௅ன்க஦ற்஫ம் கயண்டும். இம்ப்பறழன் ஋ந்த அம்ெம் அயள் ஧னன்஧டுத்த 
கயண்டும்? 
அ) Custom Animation  ஆ) Rehearse Timing இ) Slide Transition  ஈ) Either (a)or (b) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 40 

 

2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஒரு சில்லு நற்றும் Slide Show-க்கு உள்஭ யித்தினாசம் என்஦? 

சில்லு Slide Show 

ெழல்லு ஋ன்஧து ஥ழகழ்த்துதலுக்கள஦ உலப, 
஧டங்கள், எ஭ிக்களட்ெழகள், அலெவு 
஧டங்கள், எ஬ழ, யலப஧டங்கள், 
அட்டயலணகள் க஧ளன்஫ கூறுகல஭க் 
பகளண்டதளகும். 

ெழல்லுக்களட்ெழ (Slide Show) ஋ன்஧து என௉ 
கு஫ழப்஧ிட்ட ப஧ளன௉ள் ஧ற்஫ழன பெய்தழகல஭ 
யலப஧ட ெழல்லுக஭ளககயள, ஆயண 
஧க்கங்க஭ளககயள பகளடுக்கும் என௉ 
களட்ெழனளகும். 

 

2. எத்தல஦ உள்஭லநந்த சில்லு த஭யலநப்புகள் Impress-ல் 
அைங்கிப௅ள்஭஦.? 
 12 யலகனள஦ உள்஭லநந்த ெழல்லு த஭யலநப்ன௃கள் Impress-ல் 

அடங்கழனேள்஭஦. 
 

3. ஥ிகழ்த்துதல஬ என்஦தயன்று புரிந்து தகாண்டீர்கள்? 
 ஥ழகழ்த்துதல் ஋ன்஧து என௉ கணிப்ப஧ள஫ழ ஧னன்஧ளட்டு பநன்ப஧ளன௉ள் ஆகும். 

இது தகயல்கல஭ ெழல்லுக் களட்ெழக஭ளக யமங்க ஧னன்஧டுகழ஫து. 
 

4. Impress-னில் யார்ப்புரு – யலபனறு.  
 யளர்ப்ன௃ன௉ ஋ன்஧து  ன௃தழன  ஥ழகழ்த்துதல஬  உன௉யளக்க ன௅ன்஦கப 

யடியலநக்கப்஧ட்ட ஥ழகழ்த்துதல் யடியலநப்஧ளகும்.  
 

5. சில்லுயின் அலநப்஧ால் என்஦ புரிந்து தகாள்கி஫ரீ்கள்? 
 ன௅தன்லந ென்஦஬ழல் உள்஭ ஧ணி ஧஬கத்தழன் என௉ ஧குதழகன ெழல்லு 

அலநப்ன௃ ஆகும். இதழல் ஧஬ பதளகுக்கப்஧ட்ட ெழல்லு அலநப்ன௃கள் உள்஭஦. 
 அதழல் என்ல஫ கதர்வு பெய்து ஧னன்஧டுத்தழ , நளற்஫ம் பெய்து த஦ித் 

கதலயகல௃க்கு ஧னன்஧டுத்தழக் பகளள்஭஬ளம். 
 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. Impress-ல் ஧ன஦ர்கல஭ ஈர்க்கும் யலகனில் எத்தல஦ யலகனா஦ 

காட்சிகள் யமங்கப்஧டுகின்஫஦? 
Impress-ல் 5 யலகனா஦ காட்சிகள் யமங்கப்஧டுகின்஫஦. 

(1) Normal View: த஦ித்த஦ி ெழல்லுலய உன௉யளக்கவும் ஧தழப்஧ிக்கவும் 
உதவுகழ஫து.  

(2) Outline View: ெழல்லுயின் ப஧னர் நற்றும் தல஬ப்ன௃கல஭ கதலயக்ககற்஧  
஧தழப்஧ித்து பகளள்஭ உதவுகழ஫து. 

(3) Notes View: ெழல்லுக஭ின் கு஫ழப்ன௃கல஭ கெர்க்கவும் ஌ற்க஦கய உள்஭ 
கு஫ழப்ன௃கல஭ ஧ளர்க்கவும் ஧னன்஧டுகழ஫து.  

(4) Slide Sorter View: இது ஋ல்஬ள ெழல்லுகல஭னேம் ெழ஫ழன யடியத்தழல் ஧ளர்க்க 
உதவுகழ஫து. ெழல்லு களட்ெழனின் க஥பத்லத கு஫ழப்஧ிடவும் இபண்டு 
ெழல்லுகல௃க்கழலடகனனள஦ ஧ரிநளற்஫த்லத கெர்க்கவும் ஧னன்஧டுகழ஫து. 

(5) Handout View: ெழல்லுயின் அ஭லய நளற்஫ழ ஧஬ ெழல்லுகள் எகப 
஧க்கத்தழல் யன௉நளறும் ெழல்லுகல஭ அச்ெழட்டு லகப்஧ிடி அ஫ழக்லகக஭ளக 
யமங்க உதவுகழ஫து. 
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2. ஥ிகழ்த்தல் தநன்த஧ாருல஭ னார் ஧னன்஧டுத்துகி஫ார்கள், ஏன்? 
 யிற்஧ல஦ ஧ிபதி஥ிதிகள்: யளடிக்லகனள஭ர்கல௃க்கு தளங்கள் யிற்கும் 

ப஧ளன௉ள் ஧ற்஫ழன ஥ழகழ்த்தல஬க் பகளடுக்க ஧னன்஧டுத்துகழன்஫஦ர். 
 ஥ிறுய஦ங்கள்: ஧னிற்ெழ தன௉யதற்கள஦ என௉ கன௉யினளக 

஧னன்஧டுத்துகழன்஫஦ர். 
 ஆசிரினர்கள்: கற்஧ித்தல் கன௉யினளக ஧னன்஧டுத்துகழன்஫஦ர். 
 நாணயர்கள்: தங்கல௃லடன ஧ளடத்தல஬ப்ன௃கள் ஧ற்஫ழன ஥ழகழ்த்துதல஬ 

உன௉யளக்க ஧னன்஧டுத்துகழன்஫஦ர். 
 ம஧ச்சா஭ர்கள்: தளங்கள் க஧சும் ப஧ளன௉ள் ஧ற்஫ழன ன௅க்கழன கன௉த்துக்கல஭ 

ப஧ரின தழலபனில் களட்ட ஧னன்஧டுத்துகழன்஫஦ர். 
 

3. Slide Sorter காட்சி நற்றும் அதன் ப௃க்கினத்துயத்லத யலபனறுக்கவும். 
 Slide Sorter களட்ெழ ஋ல்஬ள ெழல்லுலயனேம் குறும்஧டம் யடியத்தழல் ஧ளர்க்க 

உதவும் ஧ளர்லயனளகும். 
 ெழல்லுக்களட்ெழனின் க஥பத்லத கு஫ழப்஧ிடவும், இபண்டு 

ெழல்லுகல௃க்கழலடகனனள஦ ஧ரிநளற்஫த்லத கெர்க்கவும் ஧னன்஧டுகழ஫து. 
 கநலும் இலத ஧னன்஧டுத்தழ ஋ல்஬ள கயல஬லனனேம் ெழல்லுயின் 

பதளகுப்஧ிக஬ள அல்஬து த஦ி ெழல்லுயிக஬ள பெய்ன஬ளம். 
 என௉ யரிலெனில் கதளன்றும் ெழல்லுயின் ஋ண்ணிக்லகனில் நளற்஫ம் 

பெய்ன஬ளம். 
4. Normal View என்஫ால் என்஦? யி஭க்குக. 

 Normal View ஋ன்஧து த஦ித்த஦ி ெழல்லுலய உன௉யளக்கவும் ஧தழப்஧ிக்கவும் 
உதவுகழ஫து.  

 ெழல்லுலய யடியலநக்க, கெர்க்க யலபகல஬ ஧டம் நற்றும் அலெவு 
஧டங்கல஭ கெர்க்க ஧னன்஧டுகழ஫து. 

 Normal View யில் ெழல்லுலய யடியலநக்கும் ஧குதழனில் ெழல்லுலய 
கெர்க்கும் யெதழ உள்஭து.  

 உ஭யி ஧ட்டிலன ஧னன்஧டுத்தழகனள அல்஬து யமழகளட்டி ஧ட்டிலன 
஧னன்஧டுத்தழகனள கழ஭ிக் பெய்து பகளண்டு யன௉ம் யெதழ உள்஭து. 
 

5. Impress-ல் சில்லு நாற்று (transistion effect) யில஭வுகள் எவ்யாறு 
஥ிகழ்த்துதல஬ தி஫ம்஧ை உருயாக்க உதவுகி஫து? 
 ெழல்லுக்களட்ெழனில் என௉ ெழல்லுலய களண்஧ிக்கும் க஧ளது கதளன்றும் ெழ஫ப்ன௃ 

யில஭வுகல஭ ெழல்லு நளற்று யில஭வுகள் ஋ன்கழக஫ளம். 
 ஥டப்ன௃ ெழல்லு நல஫யதற்கு ஧ின்ன௃ம் அடுத்த ெழல்லு கதளன்றுயதற்கு 

ன௅ன்ன௃ம் நளற்று யில஭வு கதளன்றும். 
 ெழல்லுகல௃க்கழலடகனனள஦ நளற்று யில஭வுகள் ஧ளர்லயனள஭ர்க஭ின் 

கய஦த்லத ஈர்ப்஧தற்கள஦ என௉ ன௅னற்ெழ ஆகும். 
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஧ாைம் 9. இலணன த஭ம் நற்றும் நின்஦ஞ்சல் - ஓர் அ஫ிப௃கம் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. WLAN - ஋ன்஧தன் யிரியளக்கம். 
a) Wireless Local Area Network  b) Wired local Area Network 
c) Wireless Local Area Netware  d) Wireless Area Netbande 

2. ய஭ளக யல஬னலநப்஧ிற்கள஦ யபம்ன௃. 
a) 10 கழ.நீ  b) 5 கி.நீ c) 25 கழ.நீ  d) 20 கழ.நீ 

3. யல஬னில் உள்஭ எவ்பயளன௉ கணிப்ப஧ள஫ழனேம் ______________ கன௉தப்஧டுயது. 
a) புபய஬ர் (host)   b) கெலய னகம் (server)  
c) ஧ணி஥ழல஬னம் (workstation) d) ன௅ல஦ னம் 

4. இலணனம்______________ ஆல் ஥ழர்யகழக்கப்஧டுகழ஫து? 
a) ICANM  b) ICANN c) ICMA  d) ICNNA 

5. W3C ஋ன்஧தன் யிரியளக்கம் 
a) World Wide Web Consortium  b) Wide World Web Consortium 
c) World Web Wide Consortium  d) World Wide Web Consortum 

6. W3C 1994 ஆம் ஆண்டில் ______________ ஋ன்஧யபளல் கதளற்றுயிக்கப்஧ட்டது. 
a) டிம் – த஧ர்஦ர்ஸ் லீ b) டிம் ”஧ர்஦ளர்டு லீ 
c) கழம் ” ப஧ர்஦ர்ஸ்  d) கழம் ” ஧ர்஦ளர்டு 

7. ஧ின்யன௉ய஦யற்றுள் ஧கபல஬ (hotspot) ஋ந்த யல஬னலநப்ல஧ப் 
஧னன்஧டுத்துகழ஫து? 
a) LAN  b) PAN  c) WLAN   d) CAN 

8. னே஋ஸ்஧ி, லயஃல஧ அடளப்டர்ஸ் ஋வ்யளறு அலமக்கப்஧டும்? 
a) Data Card  b) Pen Drive c) Dongles   d) Memory Card 

9. இலணனத்தழல் தகயல஬ கதடுதல் ஋வ்யளறு அலமக்கப்஧டுகழ஫து? 
a) உ஬ளவுதல் (Surfing) b) மதடுதல் (Searching) 
c) கண்ட஫ழதல் (Finding) d) கண்கணளட்டநழடல் (glancing) 

10. Safari - யல஬ உ஬ளயினள஦து னளபளல் உன௉யளக்கப்஧ட்டது? 
a) கூகுள் (Google)   b) ஆப்஧ிள் (Apple) 
c) லநக்கபளெளப்ட் (Microsoft)  d) ஬ழ஦க்ஸ் களர்ப்஧கபென் (Linux Corpn) 

11. ஋த்தல஦ யலகனள஦ யல஬த்த஭ங்கள் உள்஭஦? 
a) 3   b) 2  c) 4   d) 6 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. இலணனத்தில் உள்஭ இபண்டு ப௃க்கினநா஦ த஥஫ிப௃ல஫க஭ின் த஧னலப கூறு. 

 TCP - Transmission Control Protocol  
 IP - Internet Protocol 

2. யல஬னலநப்பு என்஫ால் என்஦? 
 யல஬னலநப்ன௃ ஋ன்஧து கணிப்ப஧ள஫ழ ெளர்ந்த ய஭ங்கல஭ ஧கழர்ந்து பகளள்ல௃ம் 

க஥ளக்கத்தழற்களக என்க஫ளபடளன்று இலணக்கப்஧ட்ட ெளத஦ங்க஭ின் பதளகுப்஧ளகும். 
3. ICANN - அலநப்஧ின் ஧ணி னாது? 

 ஍களன் (Internet Corporation For Assigned Names and Numers) ஋ன்஫ அலநப்ன௃ 
இலணனத஭ ன௅கயரி ஧தழலய ஥ழர்யகழக்கழன்஫து.  

 ஌ற்க஦கய ஧தழவு பெய்னப்஧ட்ட ப஧னர் நீண்டும் ஧தழவு பெய்னப்஧டளநல் 
இன௉க்க உதவுகழ஫து. 

4. மதடுத஧ா஫ி என்஫ால் என்஦? 
 கதடுப஧ள஫ழகள் ஋ன்஧து கதலயனள஦ தகயல஬ உ஬க஭ளயின யல஬னில் 

இன௉ந்து (www) கதடி தன௉யதற்களக யடியலநக்கப்஧ட்டுள்஭ பநன்ப஧ளன௉஭ளகும்.  
 Google நற்றும் Yahoo ஆகழனலய நழகவும் ன௃கழ்ப஧ற்஫ கதடு ப஧ள஫ழக஭ளகும். 

5. யல஬ உ஬ாயி என்஫ால் என்஦? 
 யல஬ உ஬யி ஋ன்஧து கணிப்ப஧ள஫ழனில் யல஬த஭த்லதகனள, யல஬ 

஧க்கத்லதகனள அணுக ஧னன்஧டும் பநன்ப஧ளன௉ள் ஆகும்.  
 Internet Explorer, Google Chrome, Mozila Firefox நற்றும் Safari, ஆகழனலய ன௃கழ்ப஧ற்஫ 

யல஬ உ஬யிகள் ஆகும்.  
6. URL - ப௃கயரினில் உள்஭ கூறுகள் னாலய?  

     
7. யல஬த்த஭ம் என்஫ால் என்஦? 

 யல஬த஭ம் ஋ன்஧து யல஬ப்஧க்கங்க஭ின் பதளகுப்஧ளகும்.  
 இலணனத஭நள஦து, ன௅தல் ஧க்கம், ஥ழறுய஦த்லத ஧ற்஫ழன தகயல்கள் (About 

us), பதளடர்ன௃ பகளள்஭ (Contacts), ெளன்றுகள் (Testimonials), ப஧ளன௉ள்கள் (Products), 
கெலயகள் (Services), FAQ’s நற்றும் ஧஬ யல஬ப்஧க்கங்கல஭ பகளண்டின௉க்கும் 
இவ்யள஫ள஦ ஧க்கங்கள் இலணந்தது யல஬த்த஭ம் ஋஦ப்஧டும். 

8. நின்஦ஞ்ச஬ில் உள்஭ CC நற்றும் BCC என்஫ால் என்஦? 
 CC (Carbon Copy) ன௃஬நள஦து க஥படி அணுகல் இல்஬ளத ப஧று஥ர்கல஭ 

கு஫ழப்஧ிடஉதவுகழன்஫ என௉ யின௉ப்஧த் கதர்வு ஆகும்.  
 BCC (Blind Carbon Copy) இதுவும் CC ” க஧ளன்஫கத ஆகும். இதழல் ப஧று஥ர்கள் 

஧ட்டினல் இபகெழனநளக லயக்கப்஧டும். ஋஦கய இப்ன௃஬த்தழல் கு஫ழப்஧ிடப்஧ட்டு 
நழன்஦ஞ்ெல் ப஧று஧யர், கயறு னளன௉க்பகல்஬ளம் இந்த நழன்஦ஞ்ெல் 
அனுப்஧ப்஧ட்டுள்஭து ஋ன்஧லத களணன௅டினளது. 
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9. ஥ில஬னா஦ யல஬ப்஧க்கம் என்஫ால் என்஦? 
 ஥ளம் ஧ளர்லயனிடும் க஧ளபதல்஬ளம் யல஬த்த஭நள஦து அகத ஥ழல஬னிக஬கன 

பதளடர்ந்து இன௉க்கும். இவ்யலக யல஬த்த஭ங்கள் ஥ழல஬னள஦ 
யல஬த்த஭ங்கள் ஋஦ப்஧டும்.  

 என௉ ெழ஫ழன யணிக ஥ழறுய஦த்தழன் யல஬த்த஭ம் நற்றும் ஧ள்஭ினினுலடன 
யல஬த்த஭ம் க஧ளன்஫லய ஥ழல஬னள஦ யல஬த்த஭ங்கல௃க்கு 
஋டுத்துக்களட்டடளகும். 

10. நா஫க்கூடின யல஬ப்஧க்கம் என்஫ால் என்஦? 
 ப஧ளதுத் கதர்வு ன௅டிவுகள், நுலமவுத் கதர்வு ன௅டிவுகள் க஧ளன்஫யற்ல஫ 

பய஭ினிடும் யல஬த்த஭நள஦து ஧ன஦ர் உள்஭ிடும் ஧தழபயண்ணிற்கு ஌ற்஧ 
யல஬ப்஧க்கம் நளறும். இது க஧ளன்஫ யல஬த்த஭ங்கள் நள஫க்கூடின 
யல஬ப்஧க்கம் ஋஦ப்஧டும்.  

 (஋.கள) அபெழனுலடன யல஬த்த஭ம், நுலமவுத் கதர்வு ன௅டிவுகல஭ 
பய஭ினிடும் யல஬த்த஭ம். 

11. நின் – அபசாண்லநனின் ஥ன்லநகள் னாலய? 
 ஊமல஬க் குல஫த்தது 
 அதழக பய஭ிப்஧லடத்தன்லந 
 யெதழகள் அதழகரிப்ன௃  
 எட்டு பநளத்த பெ஬யில் குல஫ப்ன௃. 
 அபெளங்கத்லத அணுகும் ன௅ல஫கள் யிரியளக்கம் 

12. ஃ஧ிரிங்(Phishing) என்஫ால் என்஦? 
 த஦ினளர் ஧ற்஫ழன தகயல்கல஭ ப஧஫ லெ஧ர் குற்஫யள஭ிக஭ின் கநளெடி 

ன௅னற்ெழகள் ஆகும்.  
 இலய நழன்஦ஞ்ெல் க஧ளன்று யடியலநக்கப்஧ட்டின௉க்கும். 
 கநலும் ெட்டப்ன௄ர்யநள஦ இடத்தழல் இன௉ந்து யந்தது க஧ளல் ன௅கப்஧ில் 

கதளற்஫ந஭ிக்கும். 
 
3 நதிப்த஧ண் யி஦ாக்கள்: 

1. TCP/IP என்஫ால் என்஦? 
 உ஬க஭ளயின யல஬ அலநப்஧ள஦ இலணனம் TCP/IP (Transmission Control 

Protocol/Internet Protocol) ப஥஫ழன௅ல஫லன ஧னன்஧டுத்தழ ஧ல்கயறு ஊடகங்கள் 
யமழனளக தபவு ஧ரிநளற்஫த்லத பெய்கழ஫து.  

TCP/IP க்கு கதலயனள஦ இபண்டு அம்ெங்கள்: 
 பெய்தழலன ஧ரிநளற்஫ம் பெய்யதற்கள஦ யெதழ. 
 ஥ம்஧கத் தகுந்தன௅ல஫னில் ஧ரிநளற்஫ம் பெய்னேம் யமழ யலக. 

2. ஧கபல஬ (hotspot) இலணன மசலய ஧ற்஫ி சிறுகு஫ிப்பு யலபக. 
 கம்஧ினில்஬ள குறும்஧பப்ன௃ யல஬னலநப்ல஧ க஧ளன்று இலணன யெதழலன 

அணுக லளட்ஸ்஧ளட்ஸ் (Hotspots) ஧னன்஧டுகழன்஫து.  
 நழன்஦ணு ெளத஦ங்கள் இலணனத்துடன் பதளடர்ன௃ பகளள்஭ அல்஬து 

தகயல்கல஭ ஧ரிநள஫ழக் பகளள்஭ கபடிகனள அல஬கல஭ (Radio waves) 
஧னன்஧டுத்துகழ஫து. 

 Hotspots ெளத஦நள஦து பவுட்டர் (ROUTER) க஧ளல் பெனல்஧ட்டு இலணன கெலய 
யமங்கு஧யன௉டன் இலணப்ல஧ ஌ற்஧டுத்துகழ஫து.  
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3. மைட்ைாகார்டு (Data card) நற்றும் ைாங்கில்ஸ் (Dongles) மயறு஧டுத்துக. 
Dongle Data Card 

கூடுதல் ஧ளதுகளப்ல஧ யமங்கும் 
஥ீக்கக் கூடின (removable) கூறுகல஭ 
கு஫ழக்கழ஫து.  

இது தபவுகல஭ கெநழத்து லயக்க 
஧னன்஧டும் ஥ீக்கக்கூடின நழன்஦ணு 
அட்லட ஆகும்.  

ப௅.எஸ்.஧ி ைாங்கி஭ின் யலககள் 
 WIFI டளங்கழள் 
 BLUETOOTH  
 MEMORY டளங்கழள் 

DATACARD ன் யலககள் 
1. Expansion Card 
2. Memory Card or Fla  

4. இலணனத்தில் இலணயதற்கு ஧னன்஧டும் இபண்டு அணுகு ப௃ல஫கல஭ 
கூறுக. 
 ம஥படி அணுகுதல்: ஧னணத்தழன் க஧ளது இம்ன௅ல஫னள஦து ப஧ன௉ம்஧ளலும் 

஧னன்஧டும். 
஋.கள: அல஬ப்க஧ெழனள஦து 3G/4G அல஬ப்க஧ெழ யல஬னலநப்ன௃ னெ஬நளக 
அல்஬து ப஧ளது லயஃல஧ னெ஬நளக இலணனத்தழல் இலணதல். 

 நல஫ப௃க அணுகல்: யடீு நற்றும் அலுய஬கங்க஭ில் ப஧ன௉ம்஧ளலும் 
஧னன்஧டும் யல஬னலநப்஧ளகும். 
஋.கள: கணிப்ப஧ள஫ழனள஦து ஈதர்ப஥ட் அல்஬து லயஃல஧ னெ஬நளக 
யல஬னலநப்ன௃டன் இலணக்கப்஧ட்டு அந்த யல஬னலநப்஧ள஦து ADSL 
னெ஬நளக இலணனத்துடன் இலணக்கப்஧ட்டின௉க்கும். 

5. யல஬ உ஬ாயி நற்றும் மதடுத஧ா஫ிகள் மயறு஧டுத்துக (எ.கா உதயிப௅ைன்). 

யல஬ உ஬ாயி மதடுத஧ா஫ிகள் 
யல஬ உ஬யி ஋ன்஧து 
கணிப்ப஧ள஫ழனில் யல஬த஭த்லதகனள, 
யல஬ ஧க்கத்லதகனள அணுக 
஧னன்஧டும் பநன்ப஧ளன௉ள் ஆகும்.  

 

கதடுப஧ள஫ழகள் ஋ன்஧து கதலயனள஦ 
தகயல஬ உ஬க஭ளயின யல஬னில் 
இன௉ந்து (www) கதடி தன௉யதற்களக 
யடியலநக்கப்஧ட்டுள்஭ 
பநன்ப஧ளன௉஭ளகும்.  

Internet Explorer, Google Chrome, Mozila 
Firefox நற்றும் Safari, ஆகழனலய 
ன௃கழ்ப஧ற்஫ யல஬ உ஬யிகள் ஆகும்.  

Google நற்றும் Yahoo ஆகழனலய நழகவும் 
ன௃கழ்ப஧ற்஫ கதடு ப஧ள஫ழக஭ளகும். 

6. யல஬த்த஭ம், யல஬ப்஧க்கம் மயறு஧டுத்துக. 
யல஬ப்஧க்கம் யல஬த்த஭ம் 

என௉ ஆயணத்லதக் பகளண்டு 
யல஬ உ஬யினளல் 
பய஭ிக்களட்டப்஧டுயதளகும். 

஧஬ யல஬ ஆயணங்கல஭க் பகளண்டு 
உன௉யலநக்கப்஧ட்டு யல஬ உ஬யினளல் 
பய஭ிக்களட்டப்஧டும். 

யல஬த்த஭த்லத உன௉யளக்க 
஧னன்஧டுகழ஫து. 

என்று அல்஬து ஧஬ 
யல஬ப்஧க்கங்கல஭க் பகளண்டின௉க்கும். 
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7. ஥ில஬னா஦ யல஬ப்஧க்கத்திற்கும், நாறும் யல஬஧க்கத்திற்கும் உள்஭ 
மயறு஧ாடு னாது. 

஥ில஬னா஦து நா஫க்கூடினது 
யல஬ப்஧க்கத்தழன் ப஧ளன௉஭டக்கன௅ம் 
கதளற்஫ன௅ம் ஫ழல஬னள஦தளக 
இன௉க்கும். 

ப஧ளன௉஭டக்கன௅ம் கதளற்஫ன௅ம் 
இனக்க க஥பத்தழன் க஧ளது நளறும். 

஥ழல஬னள஦ யல஬ப்஧க்கநள஦து, 
கெலயனகத்தழன் ஋ந்த ஧னன்஧ளட்டின் 
துலணனேநழன்஫ழ க஥படினளக யல஬ 
உ஬ளயினில் இனங்கும். 

நள஫க்கூடின யல஬ப்஧க்கநள஦து 
கெலயனகத்தழன் ஧னன்஧ளட்டு 
஥ழபல஬க் பகளண்டு ன௅டிலய 
பய஭ினிடுயதன் னெ஬ம் இனங்கும். 

஥ழல஬னள஦ யல஬ப்஧க்கத்லத 
உன௉யளக்குயது ஋஭ிது. 

நள஫க்கூடின யல஬ப்஧க்கத்லத 
உன௉யளக்க ஥ழப஬ளக்கத்தழ஫ன் கதலய. 

8. நின்஦ஞ்ச஬ின் ஥ன்லநகள் னாலய? 
 இ஬யச யி஥ிமனாகம் (Free delivery) - நழன்஦ஞ்ெல் அனுப்ன௃யது இலணன 

பெ஬லய தயிர்த்து கழட்டதட்ட இ஬யெநளககய உள்஭து.  
 உ஬க஭ாயின யி஥ிமனாகம் (Global delivery) - நழன்஦ஞ்ெ஬ள஦து உ஬கழன் ஋ந்தப் 

஧குதழனில் உள்஭ ஋ந்த ஥ளட்டிற்கும் அனுப்஧ப்஧டும். 
 மகாப்புகல஭ இலணத்தல் (File attachment): நழன்஦ஞ்ெ஬ள஦து ஆயணங்கள், 

஧டங்கள், அல்஬து நற்஫ ககளப்ன௃கல஭ இலணத்து அனுப்஧ யலக பெய்கழ஫து. 
 ஥ீண்ைகா஬ மசநிப்பு (Long-term storage): நழன்஦ஞ்ெ஬ள஦து ஥ீண்டகள஬த்தழற்கு 

தகயல்கல஭கதக்கழ லயக்கவும், ஧ளதுகளக்கவும் அனுநதழக்கழ஫து. 
5 நதிப்த஧ண்கள் யி஦ாக்கள்: 

1. ஏமதனும் 5 இலணன மசலயகள் ஧ற்஫ி யியரி? 
 கம்஧ி இல்஬ாஇலணப்பு (Wireless): பதளல஬க஧ெழ (அல்஬து) கம்஧ி யடம் 

இலணப்ன௃கல௃க்கு ஧தழ஬ளக கபடிகனள அல஬கள் ஧னன்஧டுத்தப்஧டுகழன்஫஦. 
கம்஧ினில்஬ள இலணன இலணப்஧ின் நழகப் ப஧ன௉ம் அனுகூ஬கந, யல஬னலநப்ன௃ 
யிரிந்துள்஭ இடத்தழற்குள் இலணன இலணப்ல஧ ஋ந்த இடத்தழ஬ழன௉ந்தும், 
஋ப்க஧ளதும் அணுக ன௅டினேம்.  

 லகப்ம஧சி (Mobile): ஧஬ லகப்க஧ெழ நற்றும் ஸ்நளர்ட்க஧ளன் தனளரிப்ன௃ ஥ழறுய஦ங்கள் 
குபல் யமழ அலமப்ன௃ யெதழனேடன் கூடின இலணன கெலயகல஭ யமங்குகழன்஫஦. 
஥ல்஬ கயகத்துடன் இலணனத்லத அணுகுயதற்கு லகப்க஧ெழ யமழ இலணன 
இலணப்஧ள஦து ஧னன்஧டுகழ஫து.  

 ஹாட்ஸ்஧ாட்(Hotspots): கம்஧ினில்஬ள குறும்஧பப்ன௃ யல஬னலநப்ல஧ க஧ளன்று 
இலணன யெதழலன அணுக லளட்ஸ்஧ளட்ஸ் (Hotspots) ஧னன்஧டுகழன்஫து. Hotspots 
ெளத஦நள஦து பவுட்டர் (ROUTER) க஧ளல் பெனல்஧ட்டு இலணன கெலய 
யமங்கு஧யன௉டன் இலணப்ல஧ ஌ற்஧டுத்துகழ஫து.  

 யைங்கள் (Cable): யடங்கள் யமழனளக கநற்பகளள்஭ப்஧டும் இலணன 
இலணப்஧ள஦து ஧ிபளட்க஧ண்ட் அலநப்ல஧ப் க஧ளன்஫து. இது இலணனத்லத அதழ 
கயகநளக அணுகுயதற்கு உதவுகழ஫து.  

 ைாங்கிள்ஸ் / தபவு அட்லை(Dongles / Data Card): இன்ல஫ன கணிப்ப஧ள஫ழகள் 
ப஧ன௉ம்஧ள஬ள஦லய லயஃல஧, நற்றும் பெல்லு஬ளர் தபவு ஌ற்஧ிகல஭(adapters) ன௅ன் 
கூட்டிகன பகளண்டுள்஭தளல் 3G நற்றும் 4G டளங்கழள்கள் (DONGLES) அதழகநளக 
஧னன்஧டுகழன்஫஦.  
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2. ஏமதனும் 5 இலணன ஧னன்஧ாடுகள் ஧ற்஫ி தகுந்த எடுத்துக்காட்டுைன் யியரி?. 
 இலணனத்தில் த஧ாருள்கல஭ யாங்குதல் (ONLINE SHOPPING): 

இலணனநள஦து பநய்஥ழகர் ெந்லதக஭ளல் (Online Shopping) கட்டலநக்கப்஧ட்டு 
உள்஭டக்கழன ன௃தழன ெந்லத ன௅ல஫ யெதழலன அ஫ழன௅கப்஧டுத்துகழன்஫து. (www) 
கெலயனங்கள் னெ஬ம் ப஧ளன௉ள்கல஭ ஧ற்஫ழன யி஧பங்கல஭கனள அல்஬து 
யமங்கும் கெலயகள் ஧ற்஫ழன தகயல்கல஭கனள யல஬த்த஭த்தழல் அ஫ழந்து 
பகளள்஭ன௅டினேம். (஋.கள.) amazon.com உ஬க஭ளயின யல஬லன அடிப்஧லடனளக 
பகளண்டு (இலணனத்லத) இலணனத்தழல் பெனல்஧டும் ன௃த்தக கலட ஆகும்.  

 ஧ங்குச் சந்லத ஧ற்஫ின தகயல்கல஭ த஧றுதல் (Stock market updates): 
இலணனத்தழன் னெ஬ம் யடீ்டில் இன௉ந்த஧டிகன ஥ழறுய஦ங்க஭ின் ஧ங்குகல஭ 
யளங்ககயள, யிற்ககயள ன௅டினேம்.  

 நின் கற்஫ல் (e-learning): நழன் கற்஫ல் ஋ன்஧து இலணனத்தழன் யமழனளக 
஋ங்கழன௉ந்தும் கற்஧தற்கு யமங்கப்஧டும் கல்யி ன௅ல஫னளகும்.  

 நின் ஆல௃லந (e - governance): இலணனம் னெ஬ம் அபெளங்கம் யமங்கும் 
கெலயகல஭ப் ப஧஫வும், அலய பதளடர்஧ள஦ தகயல்கல஭ பதரிந்து 
பகளள்஭வும் உதவும் ஧னன்஧ளடு நழன் ஆல௃லந ஋஦ப்஧டும்.  

 நின்-யங்கி (e-banking): நழன் யங்கழ ஋ன்஧து இலணன யங்கழ ஋஦வும் 
அலமக்கப்஧டுகழ஫து. என௉ யங்கழனின் யளடிக்லகனள஭ர் அல்஬து ஥ழதழ ஥ழறுய஦ம் 
ஆ஦து த஦து யல஬னகத்தழன் னெ஬ம் ஥ழதழ ஧ரியர்த்தல஦கல஭ கநற்பகளள்஭ 
உதவுகழ஫து. 

 
3. ஧ாைப்புத்தகத்தில் தபப்஧ட்டுள்஭ யல஬ உ஬ாயிகள் தயிப ஏமதனும் 5 யல஬ 

உ஬ாயிகள் ஧ற்஫ி யியரி. 
(1) Opera: யிண்கடளஸ் நற்றும் ஬ழ஦க்ஸ் இனக்க அலநப்ன௃கல௃க்கு Opera 

Software As ஋ன்஫ ஥ழறுய஦த்தளல் ஌ப்பல்1995 ல் பய஭ினிடப்஧ட்ட என௉ 
உ஬ளயி.   

(2) UC Browser: UC Web ஋ன்஫ ெவ஦ பநளல஧ல் ஥ழறுய஦த்தளல் உன௉யளக்கப்஧ட்ட 
யல஬ உ஬ளயி. இதன் ெழ஫ப்஧ம்ெம்: உள்஥ழல஦யகத்தழ஫ன், தபவுச் சுன௉க்கம், 
கயகநள஦ உ஬ளவுதல் 

(3) Mosaic Browser: இது உ஬கழன் ன௅தல் யல஬ உ஬ளயி ஆகும். இந்த உ஬ளயி 
நளர்க் அண்டர்பென் ஋ன்஧யபளல் உன௉யளக்கப்஧ட்டது. இப்ப஧ளழுது இது 
஧னன்஧ளட்டில் இல்ல஬. 

(4) Microsoft Edge: இது லநக்கபளெளப்ட் ஥ழறுய஦த்தளல் உன௉யளக்கப்஧ட்டு 
யிண்கடளஸ் 10 இனக்க அலநப்ன௃டன் இலணக்கப்஧ட்ட யல஬ உ஬ளயி 
ஆகும்.  

(5) Maxthon: இது ஥ம்஧கநள஦ ஧ன஦ர் இலடன௅கத்துடனும், ஧஬ 
ெழ஫ப்஧ம்ெங்கல௃ம் பகளண்ட என௉ கயகநள஦ இ஬யெ உ஬ளயினளகும். இது 
Maxthon Ltd ஋ன்஫ ெவ஦ ஥ழறுய஦த்தளல் உன௉யளக்கப்஧ட்டது. 
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4. இலணன உ஬ாவுத஬ிள் தசய்னமயண்டினலயப௅ம், தசய்னக்கூைாததும் ஧ற்஫ி 
யியரி.  
 த஦ிப்஧ட்ட தகய஬ள஦ யடீ்டு ன௅கயரி, பதளல஬க஧ெழ ஋ண்கள், ப஧ற்க஫ளர்கள் 

஧ணின௃ரினேம் இடத்தழன் ன௅கயரி க஧ளன்஫யற்ல஫ இலணனத்தழல் ஧தழனக் 
கூடளது.  

 த஦ிநல஫ அலநப்ன௃கல஭ ஧னன்஧டுத்தழ ஥ளம் ஧தழயிடும் ன௃லகப்஧டங்கள், 
நற்றும் பெய்தழகல஭ ஥ண்஧ர்கள் நற்றும் உ஫வு஦ர்கள் நட்டுகந ஧ளர்க்குநளறு 
பெய்ன கயண்டும். 

 ஧ளதுகளப்ன௃ நற்றும் த஦ிநல஫ அலநப்ல஧ ெரி஧ளர்த்துக் பகளள்ல௃தல் 
 கடவுச்பெளல்ல஬ அலநக்கும்க஧ளது னளன௉ம் ஋஭ிதழல் னைகழக்க ன௅டினளததளக 

இன௉ப்஧லத உறுதழ பெய்ன கயண்டும். 
 அல஬ப்க஧ெழனள஦து கடவுச்பெளற்கள் (஋ண்கள் ) னெ஬ம் ஧ளதுகளப்஧ளக 

உள்஭லத உறுதழ பெய்து பகளள்஭ கயண்டும்.  
 அந்஥ழனர்கல௃டன் ஆன்ல஬஦ிக஬ள அல்஬து ஆஃப் ல஬஦ிக஬ள பதளடர்ன௃ 

பகளள்஭ கூடளது.  
 ப஧ரினயர்க஭ின் க஧ச்லெ ககட்க கயண்டும்.  
 ஧ளதுகளப்஧ற்஫ அல்஬து பதரிந்தழன௉க்களத யல஬த் த஭ங்க஭ில் கய஦ன௅டன் 

இன௉க்க கயண்டும்.  
 ஆன்ல஬஦ில் ப஧ளன௉ள் யளங்கும் க஧ளது க஥ர்லநனள஦ நற்றும் அ஫ழனப்஧ட்ட 

யிற்஧ல஦னள஭லப ஧னன்஧டுத்த கயண்டும். 
 நழன்஦ஞ்ெல், உட஦டி பெய்தழகள், அல்஬து ெனெக யல஬த்த஭ங்க஭ில் யன௉ம் 

இலணப்ன௃கள் ஥நக்கு பதரிந்தயர்க஭ிடநழன௉ந்து யந்தது ஋ன்஧லத உறுதழ 
பெய்னேம் யலப அயற்ல஫ Click பெய்ன கூடளது. 
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஧ாைம் 10. HTML - கட்ைலநப்பு ஒட்டுகள் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. HTML ஋ன்஧தன் யிரியளக்கம் 
(a) Hyper Transfer Markup Language   (b) Hyper Text Markup Language 
(c) Hyper Transfer Makeup Language   (d) Hyper Text Makeup Language 

2. HTML ஥ழப஬ழல் இலணன உ஬ளயினள஦து யல஬ப்஧க்கத்தழன் ப஧ளன௉஭டக்கத்தழல஦ 
஋வ்யளறு யடியலநத்து தழலபனில் பய஭ிப்஧டுத்த கயண்டும் ஋ன்஧லதக் கு஫ழப்஧து 
(a) ஒட்டுக்கள் (Tags)  (b) ஧ண்ன௃க்கூறுகள் (c) தல஬ப்ன௃கள்  (d) உடற்஧குதழ 

3. ஧ின்யன௉஧லயக஭ில் ஋து எட்டுக஭ின் உள்க஭ கு஫ழக்கப்஧ட்டு அலய ஧ற்஫ழன 
கூடுதல் தகயல்கல஭ கு஫ழக்க உதவுகழ஫து? 
(a) எட்டுக்கள் (Tags)  (b) ஧ண்புக்கூறுகள் (c) தல஬ப்ன௃கள்  (d) உடற்஧குதழ 

4. HTML எட்டுக஭ள஦து …………………………….கு஫ழகல௃க்குள் கு஫ழக்கப்஧டுதல் கயண்டும்: 
(a) [ ]   (b) { }   (c) ( )   (d) < > 

5. HTML ஆயணநள஦து …………இலண எட்டுகல௃க்குள் அலநக்கப்஧டுதல் கயண்டும். 
(a) <body> ……. </body>   (b) <title> ……. </title>  
(c) <html> ……. </html>   (d) <head> …… </head> 

6. ஧ின்யன௉஧லயக஭ில் ஋து ன௅டிவு எட்டில஦ கு஫ழக்க ஧னன்஧டுகழ஫து? 
(a) < >   (b) %   (c) /   (d) \ 

7. இலணன உ஬ளயி ஜன்஦ல் தழலபனில் ஋ந்த ஧குதழனள஦து ஆயணத்தழன் ஧ிபதள஦ 
உள்஭டக்கத்லத களட்டும்? 
(a) Head   (b) Body  (c) Title   (d) Heading 

8. ஧ின்யன௉஧லயக஭ில் ஋து கட்டலநப்ன௃ எட்டு ஆகும்? 
(a) <html>   (b) <h1>   (c) <br>   (d) <p> 

9. HTML ல் யண்ணங்கள் ……………………….னெ஬ம் கு஫ழக்கப்஧டுகழன்஫஦. 
(a) இன௉஥ழல஬ ஋ண்கள்   (b) ஋ண்ந ஋ண்கள் 
(c) ஧தழன்ந ஋ண்கள்   (d) ஧தி஦ாறுந எண்கள் 

10. ஧ின்யன௉஧லயக஭ில் ஋ந்த கு஫ழனடீள஦து யண்ணங்கல஭க் கு஫ழக்கும் ஧தழ஦ளறுந 
஋ண் நதழப்ன௃கல௃க்கு ன௅ன்ப஦ளட்டளக கு஫ழப்஧ிடப்஧டுகழன்஫஦? 
(a) %   (b) #   (c) @   (d) & 

11. உடற்஧குதழ எட்டினுள் உலபனின் யண்ணத்லதக் கு஫ழப்஧ிட கவழ்யன௉ம் ஋ந்த 
஧ண்ன௃க்கூறு ஧னன்஧டுகழ஫து? 
(a) bgcolor  (c) background   (c) text  (d) color 

12. உடற்஧குதழனினுள் கநல்஧க்க ஏபத்லத கு஫ழப்஧ிட ஧ின்யன௉ம் ஋ந்த ஧ண்ன௃க்கூறு 
஧னன்஧டுகழ஫து? 
(a) margin  (b) top   (c) topmargin   (d) leftmargin 

13. ஋த்தல஦ யலகனளக தல஬ப்ன௃ எட்டுகள் HTML ல் உள்஭஦ ? 
(a) 6   (b) 4   (c) 8   (d) 3 

14. யரி ன௅஫ழலய ஌ற்஧டுத்துயதற்கு ……………………எட்டு ஧னன்஧டுகழ஫து. 
(a) <h1>  (b) <br>  (c) <html>  (d) <p> 

15. HTML ல் ஧த்தழகல஭ யலபனறுக்க ………………எட்டு ஧னன்஧டுகழ஫து 
(a) <para>  (b) <p>  (c) <q>  (d) <br> 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. சந்தினா ஒரு யல஬ப்஧க்கத்லத உருயாக்கிக் தகாண்டிருக்கின்஫ாள். அயள் 

த஦து கணி஦ினில் HTML கு஫ிப௃ல஫லன உள்஭ிட்டுக் தகாண்டிருக்கி஫ாள். 
இலைனிலைமன இலணன உ஬ாயினில் REFRESH /RELOAD த஧ாத்தால஦ 
அழுத்திக்தகாள்கி஫ாள். காபணத்லத யி஭க்குக. 

 ெந்தழனள த஦து கணி஦ினில் HTML கு஫ழன௅ல஫னில் பெய்னேம் நளற்஫ங்கல஭ 
இலணன உ஬ளயினில் ஧ளர்லயனிட REFRESH / RELOAD ப஧ளத்தளல஦ 
அழுத்தழக்பகளள்கழ஫ளள். 

2. அலைவு ஒட்டுகல௃க்கும், கா஬ி ஒட்டுகல௃க்கும் இலைமனனா஦ மயறு஧ாட்லை 
ஒரு தகுந்த எடுத்துக்காட்டுைன் யி஭க்குக. 

அலைவு ஒட்டுகள் கா஬ி ஒட்டுகள் 
பதளடக்க நற்றும் ன௅டிவு எட்டுகல஭ 
பகளண்டுள்஭ எட்டுகள் அலடப்ன௃ 
எட்டுகள் ஋஦ப்஧டும் 

பதளடக்க எட்டுகல஭ நட்டும் 
பகளண்டுள்஭ எட்டுகள் கள஬ழ எட்டுகள் 
஋஦ப்஧டும்.  

஋.கள: <html>, <body>, <title>, <p> etc., ஋.கள: <br>, <Img>, <Hr> 
3. ஧ின்யரும் HTML கு஫ிப௃ல஫னில் உள்஭ ஧ிலம னாது?  

<html>  

<my web page>  

<title> Welcome to my web page  

</head>  

</title> 

 சரினா஦ ப௃஫ிப௃ல஫: 
<html>  

<head>  

<title> <my web page> 

</title> 

</head>  

<body>  

Welcome to my web page  

</body>  

</html> 

4. HTML ஥ிப஬ில் கு஫ிப்புகல஭(comments) எவ்யாறு யலபனறுப்஧ாய்? யி஭க்குக. 
 யல஬ப்஧க்கத்லதப் ஧ற்஫ழ கு஫ழப்ன௃லபகள் யமங்கவும் அல்஬து 

யல஬ப்஧க்கத்தழன் ஥ழல஬லனப் ஧ற்஫ழ ெழ஬ யலகனளக அலடனள஭ங்கல஭க் 
கு஫ழப்஧தற்கும் comments எட்டள஦து ஧னன்஧டுகழ஫து.  

 Comments எட்டில் இடம் ப஧றும் உலபலன யல஬ உ஬ளயினள஦து 
பய஭ினடீ்டில் பய஭ிப்஧டுத்தளது.  

Comment எட்டின் ப஧ளதுயடியம்: <!யி஭க்கஉலப> 
5. இலணன உ஬ாயினின் ஧ின்பு஫ம் ஒரு உருயப்஧ைத்லத உள்஭ிடும் யமிப௃ல஫ 

னாது?  
 இலணன உ஬ளயினின் ஧ின்ன௃஫ம் என௉ உன௉யப்஧டத்லத உள்஭ிடும் யமழன௅ல஫:

 <body background = “image_name_with_extenstion”> 
 
 
3 நதிப்த஧ண் யி஦ாக்கள்: 
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1. உைற்஧குதி ஒட்டினுள் ( Body) உள்஭ ஧ண்புக்கூறுகள் னாலய? 
ஆயணத்தழன் உடற்஧குதழலன யலபனறுக்க <body> எட்டள஦து ஧னன்஧டுகழ஫து.  
Body ஒட்டுக்கா஦ ஧ண்புக்கூறுகள்: 
 Background Color ( bgcolor = color): யல஬ உ஬ளயினின் ஧ின்஦ணி ஥ழ஫த்லத bgcolor 

஋ன்஫ ஧ண்ன௃க்கூ஫ழன் னெ஬ம் நளற்஫ழனலநக்க ன௅டினேம். 
 text (text = color): உடற்஧குதழனில் இடம்ப஧றும் உலபனின் ஥ழ஫த்லத நளற்றுதல்.  
 Background image (background=image): யல஬ உ஬ளயினின் ஧ின்஦ணினளக 

உன௉யப்஧டத்லதகனள (image) அல்஬து ஥ழமற்஧டத்லதகனள (picture) அலநக்க 
ன௅டினேம்.  

 Setting Margins (margin = value): யல஬ உ஬ளயினின் கநல் ஧க்ககநள அல்஬து 
இடது ஧க்ககநள ஏபத்தழற்களக இலடபய஭ி அலநக்க யின௉ம்஧ி஦ளல் ன௅ல஫கன 
Top Margin நற்றும் left Margin ஋ன்஫ ஧ண்ன௃க்கூறுகள் ஧னன்஧டுகழன்஫஦. 

2. HTML ஒட்டினுள் உள்஭ ஧ண்புக்கூறுகள் னாலய? 
<html> எட்டள஦து இபண்டு ஧ண்ன௃க்கூறுகல஭க் பகளண்டுள்஭து. அலய, dir நற்றும் 
lang ஆகும். இந்த ஧ண்ன௃க்கூறுகள் உலபனின் தழலெலனனேம் நற்றும் பநளமழ 
அலநலயனேம் ஥ழர்ணனிக்க ஧னன்஧டுகழன்஫஦.  

஧ண்புக்கூறுகள் யி஭க்கம் 
dir dir - ஧ண்ன௃க்கூ஫ள஦து நீவுலப ஆயணம் ன௅ழுலநக்கும் உலபனின் 

தழலெலனத் தீர்நள஦ிக்க ஧னன்஧டுகழ஫து.  
Ltr ” நதழப்஧ள஦து பகளடள஥ழல஬ நதழப்஧ளகும் 
rtl - நதழப்஧ள஦து அகப஧ின பநளமழகல௃க்கள஦ கதர்யளகும். 

lang lang ஧ண்ன௃க்கூ஫ள஦து நீவுலப ஆயணத்தழல்  
஧னன்஧டுத்தப்஧டும் பநளமழலன கு஫ழக்கும். ன௅ன்க஧ யலபனறுத்து 
லயக்கப்஧ட்ட பநளமழகல௃க்கள஦ கு஫ழனடீுகள் lang ன் நதழப்஧ளக 
஧னன்஧டுத்தப்஧டுகழன்஫஦. அலய 
நல஬னள஭ம் ” ml ; கன்஦டம் ” kn ; இந்தழ ” hi ; ஧ிபபஞ்ச் ” fr ; 
பஜர்நன் ” de;  

3. ப௄஬க்கு஫ிப௃ல஫லன எவ்யாறு ஧ார்லயனிடுயாய்? 
 உலபப்஧தழப்஧ள஦ில் தட்டச்சு பெய்னப்஧ட்டு கெநழக்கப்஧டும் நீவுலப ஆயணம் 

னெ஬க்கு஫ழன௅ல஫ ககளப்ன௃ ஋஦ப்஧டும். னெ஬க்கு஫ழன௅ல஫ ககளப்ல஧ யல஬ 
உ஬ளயினில் ஧ளர்க்க ன௅டினேம்.  

யமழன௅ல஫கள்:. 
 யல஬உ஬ளயினில் சுட்டிலன லயத்து ய஬து Click பெய்ன கயண்டும்.  
 View Page Source / View Source ஋஦ கதர்வு பெய்னவும் அல்஬து Ctrl + U  ஋ன்஫ 

ெளயிச் கெர்நள஦த்லத அழுத்தவும். இப்ப஧ளழுது னெ஬க்கு஫ழன௅ல஫னள஦து 
யல஬உ஬ளயினில் கதளன்றும்.  

4. HTML ல் மகாப்புகல஭ மசநிக்கும் யமிப௃ல஫கள் னாலய? 
 உலபப் ஧தழப்஧ளல஦ தழ஫ந்து HTML ஆயணத்லதத் தட்டச்சு பெய்ன கயண்டும்.  
 File → Save ஋ன்஫ யரிலெ அல்஬து CTRL + S ஋ன்஫ ெளயிச் கெர்நள஦த்லத 

அழுத்தழ஦ளல் SaveAS உலபனளடல் ப஧ட்டி கதளன்றும். 
 File Name ஋ன்஫ உலபப் ப஧ட்டினில் ககளப்஧ின் ப஧னன௉டன் .htm or .html ஋஦வும், 

SaveAs Type ஋ன்஧தழல் ALL FILES ஋ன்஧லதனேம் கதர்வு பெய்து  SAVE 
ப஧ளத்தளல஦ Click பெய்தளல் ஆயணம் கெநழக்கப்஧டும். 
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஧ாைம் 11. HTML உலப யடிவூட்ைல், அட்ையலண உருயாக்குதல், ஧ட்டினல்கள் 
நற்றும் இலணப்புகள் 

சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 
1. கவழ்கண்ட எட்டுகள் ஋து PHYSICAL STYLE எட்டுகள் ஋஦ அலமக்கப்஧டும்? 

(அ) <html>, <b>, <br>   (ஆ) <b>, <br>, <u> 
(இ) <A>, <b>, <i>   (ஈ) <b>, <i>, <u> 

2. ஧ின்யன௉ய஦யற்றுள் ஋ந்தப் ஧ண்ன௃ ஧டிப்஧யரின் கய஦த்லத ஈர்க்க ஧னன்஧டுகழ஫து? 
(அ) உனர்த்திக்காட்டுதல்  (ஆ) தடித்த  (இ) ெளய்ந்த  (ஈ) அடிக்ககளடிட்ட 

3. <sub> நற்றும் <sup> எட்டுக஭ில் ஧னன்஧ளடள஦து: 
(அ) Subject and Super   (ஆ) Subscript and Super 
(இ) Subject and Superscript   (ஈ) Subscript and Superscript 

4. கு஫ழப்஧ிட்ட ஋ழுத்து நற்றும் ஋ண்க஭ின் யலகனில஦ பகளண்ட பதளகுதழனள஦து 
(அ) Style  (ஆ) Character  (இ) Font  (ஈ) List 

5. ஧ட்டின஬ழல் இன௉ந்து கயறு஧ட்ட என்ல஫ கதர்ந்பதடு. 
(அ) <tr>   (ஆ) <th>  (இ) <dh>   (ஈ) <td> 

6. ப஧ளன௉த்துக: 
(a) tfoot -  (1) Order list 
(b) start -  (2) Hyperlink 
(c) href -  (3) Highlight 
(d) mark -  (4) Table 
(அ) 4 1 2 3  (ஆ) 1 4 3 2  (இ) 4 3 2 1  (ஈ) 1 2 4 3 

7. யலபனறுக்கப்஧ட்ட ஧ட்டின஬ள஦து ஋த்தல஦ ஧குதழகல஭ பகளண்டுள்஭து? 
(அ) 5   (ஆ) 4   (இ) 3   (ஈ) 2 

8. என௉ ஧ட்டினல் பதளகுதழனள஦து நற்ப஫ளன௉ ஧ட்டினல் பதளகுதழக்குள் 
யலபனறுக்கப்஧ட்டளல் அது : 
(அ) Inner List   (ஆ) Nested List (இ) Outer List   (ஈ) Listing List 

9. ஧ின்யன௉ம் கூற்றுகல஭ தடித்த அயற்஫ழல் ெரினள஦ல஫ கதர்ந்பதடு: 
(I) HTML –ல் நீத்பதளடுப்ன௃கல஭ உன௉யளக்க இலணப்஧ள஦து ஧னன்஧டுகழ஫து. 
(II) HREF ஋ன்஧து Hypertext Markup File 
(அ) I is correct   (ஆ) II is correct  
(இ) I and II is correct     (ஈ) Both are wrong 

10. உள் இலணப்ன௃கல஭ உன௉யளக்க ஧ின்யன௉ய஦யற்றுள் ஋ந்த ஧ண்ன௃க்கூறு 
஧னன்஧டுகழ஫து? 
(அ) link   (ஆ) name  (இ) local   (ஈ) Inter 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. <strong> நற்றும் <em> ஒட்டுகள் ஧ற்஫ி கு஫ிப்பு யலபக. 

HTML ஆ஦து Bold ந஫றும் italic எட்டுகல௃டன் <strong>, <em> எட்டுகல஭னேம் 
கூடுத஬ளக யமங்குகழ஫து.  
 <strong> எட்டள஦து உலபலன தடித்த ஋ழுத்துக்க஭ில் பய஭ிப்஧டுத்தும். 
 <em> எட்டள஦து உலபலன ெளய்ந்த ஋ழுத்துக்க஭ில் பய஭ிப்஧டுத்தும். 
 <mark> ஒட்டின் ஧னன் னாது? 
 HTML ” ல் உலபலன உனர்த்தழக்களட்டுயதற்கு <mark> ஋ன்஫ எட்டள஦து 

஧னன்஧டுகழன்஫து. இது உலபலன ஧டிப்஧யர்க஭ின் கய஦த்லத ஈர்க்க 
஧னன்஧டுகழ஫து.  

2. கீழ்காணும் சநன்஧ாட்லை HTML கு஫ிப௃ல஫னில் எழுதுக:  
Pd = 25 – Q2 

 கு஫ிப௃ல஫: 
<html>  

<head>  

<title> Equation </title> 

</head>  

<body>  

Pd = 25 – Q2 

</body>  

</html> 

3. font ஒட்டின் ஏமதனும் இபண்டு ஧ண்புக்கூறுகல஭ ஧ற்஫ி எழுதுக. 
<font> எட்டள஦து உலபனின் ஋ழுத்து யலக, அ஭வு நற்றும் ஥ழ஫த்லத நளற்஫ 
஧னன்஧டுகழ஫து. 
஧ண்புக்கூறுகள்: 
 face ஋ன்஫ ஧ண்ன௃க்கூ஫ள஦து ஧ல்கயறு யலகனள஦ ஋ழுத்துன௉க்கல஭ அலநக்கப் 

஧னன்஧டுகழ஫து.  
 Size ” ஧ண்ன௃க்கூ஫ள஦து ஧ல்கயறு யலகனள஦ ஋ழுத்து அ஭வுகல஭ அலநக்கப் 

஧னன்஧டுகழ஫து.   
4. கருப்த஧ாருள் இலைதய஭ி என்஫ால் என்஦? 

 <hr> (Horizontal Rules) எட்டள஦து, கன௉ப்ப஧ளன௉ள் இலடபய஭ி ஋஦ப்஧டும். 
 இது யல஬ உ஬ளயினின் அக஬த்தழற்கு இலணனளக என௉ கழலடநட்டயரிலன 

உன௉யளக்குகழ஫து. இது கள஬ழ எட்டளகும்.  
5. HTML-ல் உள்஭ ஧ட்டின஬ின் யலககள் னாலய? 

HTML-ல் ப௄ன்று யலகனா஦ ஧ட்டினல்கள் உள்஭஦,  
 யரிலெ ஧டுத்தப்஧ட்ட ஧ட்டினல்கள்  

 யரிலெப்஧டுத்தப்஧டளத ஧ட்டினல்கள்  
 யலபனல஫஧ட்டினல்கள்   

6. யரிலசப்஧டுத்தப்஧ட்ை ஧ட்டினல஬ எவ்யாறு உருயாக்குயாய்? 
 ஋ண் யரிலெப்஧ட்டின஬ள஦து <OL> ….. </OL> ஋ன்஫ இலண எட்டுக஭ளல் 

உன௉யளக்கப்஧டுகழன்஫஦.  
 ஧ட்டின஬ழல் என௉ உன௉ப்஧டிலன கெர்க்க <LI> எட்டள஦து ஧னன்஧டுகழன்஫து.  
 ஋ண்யரிலெப்஧ட்டின஬ள஦து உன௉ப்஧டிகல஭ ஋ண்யரிலெப்஧டிகனள அல்஬து 

அகபயரிலெப்஧டிகனள ஧ட்டின஬ழட்டு களட்டும்.  
 <OL> நற்றும் <LI> ஋ன்஫ இபண்டு எட்டுகல௃ம் அலடவு எட்டுக஭ளகும். 
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3 நதிப்த஧ண் யி஦ாக்கள்: 
1. கீழ்காணும் உலபலன அது தகாடுக்கப்஧ட்டுள்஭து ம஧ா஬மய யல஬ 

உ஬ாயினில் தய஭ிப்஧டுத்த HTML கு஫ிப௃ல஫ எழுதுக. 
I am studying Computer Science Application. 

கு஫ிப௃ல஫: 
<html>  
<head>  
<title> Sample Web Page </title> 
</head>  
<body>  

  <Font face = “Times New Roman”> 
I am studying Computer Science Application. 
</Font> 
</body>  
</html> 

2. <hr> ஒட்டின் ஧ண்புக்கூறுகல஭ ஧ற்஫ி யி஭க்கநாக எழுதுக. 
<hr> எட்டிற்கள஦ பதளடரினல் அதன் ஧ண்ன௃க்கூறுகல௃டன் :  

<hr size=value width=value noshade, color=color_name/code> 
 Size: கழலடநட்ட யரினின் தடிநன் அ஭லய ஥ழர்ணனம் பெய்ன size ஧ண்ன௃க்கூறு 

஧னன்஧டுகழ஫து.  
 Width: கழலடநட்ட யரினின் அக஬த்லத கு஫ழப்஧தற்கு Width ஧ண்ன௃க்கூ஫ள஦து 

஧னன்஧டுகழ஫து.  
 Noshade: ‚noshade‛ ஧ண்ன௃க்கூல஫ <hr> எட்டினுள் கு஫ழப்஧ிட்டளல் 

கழலடநட்டயரினின் கதளற்஫நள஦து ன௅ப்஧ரிநளணத்தழ஬ழன௉ந்து இன௉஧ரிநளண 
ன௅ல஫க்கு நளறும்.  

 Color: Color ஧ண்ன௃க்கூ஫ள஦து கழலடநட்ட யரினின் பகளடள஥ழல஬ யண்ணத்லத 
யின௉ம்஧ின யண்ணத்தழல் நளற்஫ழனலநக்க உதவுகழ஫து,  

3. அட்ையலணலன உருயாக்க ஧னன்஧டும் இலணஒட்டுகள் னாலய? 
 <table>  - அட்டயலணலன உன௉யளக்க ஧னன்஧டுகழ஫து. இது என௉ அலடவு 

எட்டளகும்.  
 <caption> - அட்டயலணனின் தல஬ப்ல஧ யலபனறுக்கழ஫து. 
 <tr> - அட்டயலணனில் யரிலெலன யலபனறுக்க உதவுகழ஫து.  
 <th> - அட்டயலணனில் ப஥டுயரிலெலன யலபனறுக்க உதவுகழ஫து. 
 <td> - ெழற்஫ல஫னில் தபயில஦க் கு஫ழப்஧ிட ஧னன்஧டுகழ஫து. 
 இந்த ஍ந்து எட்டுகல஭ தயிப <tbody>, <thead> நற்றும் <tfoot> க஧ளன்஫ 

எட்டுகல௃ம் ஧னன்஧டுகழன்஫஦. 
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4. https://www.w3schools.com என்஫ யல஬ த஭த்திற்கு HTML கு஫ிப௃ல஫ ப௄஬ம் 
நீத்ததாடுப்ல஧ உருயாக்குக.  
கு஫ிப௃ல஫: 

<html>  

<head>  

<title> Links </title> 

</head>  

<body>  

 <h1> Hyper Link </h1> 

 <A href = “https://www.w3schools.com”> 

W3schools.com</A>   

</body>  

</html> 

5. <UL> நற்றும் <OL> ஒட்டுகல஭ மயறு஧டுத்துக. 
<UL> ஒட்டு <OL> ஒட்டு 

யரிலெப்஧டுத்தப்஧டளத ஧ட்டினல் அல்஬து 
ன௃ல்஬ட் ஧ட்டினல்கல஭ யலபனறுக்கப் 
஧னன்஧டுகழ஫து. 

யரிலெப்஧டுத்தப்஧ட்ட ஧ட்டினல் அல்஬து 
஋ண்யரிலெ ஧ட்டினல்கல஭ யலபனறுக்கப் 
஧னன்஧டுகழ஫து. 

<UL> எட்டுடன் type ஧ண்ன௃க்கூறு 
஧னன்஧டுகழ஫து. 

<OL> எட்டுடன் type நற்றும் start 
஧ண்ன௃க்கூறுகள் ஧னன்஧டுகழன்஫஦. 

யரிலெப்஧டுத்தப்஧டளத ஧ட்டின஬ழல் 
உன௉ப்஧டிகள் ெழ஫ப்ன௃ ன௃ல்஬ட் கு஫ழனடீுகல஭ 
ன௅ன்஦தளக பகளண்டின௉க்கும். 

஋ண்யரிலெப் ஧ட்டின஬ள஦து உன௉ப்஧டிகல஭ 
஋ண்யரிலெப்஧டிகனள அல்஬து 
அகபயரிலெப்஧டிகனள ஧ட்டின஬ழட்டு களட்டும்.  

 
5 நதிப்த஧ண் யி஦ாக்கள்: 

1. அட்ையலண <table> ஒட்டுைன் ஧னன்஧டும் ஧ண்புக்கூறுகல஭ ஧ற்஫ி யி஭க்குக. 
அட்டயலணனின் யடியலநப்ல஧ கநம்஧டுத்த ஧ல்கயறு யலகனள஦ 
஧ண்ன௃க்கூறுகள் உள்஭஦. 
 Cellspacing: அட்டயலணனில் உள்஭ ெழற்஫ல஫கல௃க்கு இலடகன 

இலடபய஭ிலன அலநக்கப் ஧னன்஧டுகழன்஫து. அதனுலடன நதழப்஧ள஦து 
ன௃ள்஭ிக஭ில் பகளடுக்கப்஧ட கயண்டும். 

 Cellpadding: அட்டயலணனில் ெழற்஫ல஫கல௃க்குள் உள்஭ ப஧ளன௉஭டக்கத்தழற்கும் 
ெழற்஫ல஫னின் ஋ல்ல஬கல௃க்கும் இலடகனனள஦ இலடபய஭ிலன அலநக்கப் 
஧னன்஧டுகழ஫து. இதன் நதழப்஧ள஦து ன௃ள்஭ிக஭ில் பகளடுக்கப்஧ட கயண்டும். 

 Border: <table> எட்டுடன் ஧னன்஧டுத்தப்஧டும் border ஧ண்ன௃க்கூ஫ள஦து, 
அட்டயலணலன சுற்஫ழனேள்஭ ஋ல்ல஬ ககளடுக஭ின் தடிந஦஭லய கு஫ழக்க 
஧னன்஧டுகழன்஫து. Border ஧ண்ன௃க்கூ஫ழன் நதழப்஧ள஦து ன௄ஜ்னம் அல்஬ளத நதழப்஧ளக 
ன௃ள்஭ிக஭ில் பகளடுக்கப்஧ட கயண்டும்.  

 Bordercolor: அட்டயலணனின் ஋ல்ல஬க் ககளடுகல௃க்கு யண்ணத்தழல஦ 
அலநக்கப் ஧னன்஧டுகழன்஫து. 

 Align: Align ஧ண்ன௃க்கூ஫ள஦து யல஬ உ஬ளயினின் ஜன்஦ல் தழலபனில் 
அட்டயலணலன எழுங்குப்஧டுத்துகழ஫து.  

 BGcolor: அட்டயலணனின் ஧ின்ன௃஫ யண்ணத்லத அலநக்கப் ஧னன்஧டுகழ஫து. 
 Height and Width: அட்டயலணனின் அக஬த்லதனேம், உனபத்லதனேம் கு஫ழக்க Width 

நற்றும் Height ஧ண்ன௃க்கூறுக஭ள஦து ஧னன்஧டுகழ஫து. இதன் நதழப்ன௃க஭ள஦து 
ன௃ள்஭ிகள் அல்஬து ெதயதீத்தழல் பகளடுக்கப்஧ட கயண்டும். 

 

https://www.w3schools.com/
https://www.w3schools.com/
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2. இலணப்பு என்஫ால் என்஦? இலணப்புக஭ின் யலககல஭ யி஭க்குக. 
 யல஬ ய஭ங்கல஭ இலணக்கப் ஧னன்஧டும் இலணப்ன௃ HTML-ல் என௉ ன௅க்கழன அம்ெநளகும்.  
 யல஬ ஆயணங்கல௃க்கு நீத்பதளடுப்ன௃கல஭ உன௉யளக்க இலணப்ன௃ ஧னன்஧டுகழ஫து. 
 நீத்பதளடுப்஧ள஦து அதனுடன் இலணக்கப்஧டும் யல஬ உள்஭டக்கத்தழன் இடத்லத 

ப஧ளறுத்து 2 யலகப்஧டும். 
 உள் இலணப்ன௃ (2) பய஭ி இலணப்ன௃  

உள் இலணப்பு (Internal Link) :  
 எகப ஆயணத்தழல் இடம் ப஧ற்றுள்஭ கு஫ழப்஧ிட்ட ஧குதழக்கு இலணப்ன௃கல஭ 

உன௉யளக்குயது உள் இலணப்ன௃ ஋஦ப்஧டும்.  
 உள் இலணப்ன௃கல஭ உன௉யளக்குயதற்கு <A> ஥ங்கூப எட்டுடன் Name 

஧ண்ன௃க்கூ஫ள஦து ஧னன்஧டுகழ஫து.  
 ஥ங்கூப எட்டின் ப஧னர் ஧ண்ன௃க்கூ஫ள஦து, ஆயணத்தழன் உள்க஭ இன௉க்கும் 

கு஫ழப்஧ிடப்஧ட்ட ஧குதழக்கு இலணப்ல஧ உன௉யளக்குகழ஫து. 
தய஭ி இலணப்பு (External Link):  
 யல஬ ஆயணத்தழற்கு பய஭ினில் உள்஭ யல஬ப்஧க்கங்கல௃டன் இலணப்ன௃கல஭ 

஌ற்஧டுத்துயது பய஭ி இலணப்ன௃ ஋஦ப்஧டும்.  
 <A> எட்டினுள் உள்஭ HREF ஧ண்ன௃க்கூ஫ழல் இலணப்ன௃ ஌ற்஧டுத்த கயண்டின 

யல஬ப்஧க்கத்தழன் URL ன௅ல஫லன பகளடுத்து இலணப்ல஧ உன௉யளக்க஬ளம். 
3. தகுந்த HTML ஥ிபலுைன் ஧ட்டின஬ின் யலககல஭ ஧ற்஫ி யி஭க்குக. 

HTML-ல் ப௄ன்று யலகனா஦ ஧ட்டினல்கள் உள்஭஦,  
 யரிலெ ஧டுத்தப்஧ட்ட ஧ட்டினல்கள் (Ordered List) 

 யரிலெப்஧டுத்தப்஧டளத ஧ட்டினல்கள் (Unordered List) 

 யலபனல஫஧ட்டினல்கள்  ( Definition List) 

எண் யரிலசப்஧ட்டினல் / யரிலசப்஧டுத்தப்஧ட்ை஧ட்டினல்:  
 ஋ண் யரிலெப்஧ட்டின஬ள஦து <OL> ….. </OL> ஋ன்஫ இலண எட்டுக஭ளல் 

உன௉யளக்கப்஧டுகழன்஫஦.  
 ஧ட்டின஬ழல் என௉ உன௉ப்஧டிலன கெர்க்க <LI> எட்டள஦து ஧னன்஧டுகழன்஫து.  
 ஋ண்யரிலெப்஧ட்டின஬ள஦து உன௉ப்஧டிகல஭ ஋ண்யரிலெப்஧டிகனள அல்஬து 

அகபயரிலெப்஧டிகனள ஧ட்டின஬ழட்டு களட்டும்.  
 <OL> நற்றும் <LI> ஋ன்஫ இபண்டு எட்டுகல௃ம் அலடவு எட்டுக஭ளகும்.  
எண் யரிலசஇைப்஧ைாத஧ட்டினல் / யரிலசப்஧டுத்தாத஧ட்டினல்:  
 யரிலெப்஧டுத்தளத ஧ட்டின஬ள஦து ன௃ல்஬ட் ஧ட்டினல்கள் ஋஦வும் அலமக்கப்஧டுகழ஫து.  
 ஋ண்கல௃க்கு ஧தழ஬ளக ெழ஫ப்ன௃ ன௃ல்஬ட் கு஫ழனடீுகல஭ ன௅ன்஦தளக பகளண்டின௉க்கும். 

யரிலெப்஧டுத்தப்஧டளத ஧ட்டினல் ஆ஦து <UL> ……… </UL> ஋ன்஫ இலணஎட்டுகல௃க்குள் 
யலபனறுக்கப்஧ட்டின௉க்கும். 

யலபனல஫ப்஧ட்டினல்: 
 யலபனல஫ப் ஧ட்டின஬ள஦து நற்஫ இபண்டு ஧ட்டினல்க஭ில் இன௉ந்து நளறு஧டுகழ஫து.  
 ஧ட்டினல் உன௉ப்஧டிக்கு ன௅ன்஦ளல் ன௃ல்஬ட் கு஫ழனகீடள அல்஬து ஋ண் யரிலெ கு஫ழனகீடள 

இன௉க்களது. இம்ன௅ல஫னில் ஧ட்டினல் உறுப்ன௃கள் இபண்டு ஧குதழகல஭ பகளண்டுள்஭து. 
(1) யலபனல஫ தல஬ப்ன௃  
(2) யலபனல஫ யி஭க்கம்  

 யலபனல஫ப் ஧ட்டின஬ள஦து <DL> ……. </DL> ஋ன்஫ இலண எட்டுகல௃க்குள் 
யலபனறுக்கப்஧ட்டின௉க்கும்.  

 யலபனல஫த் தல஬ப்஧ள஦து <DT> ….. </DT> எட்டுகல௃க்குள் தபப்஧டல் கயண்டும். 
 யலபனல஫த் தல஬ப்஧ின் யி஭க்கநள஦து <DD> ………… </DD> எட்டுகல௃க்குள் தபப்஧டல் 

கயண்டும். 
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஧ாைம் 12. HTML – ஧ல்லூைகக்கூறுகள் நற்றும் ஧டியங்கள் இலணத்தல் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. ஋ந்த ஥ழமற்஧ட யடியம் W3C அலநப்஧ி஦ளல் அங்கவகரிக்கப்஧ட்டது? 
(A) JPEG   (B) SVG   (C) GIF   (D) PNG 

2. HTML ஆயணத்தழல் என௉ ஥ழமற்஧டத்லத பென௉க ஧னன்஧டும் எட்டு: 
(A) Image   (B) Picture   (C) Img   (D) Pic 

3. என௉ HTML ஆயணத்தழல் என௉ உலபப்஧குதழலன அல்஬து ஥ழமற்஧டத்லத 
பெங்குத்தளககயள அல்஬து கழலடநட்டநளககயள ஥கர்த்த ஧னன்஧டும் எட்டு: 
(A) <marquee>   (B) <img>   (C) <embed>   (D) <text> 

4. ஧ின்யன௉ம் ஋ந்த எட்டில஦ ஧னன்஧டுத்தழ உள் எ஬ழ HTML ஆயணத்தழல் 
இலணக்க஬ளம்? 
(A) <inline>   (B) <backgroundsound>   (C) <bgsound>   (D) <sound> 

5. என௉ யல஬ப்஧க்கத்லத ஧ளர்லயனிடும் யலப என௉ எ஬ழக்ககளப்ல஧ இனங்க பெய்ன 
஋ந்த நதழப்ல஧ப் ஧னன்஧டுத்த கயண்டும் ? 
(A) Stop   (B) Never Stop   (C) Continue   (D) Infinite 

6. <form> எட்டுடன் ஧னன்஧டுத்தப்஧டும் ன௅க்கழனப் ஧ண்ன௃கூறுக஭ளய஦ 
(A) method and action   (B) name and size  
(C) post and get   (D) type and name 

7. என௉ HTML ஆயணத்தழல், கவழ்யிரிப் ஧ட்டினல் ப஧ட்டிலன உன௉யளக்கப் ஧னன்஧டும் 
எட்டு 
(A) <dropdown>   (B) <select>   (C) <listbox>   (D) <input> 

8. ப஧ளன௉த்துக: 
(a) <textarea> -  (1) inline (உள்஭ிலணந்த) 
(b) <input> -   (2) Video (அலெவுப்஧டம்) 
(c) <bgsound> -  (3) Multiline input (஧ல்யரி உள்஭டீு) 
(d) <embed> -   (4) Password (கடவுச்பெளல்) 
(A) 3 1 4 2  (B) 3 4 1 2  (C) 2 3 4 1  (D) 2 1 3 4 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. யமக்கிலுள்஭ ஥ிமற்஧ை யடியங்கல஭ப் ஧ட்டின஬ிடு. 

 GIF (Graphical Interchange Format) 
 JPEG (Joint Photographic Experts Group)  
 PNG (Portable Network Graphics)  
 SVG (Scalable Vector Graphics) 

2. <marquee> ஒட்டின் த஧ாது யடியத்லத எழுது. 
ப஧ளது யடியம்: <marquee> Text or image to be scroll </marquee> 

3. உள் ஒ஬ி / ஒ஭ிக்காட்சி என்஫ால் என்஦? 
 உள் எ஬ழ / எ஭ிக்களட்ெழ ஋ன்஧து எ஬ழ / எ஭ிக்களட்ெழ ககளப்ன௃கல஭ இலணனப் 

஧க்கத்தழன் என௉ ஧குதழனளக யமங்குயலத கு஫ழக்கழ஫து. 
 உ஬யித்தழலபனில் யல஬ப்஧க்கம் கதளன்றும் க஧ளது, இவ்யலக எ஬ழ/ 

எ஭ிக்களட்ெழ ககளப்ன௃கள் இனங்கும். 
4. <input> ஒட்டின் ஧னன் னாது? 

 <input> எட்லடப் ஧னன்஧டுத்தழ ப஧ன௉ம்஧ள஬ள஦ ஧டிய உறுப்ன௃கல஭ 
உன௉யளக்க஬ளம்.  

 பயறுலந எட்டள஦ <input> எட்டில஦ப் ஧னன்஧டுத்தழ உலபப்ப஧ட்டி, கபடிகனள 
ப஧ளத்தளன்கள் க஧ளன்஫ ஧ல்கயறு ஧டிய உறுப்ன௃கல஭ உன௉யளக்க஬ளம். 

5. கீழ்யரிப்஧ட்டினல் த஧ட்டினில் உறுப்புக஭ின் ஧ட்டினல஬க் கு஫ிப்஧ிை எந்த 
ஒட்டுப் ஧னன்஧டுகி஫து? 
 HTML ஆயணத்தழல் <option> எட்லடப் ஧னன்஧டுத்தழ கவழ்யிரிப்஧ட்டினல் 

ப஧ட்டினில் உறுப்ன௃க஭ின் ஧ட்டினல஬க் கு஫ழப்஧ிட஬ளம். 
6. <textarea> ஒட்டிற்கு த஧ரும்஧ான்லநனாகத் மதலயப்஧டும் ஧ண்புக்கூறுகள் 

னாலய? 
<Textarea> ஒட்டின் நிக ப௃க்கினநா஦ ஧ண்புக்கூறுகள்: 
 Name ” உறுப்ன௃க்குப் ப஧னலப யலபனறுக்கப் ஧னன்஧டுகழ஫து. 
 Rows ” text area உறுப்஧ில் யரிலெக஭ின் ஋ண்ணிக்லகலனக் கு஫ழப்஧ிடுகழ஫து. 
 Cols ” text area உறுப்஧ில் ப஥டுயரிலெக஭ின் ஋ண்ணிக்லகலனக் கு஫ழப்஧ிடுகழ஫து. 

 
3 நதிப்த஧ண் யி஦ாக்கள்: 

1. அதிக அ஭யில் ஧னன்஧டுத்தும் ஥ிமற்஧ை யடியங்கல஭ப் ஧ற்஫ி சிறு கு஫ிப்பு 
யலபக. 
 GIF (Graphical Interchange Format) : அலெவுப்஧டங்கள் உன௉யலநக்க இந்த ன௅ல஫ 

ப஧ன௉ந஭யில் ஧னன்஧ளட்டில் உள்஭து.  
 JPEG (Joint Photographic Experts Group): JPEG ஋ல்஬ள உ஬யிக஭ிலும் 

பெனல்஧டக்கூடின, நழகவும் ன௃கழ்ப஧ற்஫ ஧டியநளகும்.  
 PNG (Portable Network Graphics): GIF ன௅ல஫க்கு நளற்஫ளக PNG 

ன௅ல஫யடியலநக்கப்஧ட்டது. ஋ல்஬ளஉ஬யிக஭ிலும் பெனல்஧டக்கூடினலய. 
 SVG (Scalable Vector Graphics): SVG, இலணனத்தழற்களக யடியலநக்கப்஧ட்ட 

யலபகல஬ யடியம் ஆகும்.  
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2. ஒரு HTML ஆயணத்தில், ஒரு உலபப் ஧குதிலன எவ்யாறு ஥கர்த்த஬ாம்? 
 என௉ HTML ஆயணத்தழல் , உலப அல்஬து ஥ழமற்஧டத்லதக் கழலடநட்டநளககயள, 

பெங்குத்தளககயள <marquee> எட்டில஦ப் ஧னன்஧டுத்தழ உன௉஭ச் பெய்ன஬ளம். 
இந்த யெதழ, யல஬ப்஧க்கத்லதக் கயன௉ம் யலகனில் உன௉யலநக்க 
஧னன்஧டுகழ஫து.  

3. <form> ஒட்டுைன் ஧னன்஧டுத்தப்஧டும் ப௃க்கின ஧ண்புக்கூறுகல஭ யியரி. 
<form> எட்டுடன் method நற்றும் action ஋ன்னும் ன௅க்கழனநள஦ ஧ண்ன௃க்கூறுகள் 
஧னன்஧டுத்தப்஧டுகழன்஫஦.  
 Method: method ஧ண்ன௃க்கூறு, ஧டிய உறுப்ன௃க஭ின் ப஧னர்கல௃ம், நதழப்ன௃கல௃ம் 

கெலயனகத்தழற்கு ஋வ்யளறு அனுப்஧ப்஧டும் ஋ன்கழ஫ யமழன௅ல஫லனக் 
கு஫ழப்஧ிடுகழன்஫஦.  

 Action: action ஧ண்ன௃க்கூறு, ஧டிய யியபங்கல஭ச் பென஬ளக்கும் 
கெலயனகத்தழலுள்஭ ஥ழபல் அல்஬து உலப ஥ழபல஬ கண்ட஫ழகழ஫து. ப஧ளது 
நுலமயி இலடன௅க ஥ழப஬ழன் ப஧னலப உணர்த்துகழ஫து.  

4. <input> ஒட்டின் type ஧ண்புக்கூ஫ின் ஧ல்மயறு நதிப்புகல஭ யி஭க்குக. 
type ஧ண்ன௃க்கூறு <input> எட்டின் யடியலநப்ல஧த் தீர்நள஦ிக்கழ஫து.  
 Text - உலபப்ப஧ட்டிலன உன௉யளக்குகழ஫து. 
 Password - உலபலன உள்஭டீு பெய்னேம் க஧ளது எவ்பயளன௉ ஋ழுத்தும் ஥ட்ெத்தழப 

கு஫ழனடீளக கதளன்றும். 
 Checkbox - ெழறு பெவ்யகப் ப஧ட்டினளகத் கதளன்றும். இந்த உறுப்ல஧க் பகளண்டு 

஧஬ கதர்வுகல஭த் கதர்ந்பதடுக்க஬ளம். 
 Radio Button - ஧ட்டின஬ழலுள்஭ ஧஬ கதர்வுக஭ில் என்று நட்டும் கதர்ந்பதடுக்க 

கபடிகனள ப஧ளத்தளன் உதவுகழ஫து. 
 Reset - என௉ ஧டியத்தழல் உள்஭ிட்ட ஧தழவுகல஭ அமழக்கப் ஧னன்஧டும் என௉ 

ெழ஫ப்ன௃ ப஧ளத்தள஦ளகும். 
 Submit - என௉ ஧டியத்தழல் உள்஭ிட்ட ஧தழவுகல஭ கெலயனகத்தழல் ெநர்ப்஧ிக்க 

஧னன்஧டுகழ஫து. 
 Button - இவ்யலக யலபகல஬ ப஧ளத்தளன் நீது கழ஭ிக்பெய்னேம் ப஧ளழுது 

அதனுடன் பதளடர்ன௃லடன கட்டல஭லன பெனல்஧டுத்துகழ஫து. 
5. <select> நற்றும் <option> ஒட்டுக஭ின் ஧ண்புக்கூறுகல஭ யியரி. 

 <Select> எட்டு: HTML ஆயணத்தழல் <select> எட்டில஦ப் ஧னன்஧டுத்தழ கவழ்யிரிப் 
஧ட்டினல் ப஧ட்டிலன உன௉யளக்க஬ளம். இது ஧ல்கயறு கதர்வுக஭ின் ஧ட்டினல஬ 
கவழ்யிரிப் ஧ட்டின஬ளக களண்஧ிக்கப் ஧னன்஧டுகழ஫து.  

<Select> எட்டின் ஧ண்ன௃க்கூறுகள்: 
 Name ” கெலயனகத்துக்கு அனுப்஧ப்஧டும் உறுப்ன௃க்குப் ப஧னலப அ஭ிக்கழ஫து. 
 Size ” கவழ்யிரிப் ஧ட்டினல் ப஧ட்டினின் ஧ளணிலனத் தீர்நள஦ிக்கழ஫து  
 Multiple ” ஧ன஦ர் ஧஬ நதழப்ன௃கல஭த் கதர்ந்பதடுக்க அனுநதழக்கும். 
 <option> எட்டு: HTML ஆயணத்தழல் <option> எட்லடப் ஧னன்஧டுத்தழ 

கவழ்யிரிப்஧ட்டினல் ப஧ட்டினில் உறுப்ன௃க஭ின் ஧ட்டினல஬க் கு஫ழப்஧ிட஬ளம். 
<Option> எட்டின் ஧ண்ன௃க்கூறுகள் 
 Selected ” ன௅ன்஦ினல்஧ள஦ கதர்ந்பதடுத்தல஬ச் சுட்டிக்களட்டுகழ஫து. 
 Value ” கெலயனகத்துக்கு ெநர்ப்஧ிக்கப்஧ட கயண்டின நதழப்ன௃. 
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஧ாைம் 13. CSS – ததாைரும் ஧ணி தாள்கள் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. CSS ன் யிரியளக்கம் 
(அ) Cascading Style Schools   (ஆ) Cascading Style Scheme 
(இ) Cascading Style Sheets   (ஈ) Cascading Style Shares 

2. ஧ின்யன௉ய஦யற்றுள் ஋து ஧க்க஥ழல஬ ஧ளணி? 
(அ) <Page>   (ஆ) <Style>   (இ) <Link>   (ஈ) <H> 

3. CSS ”லன ஧ின்யன௉நளறு அலமக்க஬ளம்: 
(அ) Sitewide Style Sheets   (ஆ) Internal Style Sheets 
(இ) Inline Style Sheets   (ஈ) Internal Inline Sheets 

4. CSS ககளப்஧ின் ஥ீட்டிப்ன௃ னளது? 
(அ) .ssc   ஆ) .css   (இ) .csc   (ஈ) .htm 

5. கதர்யி ஋ன்஫ளல் ஋ன்஦? 
(அ) ஧ண்ன௃   (ஆ) நதழப்ன௃   (இ) HTML ஒட்டு   (ஈ) ப஧னர் 

6. CSS ” ன் அ஫ழயிப்ன௃ பதளகுதழ ஋ந்த கு஫ழனளல் சூமப்஧ட்டுள்஭து? 
(அ) ( )   (ஆ) [ ]   (இ) { }   (ஈ) <> 

7. அ஫ழயிப்ன௃ இந்த ன௃ள்஭ினளல் ன௅டிக்கப்஧டுகழ஫து. 
(அ) :    ஆ) ;    (இ) .    (ஈ) , 

8. உலபலன தடிப்஧ளக அலநக்க ஧னன்஧டும் ஧ண்ன௃ ஋து? 
(அ) Font-Style   (ஆ) Font-Weight  (இ) Font-Property   (ஈ) Font-Bold 

9. கெர்க்கப்஧ட்ட உலபலன கு஫ழப்ன௃லப ஋ன்று ஋து உணர்த்துகழ஫து? 
(அ) /* */   (ஆ) !* *!   (இ) <* *>   (ஈ) \* *\ 

10. கவழ்கண்டயற்றுள் ஋தழல் CSS ெரினளக ஋ழுதப்஧ட்டுள்஭து? 
(அ) p{color:red; text-align:center};   (ஆ) p {color:red; text-align:center} 
(இ) p {color:red; text-align:center;}   (ஈ) p (color:red;text-align:center;) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 61 

 

2 நதிப்த஧ண் யி஦ாக்கள்: 
1. <style> ஒட்டின் ஧னன் னாது? 

 ஆயணம் ன௅ழுயதும் எகப ெவபளகப் ஧னன்஧டுத்த ஧ளணி (<style>) எட்டு 
஧னன்஧டுகழ஫து. 

  யல஬ ஆயணத்தழல் என௉ கு஫ழப்஧ிட்ட எட்டு ஋ங்பகல்஬ளம் இடம் ப஧ற்றுள்஭கதள 
அங்பகல்஬ளம் எட்டின் ன௅ன்஦ினல்஧ள஦ ஧ண்஧ினல்ன௃கல஭ நளற்஫ழ அலநக்கப் 
<style>  எட்டு ஧னன்஧டுகழ஫து. 

2. CSS என்஫ால் என்஦? 
 CSS - Cascading Style Sheets (பதளடன௉ம் ஧ளணி தளள்கள்)  த஭஧பப்ன௃ அல்஬து 

பய஭ி஥ழல஬ ஧ளணி தளள்கள் ஋஦வும் அலமக்கப்஧டுகழ஫து.  
 இது HTML - ல் ஏர் ஆயணத்தழன் யடியலநப்ல஧ யியரிக்கழ஫து.  

3. CSS-லன HTML உைன் இலணக்கும் த஧ாது யடியத்லத எழுதுக. 
 CSS ககளப்ல஧ HTML உடன் இலணக்க <link> எட்டு ஧னன்஧டுத்தப்஧டுகழ஫து.  
<Link> ஒட்டின் த஧ாது யடியம்: 

<Link rel = “stylesheet” type = “text/css” href = CSS_File_Name_with_Extension> 

4. உள்஭லந஧ாங்கு என்஫ால் என்஦? 
 என௉ கு஫ழப்஧ிட்ட எட்டின் ஧ளணிலன என௉ HTML ஆயணத்தழன் ஋ந்த என௉ 

இடத்தழலும் யலபனறுக்கன௅டினேம். இதற்கு உள்஭லந஧ளணி (inline Style) ஋ன்று 
ப஧னர். 

5. CSS அ஫ியிப்஧ின் த஧ாது யடியத்லத எழுதுக. 
CSS அ஫ியிப்஧ின் த஧ாது யடியம்: 

கதர்யி { அ஫ழயித்தல் }  
 கதர்யி (Selector) ஋ன்஧து ஧ளணிகல஭ இடுயதற்கள஦ HTML எட்டில஦க் கு஫ழக்கழ஫து.  
 அ஫ழயித்தல் ஋ன்஧து ஧ண்ன௃கள் நற்றும் நதழப்ன௃கல஭க் பகளண்ட கு஫ழன௅ல஫த் 

பதளகுதழலனக் கு஫ழக்கழ஫து. இது ப஥஫ழவு அலடப்ன௃க்கு஫ழக்குள் ({ }) 
பகளடுக்கப்஧டுகழ஫து.  

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. CSS ஧னன்஧டுத்துயதன் ஥ன்லநகள் னாலய? 

 ஧பாநரிப்புத்தி஫ன் (Maintainability): த஦ிக் ககளப்ன௃க஭ளகச் கெநழக்கப்஧டுயதளல் 
யல஬ப்஧க்கத்தழன் ஧ளணி நற்றும் கதளற்஫ம் இனங்கு ஥ழல஬னில் நளற்஫ப்஧ட்டு, 
குல஫ந்த ன௅னற்ெழனில் ஧பளநரிக்கப்஧டுகழ஫து. 

 நறு஧னன்தி஫ன் (Reusability): HTML ஧க்கங்க஭ில் தழன௉ம்஧ தழன௉ம்஧ ஧னன்஧டுகழ஫து. 
 புரிந்து தகாள்ல௃ம் தி஫ன் (Easy to understand): ஥ல்஬ன௅ல஫னில் 

யலபனறுக்கப்஧ட்டுள்஭தளல் ஋஭ிதழல் ன௃ரிந்து பகளள்஭ ன௅டிகழ஫து.  
2. CSS யிதிப௃ல஫கல஭ சுருக்கநாக எழுதுக. 

 CSS ஧ளணி யலபனறுப்஧ின் இபண்டு ன௅தன்லநப் ஧குதழகள் கதர்யி நற்றும் 
அ஫ழயித்தல் ஆகும். 

 கதர்யி (Selector) ஋ன்஧து ஧ளணிகல஭ இடுயதற்கள஦ HTML எட்டில஦க் கு஫ழக்கழ஫து.  
 அ஫ழயித்தல் ஋ன்஧து ஧ளணி யலபனறுப்ல஧க் பகளண்ட கு஫ழன௅ல஫த் பதளகுதழலனக் 

கு஫ழக்கழ஫து. இது ப஥஫ழவு அலடப்ன௃க்கு஫ழக்குள் ({ }) பகளடுக்கப்஧டுகழ஫து.  
 என௉ கதர்யிக்கு ஋த்தல஦ ஧ண்ன௃கல஭ கயண்டுநள஦ளலும் கெர்க்க஬ளம். அலய 

அலபப்ன௃ள்஭ினளல் ஧ிரிக்கப்஧டுகழ஫து.  
 ஧ண்஧ின் ப஧னன௉ம் அதன் நதழப்ன௃ம் ன௅க்களற்ன௃ள்஭ினளல் (:) ஧ிரிக்கப்஧டுகழ஫து.  
 எவ்பயளன௉ யலபனறுப்ன௃ம் அலபப்ன௃ள்஭ினளல் (;) ன௅டிக்கப்஧ட கயண்டும். 
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3. <p> ஒட்டின் உலப ஥ி஫ம் நற்றும் இலசவு யலபனறுப்஧ிற்கா஦ CSS மகாப்஧ில஦ 
எழுதுக. 

P  
{  
color:pink;  
Text-align : center; 
} 

கநற்கண்ட கு஫ழன௅ல஫லன .css ஋ன்஫ ஥ீட்டிப்ன௃டன் கெநழக்க கயண்டும். 
4. <h1> ஒட்டிற்கா஦ எழுத்து யலக, ஧ாணி நற்றும் அ஭வு யலபனறுப்஧தற்கா஦ 

CSS மகாப்஧ில஦ எழுதுக. 
h1 
{  
font-family : "Comic Sans MS";  
Font-weight : Bold;  
border:2px solid blue; 
} 

கநற்கண்ட கு஫ழன௅ல஫லன Mystyle.css ஋ன்று கெநழக்க஬ளம் 
 
5 நதிப்த஧ண் யி஦ாக்கள்: 

1. கீழ்க்கண்ை ஧த்திலன தகாடுக்கப்஧ட்ை CSS யி஭க்கத்துைன் திலபனிை HTML 
ஆயணத்லத எழுதுக:  
“ Font Name : Cooper Black  

• Style : Bold Italics  

• Color : Blue  

“The State Institute of Education (SIE) was established in 1965 to provide for systematic study of problems 

relating to School Education under the administration of Directorate of School Education.” 

File1.CSS 

P 

{ 

font-family: ”cooper Black”; 

font-weight : Bold; 

font-style:Italic; 

color:Blue; 

} 

File1.html 

<html> 

<head> 

<link rel=”style sheet” type=text/css href= “File1.css”> 

</head> 

<body> 

<h1> SIE </h1> 

<p> “The State Instittute of Education (SIE) was established in 1965 to 

provide for systematic study of problems relating to school education under the 

administration of Directorate of School Education” </p> 

</body> 

</html> 
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2. CSS-ல் உள்஭ எழுத்து நற்றும் உலப உறுப்பு ஧ண்புகல஭ அதன் 
நதிப்புகம஭ாடு ஧ட்டின஬ிட்டு யி஭க்கவும். 

யடிவூட்டல் ஧ண்ன௃கள் நதழப்ன௃கள் ஋.கள. 
உலப஥ழ஫ம் color Predefined_Color_Na

me 
P  
{  
color:pink;  
} 

உலபஇலெவு Text-align Center / Left / Right / 
Justify 

P 
{  
Text-align : center; 
} 

஋ழுத்து யலக Font-family Font_name P 
{  
Font-family : “Times New Roman”; 
} 

஋ழுத்துப்஧ளணி Font-style Normal / Italic P 
{  
Font-family : “Times New Roman”;  
Font-style : Italic; 
} 

஋ழுத்துப் 
஧ளணி (தடித்த)  

Font-weight Normal / Bold P 
{  
Font-family : “Times New Roman”;  
Font-style : Italic;  
Font-weight : bold; 
} 

஋ழுத்து அ஭வு Font-size Size in pixels P 
{  
Font-family : “Times New Roman”;  
Font-style : Italic;  
Font-size : 14px; 
} 
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஧ாைம் 14. ஛ாயாஸ்கிரிப்ட்டின் அ஫ிப௃கம் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. யல஬ அலநப்ல஧ உன௉யளக்கு஧யர்கள் அலத யடியலநக்க, ெரி஧ளர்க்க நற்றும் 
இலணன பெனல்஧ளடுகல஭ பெனல்஧டுத்த உதவும் ப஧ளதுயள஦ scripting? 
அ) C   ஆ) C++   இ) Java   ஈ) JavaScript 

2. CGI –ன் யிரியளக்கம் 
அ) common Gateway Interface   ஆ) Complex Gateway Information 
இ) Common Gateway Information   ஈ) Complex Gateway Interface 

3. ஜளயளஸ்கழரிப்ட் ஥ழப஬ளக்க பநளமழ ஧னன்஧டுத்தழ இலத உன௉யளக்க஬ளம் 
அ) நாறும் யல஬ப்஧க்கம்   ஆ) ெளப஭ம் 
இ) யல஬ப்஧க்கம்    ஈ) ன௅தல் ஧க்கம் 

4. நளறும் யல஬ப்஧க்கம் கெலயனகத்தழல் ஋லத கெநழக்க உதவும் 
அ) மயல஬  ஆ) யமழத்தடம்  இ) க஧ளக்குயபத்து   ஈ) ஧ளலத 

5. ஧ன஦ர் உள்஭டீு பெய்த தபவு கெலயனகத்தழற்கு அனுப்ன௃ம் ன௅ன் 
ெரி஧ளர்க்கப்஧டுயலத இவ்யளறு அலமப்஧ர் 
அ) மசலயனக ம஧ாக்குயபத்து   ஆ) நளறும் யல஬ப்஧க்கம் 
இ) கெலயனக யமழத்தடம்   ஈ) யல஬ கெலயனகம் 

6. ஋ந்த கூற்ல஫ ஧னன்஧டுத்தழ ஜளயளஸ்கழரிப்ட் - லன பெனல்஧டுத்த஬ளம்? 
அ) <head>   ஆ) <Java>   இ) <Script>   ஈ) <text> 

7. யிரியளக்கம் (DHTML) 
அ) Distance Hyper Text Markup language  ஆ) Dynamic Hyper Text Markup language 
இ) Distance High Text Markup language  ஈ) Dynamic High Text Markup language 

8. <script> எட்டில் ஋த்தல஦ ஧ண்ன௃கூறுகள் உள்஭து? 
அ) 2   ஆ) 3   இ) 4   ஈ) 5 

9. ஋ந்த ஧ண்ன௃கூற்ல஫ ஧னன்஧டுத்தழ scripting பநளமழ நற்றும் அந்த நதழப்ல஧ 
“Text/JavaScript” அனுப்஧ கயண்டும் ஋ன்று உணர்த்துகழன்஫து? 
அ) Language   ஆ) Text   இ) Type   ஈ) Body 

10. உ஬யினில் ககளப்ல஧ நீண்டும் ஌ற்஫ம் பெய்ன ஋ந்த குறுக்குயமழ ெளயிலன 
஧னன்஧டுத்த கயண்டும் 
அ) F2   ஆ) F3   இ) F4   ஈ) F5 

11. ஋தன் இலடகன பகளடுக்கப்஧டும் பயற்஫ழடத்லத ஜளயளஸ்கழரிப்ட் ஥ழபளகரிக்கும். 
அ) கட்டல஭கள்  ஆ) ஸ்கழரிப்ட்  இ) யில்ல஬கள்  ஈ) உலப 

12. ஥ழப஬ழல் க஥படினளக நள஫ழக்கு பகளடுக்கப்஧டும் தபவு நதழப்ல஧ இத஦ளல் 
பகளடுக்க஬ளம் 
அ) நடக்கு   ஆ) ஥ில஬ப௅ரு  இ) கூற்று   ஈ) உலப 

13. இயற்றுள் ஋து ஧ன஦ன௉க்கு ஋ச்ெரிக்லக பெய்தழலன பகளடுக்க ப஧ன௉ம்஧ளலும் 
஧னன்஧டுகழ஫து? 
அ) Alert உலபனாைல் த஧ட்டி   ஆ) Confirm உலபனளடல் ப஧ட்டி 
இ) Prompt உலபனளடல் ப஧ட்டி   ஈ) ஋துவுநழல்ல஬ 

14. கவகம உள்஭ ஥ழபல் பதளகுதழனில் நள஫ழ x-ன் நதழப்ன௃ Var x = 250 + 2 – 200; 
அ) 50   ஆ) 52   இ) 48   ஈ) 42 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. நா஫ிக஭ின் யலபதனல்ல஬ என்஫ால் என்஦? அதன் யலககள் னாலய? 

 என௉ நள஫ழனின் யலபபனல்ல஬ ஋ன்஧து அது ஋ந்த னெ஬க்கு஫ழன௅ல஫னில் 
யலபனறுக்கப்஧ட்டுள்஭கதள அந்த கு஫ழன௅ல஫னின் யளழ்஥ளள் யலப இன௉க்கும்.  

யலககள்:1. ன௅ழுத஭ளயின யலபபனல்ல஬ 2. .உள்஭லந யலபபனல்ல஬. 
2. ஛ாயாஸ்கிரிப்ட்டில் இ஦நாற்஫ம் என்஫ால் என்஦? 

 என௉ தபயி஦ யலகனி஬ழன௉ந்து கயப஫ளன௉ தபயி஦ யலகனளக நளற்஫ழனலநக்கும் 
பெனல்஧ளட்லட இ஦நளற்஫ம் ஋ன்஧ர். 

 ஜளயளஸ்கழரிப்ட்-ல் இன௉ யலகனள஦ இ஦நளற்஫ங்கள் உள்஭து.  
 உள்ல௃ல஫ இ஦நளற்஫ம் *   பய஭ிப்஧லட இ஦நளற்஫ம் 

3. ஛ாயாஸ்கிரிப்ட்-ல் எத்தல஦ ஥ில஬ப௅றுக்கள் உள்஭஦? அயற்஫ின் யலககல஭ 
எழுதுக. 
 னெ஬க்கு஫ழன௅ல஫னில் நளற்஫ ன௅டினளத நதழப்ல஧ ஌ற்கும் நள஫ழலன ஥ழல஬னேன௉ 

஋ன்஧ர். ஜளயளஸ்கழரிப்ட்-ல் 5 யலகனள஦ ஥ழல஬னேறுக்கள் உள்஭஦  
யலககள்: ன௅ழு ஋ண், நழதப்ன௃ ன௃ள்஭ி, கு஫ழனேறு, ெப நற்றும் ன௄஬ழனன் க஧ளன்஫லய. 

4. ஥ி஧ந்தல஦ச் தசனற்கு஫ி என்஫ால் என்஦? தகுந்த எடுத்துக்காட்டு தருக. 
 ஜளயளஸ்கழரிப்ட் - இல் உள்஭ ?:  பெனற்கு஫ழ ஥ழ஧ந்தல஦ பெனற்கு஫ழ ஋஦ப்஧டும்.  

 ஥ழ஧ந்தல஦ பெனற்கு஫ழ னென்று பெனற்க஬ற்஧ிகல஭ ஌ற்கும். அத஦ளல் இது 
ன௅ம்நச்பெனற்கு஫ழ ஋ன்றும் அலமக்கப்஧டும்.  

கட்ைல஭ அலநப்பு: var variablename=(condition) ? value1 : value2;  
எ.கா: var result=(10>15) ?100 :150; 

5. ஛ாயாஸ்கிரிப்ட்-ல் கு஫ிப்புலபகள் என்஫ால் என்஦? 
 கு஫ழப்ன௃லபகள் , ஥ழபல஬ உன௉யளக்கு஧யர்கல௃க்கும், நற்஫யர்கல௃க்கும் ஥ழபல஬ 

ன௃ரிந்து பகளள்஭ உதவும். 
 ஜளயளஸ்கழரிப்ட்-ல் இபண்டு யலகனள஦ கு஫ழப்ன௃லபகள் உள்஭஦. 

 ஒரு யரி கு஫ிப்புலபகள் ” ‘//’ ஋ன்஫ கு஫ழனேடன் பதளடங்கும் கு஫ழப்ன௃லபகள் என௉ 
யரி கு஫ழப்ன௃லபகள் ஆகும். 

 ஧஬ யரி கு஫ிப்புலபகள் ” ’/*’ ஋ன்஫ கு஫ழக஭ில் பதளடங்கழ ’*/’ ஋ன்஫ கு஫ழக஭ில் 
ன௅டினேம் கு஫ழப்ன௃லபகள் ஧஬ யரி கு஫ழப்ன௃லபகள் ஆகும். 

6. தசனற்கு஫ி யலககள் ஧ற்஫ி கு஫ிப்பு யலபக. 
 கணித பெனற்கு஫ழகள் (Arithmetic Operators) 
 நதழப்஧ின௉த்தல் பெனற்கு஫ழகள் (Assignment Operators)  
 எப்஧டீ்டுச் பெனற்கு஫ழகள் (Comparison Operators) 
 தன௉க்க பெனற்கு஫ழகள் (Logical Operators) 
 ெபம் பெனற்கு஫ழகள் (String Operators) 
 நழகுப்ன௃ நற்றும் குல஫ப்ன௃ பெனற்கு஫ழகள் (Increment and Decrement Operators) 
 என௉ந+ நற்றும் - பெனற்கு஫ழ 
 typeof பெனற்கு஫ழ 
 ஥ழ஧ந்தல஦ பெனற்கு஫ழ (?:) (Conditional Operator) 

7. ஛ாயாஸ்கிரிப்ட்டில் நா஫ினின் ஧ங்கு ஧ற்஫ி எழுதுக. 
 நள஫ழகள் ஋ன்஧லய நதழப்ன௃கல஭த் தளங்கழனேள்஭ ஥ழல஦யக இன௉ப்஧ிடத்லதக் 

கு஫ழக்கும்.  
 நள஫ழ ஋ன்஧து நதழப்஧ிற்கள஦ கு஫ழனடீ்டு ப஧னர்.  
 Var ஋ன்஫ ெழ஫ப்ன௃ச் பெளல்ல஬ ஧னன்஧டுத்தழ ஜளயளஸ்கழரிப்ட்-ல் நள஫ழகள் 

அ஫ழயிக்கப்஧டும்.  
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8. Prompt உலபனாைல் த஧ட்டினின் ஧னன்கள் னாது? 
 கநல் நீட்ன௃  உலபப்ப஧ட்டி னெ஬ம் ஧ன஦ர் உள்஭டீு பெய்யதற்கள஦ தகயல஬க் 

பகளடுக்க Prompt உலபனளடல் ப஧ட்டி ஧னன்஧டுகழ஫து. 
 Prompt() பெனல்ன௅ல஫லன ஧னன்஧டுத்தழ Prompt உலபனளடல் ப஧ட்டினில் 

பெய்தழலன பதரியிக்க இபண்டு அ஭ன௃ன௉க்கள் உள்஭஦. 
a. உலபனளடல் ப஧ட்டினில் கதளன்றும் யெதழ. 
b. உலபப்ப஧ட்டினில் கதளன்றும் பகளடள஥ழல஬ ெபம். 

 
3 நதிப்த஧ண் யி஦ாக்கள்: 

1. ஛ாயாஸ்கிரிப்ட்டில் உள்஭ அடிப்஧லை தபவு யலககள் ஧ற்஫ி சிறு கு஫ிப்பு 
எழுதுக. 
 ெபங்கள், ஋ண்கள் நற்றும் ன௄஬ழனன் ஋ன்஧லய ஜளயளஸ்கழரிப்டின் அடிப்஧லட 

தபயி஦ங்க஭ளகும்.  
 என௉ சபம் ஋ன்஧து கு஫ழனேன௉க்க஭ின் யரிலெனளகும், கநலும் ெப 

஥ழல஬னேன௉ ஋ன்஧து இபட்லட கநற்ககளள் கு஫ழகல௃க்குள் தபப்஧டும் 
கு஫ழனேன௉க்கல஭ கு஫ழக்கும்.  

 ன௅ழு ஋ண் அல்஬து நழதப்ன௃ப் ன௃ள்஭ி ஋ண்க஭ின் நதழப்ல஧ எண்கள் 
தபயி஦ம் ஌ற்கும்.  

 பநய் அல்஬து ப஧ளய் ஋ன்஫ இபண்டில் ஌கதனும் என௉ நதழப்ல஧ 
பூ஬ினன் ஌ற்கும்  

2. சபம் தசனற்கு஫ி ஧ற்஫ி கு஫ிப்பு யலபக. 
 ஜளயளஸ்கழரிப்ட்-ன் என௉ உள்஭லநந்த அம்ெநள஦து ெபங்கல஭ இலணப்஧து 

ஆகும். 
 + பெனற்கு஫ழ ஋ண்கல஭ கூட்டுயது நட்டுநல்஬ளது ெபங்கல஭ இலணக்கவும் 

உதவுகழ஫து. 
 பெனக஬ற்஧ிகள் ெபங்கள் ஋஦ில் + பெனற்கு஫ழ ெபங்கல஭ இலணக்கும் 

பெனல஬ பெய்னேம்  
஋.கள: <script language= "javascript"  type= "text /javascript">  

var String1 = "Java";  

var String2 = "Script";  

var String3=String1+String2;  
</script> 
 

3. <Script> ஒட்டு ஧ற்஫ி எழுதுக. 
 <script>... </script> எட்டுகல஭ ஧னன்஧டுத்தழ ஜளயளஸ்கழரிப்ட் கூற்றுகல஭க் 

பகளண்டு ஜளயளஸ்கழரிப்ட் ”லன ஥லடன௅ல஫ப்஧டுத்த஬ளம் 
த஧ாதுயடியம்: <script language="javascript" type="text/javascript">  

JavaScript code  
</script> 

<script> எட்டு இபண்டு ஧ண்ன௃கூறுகல஭ ஌ற்கும். 
 Language ” இந்த ஧ண்ன௃ ஸ்கழரிப்டிங் பநளமழலன பதரியிக்கழ஫து. ப஧ளதுயளக, 

இதன் நதழப்ன௃ ஜளயளஸ்கழரிப்ட் ஆக இன௉க்கும்.  
 Type – இந்த ஧ண்ன௃ ஸ்கழரிப்ட்டிங் பநளமழலன சுட்டிக்களட்ட ஧னன்஧டுகழ஫து 

இதன் நதழப்ன௃ ஋ப்ப஧ளழுதும் "text/javascript" ஋ன்஫ழன௉க்ககயண்டும். 
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4. தருக்க தசனற்கு஫ிக஭ின் ஧னன்கள் னாது? 
 தன௉க்க பெனற்கு஫ழகள் தன௉க்க(ன௄஬ழனன்) பெனல்஧ளடுகல஭ச் பெய்னேம்.  
 தன௉க்க பெனற்கு஫ழகள் ன௄஬ழனன் நதழப்ன௃கல஭ இலணக்கும் அல்஬து 

தல஬கவமளக நளற்றும்.  
 தன௉க்க பெனற்கு஫ழக஭ள஦ && (AND), || (OR) நற்றும் ! (NOT) ஆகழனயற்ல஫க் 

பகளண்டு ஧஬ ெழக்க஬ள஦ கட்டல஭கல஭ உன௉யளக்க஬ளம். 
 && - இபண்டும் பநய்பன஦ில் பநய் ஋ன்஫ நதழப்ல஧ தன௉ம். 
 || - இபண்டில் ஌கதனும் என்று பநய் அல்஬து இபண்டும் பநய்பன஦ில் 

இது பநய் ஋ன்஫ நதழப்ல஧ தன௉ம். 
 ! ” பநய் ஋஦ில் ப஧ளய் ஋ன்஫ நதழப்ல஧னேம், ப஧ளய் ஋஦ில் பநய் ஋ன்஫ 

நதழப்ல஧னேம் தழன௉ப்஧ி அனுப்ன௃ம். 
5. நிகுப்பு நற்றும் குல஫ப்பு தசனற்கு஫ிக஭ின் யித்தினாசத்லத எழுதுக.  

நிகுப்புச் தசனற்கு஫ி குல஫ப்புச் தசனற்கு஫ி 
‘++’ பெனற்கு஫ழ நழகுப்ன௃ பெனற்கு஫ழ 
ஆகும். 

’„’ பெனற்கு஫ழ குல஫ப்ன௃ பெனற்கு஫ழ 
ஆகும். 

இந்த பெனற்கு஫ழ, பகளடுக்கப்஧ட்டுள்஭ 
஋ண்ணின் நதழப்ல஧ 1 நழகுத்து, 
நழகுக்கப்஧ட்ட நதழப்ல஧ நள஫ழனில் 
நதழப்஧ின௉த்தும். 

இந்த பெனற்கு஫ழ, பெனக஬ற்஧ினின் 
நதழப்ல஧ 1 ஆக குல஫த்து, அந்த 
நதழப்ல஧ பெனக஬ற்஧ினில் 
நதழப்஧ின௉த்தும் 

 
5 நதிப்த஧ண் யி஦ாக்கள்: 

1. ஛ாயாஸ்கிரிப்ட்டில் உள்஭ மநல்நீட்பு உலபனாைல் த஧ட்டிகள் ஧ற்஫ி யிரியாக 
எழுதுக. 
 ஜளயளஸ்கழரிப்ட்-ல் னென்று யலகனள஦ கநல்நீட்ன௃ ப஧ட்டிகள் உள்஭து. அலய:  

 Alert உலபனளடல் ப஧ட்டி,  
 confirm உலபனளடல் ப஧ட்டி நற்றும்  
 Prompt உலபனளடல் ப஧ட்டி. 

 Alert உலபனளடல் ப஧ட்டி (Alert Dialog Box): ஧ன஦ன௉க்கு ஋ச்ெரிக்லக பெய்தழ 
பகளடுப்஧தற்கு Alert உலபனளடல் ப஧ட்டி ஧னன்஧டும்.  
கட்ைல஭ அலநப்பு: Alert(‚Message‛); 
எ.கா:    alert(‚Name is compulsory entry‛); 

 confirm உலபனளடல் ப஧ட்டி: ஌கதனும் என௉ யின௉ப்஧த்தழற்கு ஧ன஦ரின் எப்ன௃தல் 
ப஧஫ confirm  உலபனளடல் ப஧ட்டி ஧னன்஧டுகழ஫து. 
கட்ைல஭ அலநப்பு:  confirm(‚message‛); 
எகா:    confirm(‚Hai Do you want to continue:‛);  

 Prompt உலபனளடல் ப஧ட்டி: கநல் நீட்ன௃  உலபப்ப஧ட்டி னெ஬ம் ஧ன஦ர் உள்஭டீு 
பெய்யதற்கள஦ தகயல஬க் பகளடுக்க Prompt உலபனளடல் ப஧ட்டி 
஧னன்஧டுகழ஫து. 
கட்ைல஭ அலநப்பு:  Prompt(“Message”,”defaultValue”);  
எ.கா:    prompt(‚Enter Your Name:‛,‛Name‛); 
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2. கணித தசனற்கு஫ி ஧ற்஫ி தகுந்த எடுத்துக்காட்டுைன் யிரியாக எழுதுக. 
1. கூட்டல் (+), கமழத்தல் (”), ப஧ன௉க்கல் (*), யகுத்தல் (/), நற்றும் யகுநீதழ (%) க஧ளன்஫ 

அடிப்஧லட கணித பெனற்கு஫ழகள் ஋ல்஬ளயற்ல஫னேம் ஜளயளஸ்கழரிப்ட் ஆதரிக்கும். 
கணித பெனற்கு஫ழ ப஧ளன௉ள் ஋டுத்துக்களட்டு யில஭வு 

+ கூட்டல் var sum = 20 + 120 
 

Variable sum = 140 

- கமழத்தல் var diff = 20 ” 120 
 

Variable diff = 100 

* ப஧ன௉க்கல் var prod = 10 * 100 
 

Variable prod = 1000 

/ யகுத்தல் var res = 100/522 
 

Variable res = 5.22 

% யகுநீதழ var rem = 100 % 522 
 

Variable rem = 22 
(remainder) 
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஧ாைம் 15. ஛ாயாஸ்கிரிப்ட்-ல் உள்஭ கட்டுப்஧ாட்டு கட்ைலநப்பு 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. தற்க஧ளலதன கூற்஫ழ஬ழன௉ந்து நற்ப஫ளன௉ கூற்஫ழக்கு கட்டுப்஧ளட்லட நளற்஫ ஋ந்த 
஥ழ஧ந்தல஦ கூற்று ஧னன்஧டும்? 
அ) கில஭஧ிரிப்பு   ஆ) யரிலெப்஧டுத்தல் 
இ) நடக்கு    ஈ) பெனற்கு஫ழ 

2. if-else _____ கூற்஫ழக்கு நளற்஫ளக ஋ந்த கூற்ல஫ ஧னன்஧டுத்த஬ளம். 
(a) While   (b) If  (c) Else-if   (d) Switch 

3. ெரினள஦ கதர்லயக் கண்ட஫ழந்தவுடன் switch case கூற்஫ழ஬ழன௉ந்து பய஭ிகன஫ ஋ந்த 
கூற்று ஧னன்஧டும்? 
(a) Exit  (b) Default  (c) Case   (d) Break 

4. இயற்஫ழல் ஋து நடக்கு கூற்று அல்஬. 
(a) Switch  (b) While (c) Do-While   (d) For 

5. நடக்கழன் ஋ந்தப் ஧குதழ நடக்லக ஋த்தல஦ ன௅ல஫ இனக்க கயண்டும் ஋ன்஧லதத் 
தீர்நள஦ிக்கும்? 
அ) ன௅தல்  ஆ) இபண்ைாயது  இ) னென்஫ளயது  ஈ) இறுதழனள஦து 

6. இயற்றுள் ஋து கழல஭ப்஧ிரிப்ன௃ கூற்஫ளகும்? 
(a) Loop   (b) If-else  (c) Switch   (d) For 

7. கவகமனேள்஭ ஥ழபல் பதளகுதழனின் பய஭ினடீு ஋ன்஦? 
For (var n=0; n<10; n+1) 
{ 
if (n==3) 
{ 
break; 
} 
document write (n+"<br>"); 
} 

(a) 0 1 2   (b) 0 1 2 3  (c) 0 1 2 3 4   (d) 0, 1, 3 
8. கூற்ல஫ இனக்கும் ன௅ன் ஋ந்த நடக்கழல் ஥ழ஧ந்தல஦ இனக்கப்஧டும்? 

(a) While   (b) Do while  (c) Break   (d) Continue 
9. ஋ந்த கூற்று ககளலயனிலுள்஭ ஋ல்஬ள யில஭வுகல஭னேம் கெளதழக்கப் ஧னன்஧டும்? 

(a) While   (b) Do while  (c) Switch   (d) If 
10. இயற்றுள் ஋ந்த நடக்கு ஥ழ஧ந்தல஦லன இனக்கும் ன௅ன் என௉ ன௅ல஫கனனும் 

இனக்கப்஧டும்? 
(a) For  (b) While  (c) If   (d) Do while 

11. <script type = "text / javascript"> 

x = 6 + "3"; 
document write (x); 

<'script>  இதன் பய஭ினடீு ஋ன்஦? 
(a) 6   (b) 9  (c) 63   (d) Error 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஛ாயாஸ்கிரிப்ட்டில் உள்஭ ஧஬யலகனா஦ கட்டுப்஧ாட்டு கூற்றுகள் னாது? 

கட்டுப்஧ளட்டு கூற்றுகள் இன௉ யலகப்஧டும். 
 கழல஭ப்஧ிரிப்ன௃ (Branching)  *   நடக்கு (Looping) 

2. ஛ாயாஸ்கிரிப்ட்டில் ஥ி஧ந்தல஦ கூற்று என்஫ால் என்஦? 
 பகளடுக்கப்஧ட்டுள்஭ ஥ழ஧ந்தல஦ ககளலயனின் நதழப்ல஧ப் ப஧ளறுத்து என்க஫ள 

அல்஬து என்஫ழற்கு கநற்஧ட்ட கூற்றுகல஭ இனக்ககயள அல்஬து தயிர்க்ககயள 
஧னன்஧டும் கூற்றுகள் ஥ழ஧ந்தல஦ கூற்றுகள் ஋஦ப்ப்டும். 

3. ஛ாயாஸ்கிரிப்ட்டில் உள்஭ ஧ல்மயறு கில஭ப்஧ிரிப்பு கூற்றுகள் ஧ட்டின஬ிடுக. 
 ஜளயளஸ்கழரிப்ட்டில் ஧஬யிதநள஦ கழல஭ப்஧ிரிப்ன௃ கூற்றுகள் உள்஭஦. அலய,  

o if கூற்று *   if …else கூற்று *   else if கூற்று *   switch கூற்று 
4. Switch கூற்஫ின் கட்ைல஭ அலநப்ல஧ எழுதுக. 

கட்ைல஭ அலநப்ன௃: 
switch(expression)  
{ 

 case label1: statement 1; break;  

 case label2: statement 2; break;  

 case labeln; statement N; break;  

 default: statement;  

} 

5. break நற்றும் continue கூற்றுக஭ின் மயறு஧ாடுகல஭ எழுதுக. 
break கூற்று continue கூற்று 

break கூற்று நடக்கழ஬ழன௉ந்து 
கட்டுப்஧ளட்லட 
பய஭ிகனற்றும் 

continue கூற்று அது இடம்ப஧றும் ஧குதழக்கு கவழ் 
உள்஭ நடக்கழன் ஧குதழலன பெனல்஧டுத்தளநல் 
நடக்கழன் அடுத்த பெனல்஧ளட்லட இனக்கும். 

நடக்கு நற்றும் switch 
கூற்றுடன் ஧னன்஧டுத்த஬ளம். 

நடக்கழல் நட்டுகந ஧னன்஧டுத்த ன௅டினேம். 

 
3 நதிப்த஧ண் யி஦ாக்கள்: 

1. if கூற்று என்஫ால் என்஦. அதன் யலககல஭ எழுதுக. 
 ஜளயளஸ்கழரிப்ட்டில் if கூற்று ஋ன்஧து என௉ அடிப்஧லட கட்டுப்஧ளட்டு கூற்஫ளகும். 

இந்த கூற்று இன௉ யடியங்கல஭க் பகளண்டது.  
 ன௅தல் யடியம் பநய் கட்டல஭கல௃க்கு நட்டுகந உள்஭து.  
கட்ைல஭ அலநப்பு: if (condition)  

{  

True block;  
}  

 If கூற்஫ழன் இபண்டளயது யடியம் else உட்கூறுலய பகளண்டது. அதளயது ஥ழபல் 
஌கதனும் இபண்டு கழல஭ப்஧ிரிப்஧ில் என்ல஫ ப஧ளறுத்து இனங்கும். 

கட்ைல஭அலநப்பு: if (expression)  
{ 

Statement  if true ; 

}  

else  

{ 

statements if false; 

} 
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2. else-if கூற்஫ின் கட்ைல஭ அலநப்ல஧ எழுதுக. 
கட்ைல஭அலநப்பு:  

if (expression)  
{ 

Statement  1; 
}  

else if (expression 2)  
{ 

Statement  2; 
}  

else if (expression 3)  

{ 

else statement; 
} 

3. நைக்கு என்஫ால் என்஦? அதன் யலககள் னாது? 
 ஜளயளஸ்கழரிப்ட்டில் ஥ழப஬ழன் எகப ஧குதழலன ஧஬ன௅ல஫ ஧ல்கயறு நதழப்ன௃க஭ின் 

அடிப்஧லடனில் இனக்கழ஦ளல் அலத நடக்குகள் ஋ன்஧ர். ஜளயளஸ்கழரிப்ட் 
னென்று யலகனி஬ள஦ நடக்கு கூற்றுகல஭ ஆதரிக்கும். அலய: 

 for நடக்கு (for loop) 
 while நடக்கு (while loop) 
 do..while நடக்கு (do..while loop) 

4. while நற்றும் do.. while கூற்றுக஭ின் மயறு஧ாடுகல஭ எழுதுக. 
while  நைக்கு do..while நைக்கு 

while  நடக்கு, கூற்றுக஭ின் பதளகுப்ல஧ 
ககளலயனின் நதழப்ன௃ பநய்னளக உள்஭து 
யலப நீண்டும் நீண்டும் இனக்கும்.  
நடக்கழன் ககளலய நடக்கழன் 
பதளடக்கத்தழல் ெரி஧ளர்க்கப்஧டும். 

do..while நடக்கு while நடக்லக க஧ளன்று 
இனங்கும்,  
ஆ஦ளல் நடக்கழன் ககளலய நடக்கழன் 
இறுதழனில் ெரி஧ளர்க்கப்஧டும்.  
இத஦ளல் நடக்கழன் உடற்஧குதழ என௉ 
ன௅ல஫கனனும் இனக்கப்஧டும் 

இது நுலமவு கெளதழப்ன௃ நடக்கு ஆகும். இது பய஭ிகன஫ல் கெளதழப்ன௃ நடக்கு 
ஆகும். 

5. யனலத 20 என்று உள்஭டீு தசய்தால் கீமமப௅ள்஭ ஥ிபல் ஧குதி என்஦ தகயல஬ 
தய஭ினீடும்.  

if (age> = 18 )  
{  
alert ("you are eligible to get Driving licence"}  
}  
else  
alert ("you are not eligible to get driving licence");  
} 

 தய஭ினீடு:  you are eligible to get Driving licence 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. for நைக்லக ஒரு எடுத்துக்காட்டுைன் யி஭க்குக. 

 for நடக்கு ன௅ன் யலபனறுக்கப்஧ட்ட ஋ண்ணிக்லகனில் நீண்டும் நீண்டும் 
இனங்கும்.  
கட்ைல஭ அலநப்பு:  

for(initialization; condition; increment/decrement)  

{  

Body of the loop;  

}  
 for கட்டலநப்஧ில் னென்று ஧குதழகள் உள்஭஦. அலய ன௅க்களற்ன௃ள்஭ினளல் 

஧ிரிக்கப்஧ட்டின௉க்கும்.  
 நடக்கழன் ன௅தல் ஧குதழ நள஫ழக்கு பதளடக்க நதழப்஧ின௉த்தும், அந்த நள஫ழலன 

கட்டுப்஧ளட்டு நள஫ழ ஋ன்஧ர். 
 இபண்டளம் ஧குதழ என௉ ஥ழ஧ந்தல஦ கூற்஫ளகும். அது நடக்கு ஋த்தல஦ ன௅ல஫ 

இனக்கப்஧டும் ஋ன்று தீர்நள஦ிக்கும். 

 னென்஫ளம் ஧குதழ கட்டுப்஧ளட்டு நள஫ழனின் நதழப்ன௃ ஋வ்யளறு நளற்஫ப்஧டும் ஋ன்று 
தீர்நள஦ிக்கும் (நழகுக்க/ குல஫க்க) 

எ.கா: for( var n = 0; n <= 10; n++) 

{  

document.write(n+"  "); 

} 

     தய஭ினீடு: 1 2 3 4 5 6 7 8 9 10  
2. switch case கூற்ல஫ எடுத்துக்காட்டுைன் யி஭க்குக. 

 if..else கட்டலநப்஧ிற்கு நளற்஫ளக switch கூற்ல஫ ஜளயளஸ்கழரிப்ட் அ஭ிக்கழ஫து.  
 ககளலயனில் உள்஭ ஋ல்஬ள யில஭வுகல஭னேம் ெரி ஧ளர்க்க switch கூற்று கு஫ழப்஧ளக 

உதவும்.  
கட்ைல஭ அலநப்ன௃: 

switch(expression)  

{ 

   case label1: statement 1; break;  

   case label2: statement 2; break;  

   case labeln; statement N; break;  

   default: statement;  

} 

 switch கூ஫று அலடப்ப்ன௃க் கு஫ழக்குள் உள்஭ ககளலயலன இனக்கும். அதன் 
யில஭லய case label ” உடன் எப்஧ிட்டு பெனல்஧டுத்தும். ஌கதனும் என௉ case label 
ெநம் ஋஦ில் அந்த கூற்றுகல஭ இனக்கும். ஋ந்த case labels கல௃ம் 
ப஧ளன௉ந்தயில்ல஬பன஦ில் default கூற்று இனங்கும். ஌கதனும் என௉ ப஧ளன௉த்தநள஦ 
கதர்வு இனக்கப்஧ட்ட஧ின் break கூற்ல஫ ஧னன்஧டுத்தழ switch கூற்஫ழ஬ழன௉ந்து 
பய஭ிகன஫஬ளம். 
஋.கள: switch(grade)  

{  

case 1: document.write("Your Grade is Outstanding.."); break;  

case 2: document.write("Your Grade is Excellent.."); break;  

case 3: document.write("Your Grade is Good.."); break;  

case 4: document.write("Your Grade is Satisfactory.."); break;  

default: document.write("Your Grade Poor and have to re-appear Exam..");  

}  
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3. 10 எண்கல஭ தய஭ினீடு தசய்யதற்கா஦ ஛ாயாஸ்கிரிப்ட் ஥ிபல஬ எழுதுக. 
஥ிபல்: 

<Html>  

<Head>  

<Title> Program to display 10 numbers using while loop</title>  

<Head>  

<Body>  

<script language= "java Script" type = "text / javaScript")  

document write ("<h2> Using while statements </h2>")  

var n = 1; 

while(n<=10) 

{  

document write (n+ " " );  

n = n+1; 

}  

</script>  

</body>  

</Html> 

 தய஭ினீடு: 1 2 3 4 5 6 7 8 9 10 

4. கீமமப௅ள்஭ ஥ிப஬ின் தய஭ினீட்லை எழுதுக.  
<Html>  

<Head>  

<Title> for statement</title>  

</Head>  

<Body>  

<script language= "java Script" type = "text / javaScript")  

var no1= prompt ("Please enter table you want:", "0" );  

document write ("<h2> Multiplication for your need </h2>")  

for (Var no2= 0; no2<=10; no2++)  

{  

document write (no1+ "x" + no2+ "=" + no1+no2+ "<br>);  

}  

</script>  

</body>  

</Html> 

தய஭ினீடு: Please enter table you want: 6 

Multiplication for your need 

6 x 0 = 60 

6 x 1 = 61 

6 x 2 = 62 

6 x 3 = 63 

6 x 4 = 64 

6 x 5 = 65 

6 x 6 = 66 

6 x 7 = 67 

6 x 8 = 68 

6 x 9 = 69 

6 x 10 = 610 
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஧ாைம் 16. ஛ாயா எழுத்து யடிய தசனற்கூறுகள் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. அ஭ன௃ன௉க்கள் இவ்யள஫ளக பெனல்஧டுகழ஫து 
அ) உள்஭லந நா஫ி   ஆ) இ஦க்குழு நள஫ழ 
இ) ககளப்ன௃ நள஫ழ    ஈ) பதளகுதழ நள஫ழ 

2. ன௅ன்யலபனறுக்கப்஧ட்ட பெனற்கூறுகள் ஧ின்யன௉நளறு அலமக்கப்஧டுகழ஫து. 
அ) த௄஬க தசனற்கூறுகள்   ஆ) கெநழப்ன௃ பெனற்கூறுகள் 
இ) ஆலணகள்    ஈ) கட்டல஭கள் 

3. ஥ீண்ட ஥ழபல்கள் ெழ஫ழன ஧ிரிவுக஭ளகப் ஧ிரிக்கப்஧டுயது 
அ) கூறுகள்   ஆ) பதளகுதழ   இ) கணங்கள்   ஈ) குழு 

4. கவழ்கண்டயற்றுள் ஋து ஥ழபல஬ கூறுக஭ளக்க ஥ழப஬ன௉க்கு அனுநதழ அ஭ிக்கழ஫து? 
அ) நூ஬க பெனற்கூறுகள்   ஆ) ஧ன஦ர் யலபனறுக்கும் தசனற்கூறுகள் 
இ) இனல்ன௃ பெனற்கூறுகள்  ஈ) ெளதளபணநள஦ பெனற்கூறுகள் 

5. ஧ின்யன௉ய஦யற்றுள் ஋து நறு஧ன஦ளக்கத்லதனேம், ஥ழபல் பத஭ிலயனேம் 
கநன்஧டுத்துகழ஫து? 
அ) தசனற்கூறுகள்  ஆ) கூறுகள்  இ) கணங்கள்  ஈ) ஆலணகள் 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஛ாயாஸ்கிரிப்ட் தசனற்கூறு என்஫ால் என்஦? 

 பெனற்கூறு ஋ன்஧து ஜளயளஸ்கழரிப்ட் ஋ழுத்து யடிய கு஫ழன௅ல஫ 
பதளகுதழனளகும்.  

 இது என௉ன௅ல஫ யலபனறுக்கப்஧ட்டு ஧஬ன௅ல஫ பெனல்஧டுத்தப்஧டுகழ஫து. 
2. தசனற்கூ஫ின் ஧னன்஧ாடு னாது? 

 என௉ கு஫ழப்஧ிட்ட பெனலுக்கள஦ கு஫ழன௅ல஫லன உல஫ப஧ளதழனளக்கம் 
பெய்யதற்கு பெனற்கூறுகள் ஧னன்஧டுகழன்஫஦.  

 கநலும், எகப கூற்றுகல஭ தழன௉ம்஧ தழன௉ம்஧ நளற்றுலபக஭ளக தட்டச்சு 
பெய்யலத தடுக்க ெழ஬ பெனற்கூறுகள் ப஧ளதுயள஦ பெனலுக்கு 
யலபனறுக்கப்஧ட்டுள்஭து.  

 என௉ கு஫ழப்஧ிட்ட கயல஬க்கள஦ கு஫ழன௅ல஫லன என௉ இடத்தழல் லயப்஧தன் 
னெ஬ம் நறு஧ன஦ளக்கன௅ம், ஥ழபல் பத஭ிவும் கநம்஧டுத்தப்஧டுகழ஫து. 

3. கு஫ிப்பு யலபக- த௄஬க தசனற்கூறுகள். 
 ஌ற்க஦கய ஜளயளஸ்கழரிப்ட் நூ஬கத்தழல் யலபனறுக்கப்஧ட்டுள்஭ 

பெனற்கூறுகள் ன௅ன் யலபனறுக்கப்஧ட்ட பெனற்கூறுகள் ஋஦ப்஧டும்.. இலத 
நூ஬க பெனற்கூறுகள் ஋ன்றும் அலமக்க஬ளம்.  

 alert(), isNum(), toUppercase (), toLower case (), Lenth(), prompt(), write() க஧ளன்஫லய 
ன௅ன் யலபனறுக்கப்஧ட்ட பெனற்கூ஫ளகும். 

4. கு஫ிப்பு யலபக – ஧ன஦ர் யலபனறுக்கும் தசனற்கூறுகள். 
 ஧ன஦ர் யலபனறுக்கும் பெனற்கூறுகள் ஥ழபல஬ ெழறு கூறுக஭ளக்க ஥ழப஬ன௉க்கு 

அனுநதழ அ஭ிக்கழ஫து.  
 ப஧ன௉ம்஧ள஬ள஦ கணி஦ி ஥ழபல்கள் ஥ழகழ் உ஬க ெழக்கல்கல஭ தீர்க்க 

கயண்டினின௉ப்஧தளல் கணி஦ி ஥ழல஦யகத்தழல் அதழக ஥ழல஦யகத்லத ஋டுத்துக் 
பகளள்யகதளடு பெனல்஧டுத்துயதற்கு அதழக க஥பத்லதனேம் ஋டுத்துக் 
பகளள்கழ஫து.  

 ஋஦கய, ஥ீண்ட ஥ழபல்கள் ெழறு ஧ி஭வுக஭ளக ஧ிரிக்கப்஧ட்டு அலய கூறுகள் 
அல்஬து பதளகுதழகள் ஋ன்஫லமக்கப்஧டுகழன்஫஦. 

5. தசனற்கூ஫ின் கட்ைல஭னலநப்பு எழுதுக. 
தசனற்கூறு கட்ைல஭ அலநப்பு:  

Function function-name(parameters list)  

{  

Declaration of variable 

Executable statements;   

} 
 

஋.கள:  function sum(x,y)  
{  

var m=x+y;  

return m;  

} 
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஧ாைம் 17 . கணிப்த஧ா஫ி ஥ன்த஦஫ி நற்றும் இலணனப் ஧ாதுகாப்பு 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. கவழ்க்கண்ட஦யற்஫ழல் ஋து பெனல்ன௅ல஫, ஧னிற்ெழ நற்றும் நதழப்ன௃டன் 
பதளடர்ன௃லட னது? 
அ. உரிலநனில்஬ள ஥க஬ளக்கம்  ஆ. ஥ழபல்கள் 
இ. ஥ச்சு ஥ழபல்கள்    ஈ. கணிப்த஧ா஫ி ஥ன்த஦஫ி 

2. யணிக ஥ழபல்கல஭ ப஧ளது ெட்ட யிகபளதநளக ஧னன்஧டுத்துயது 
அ. இ஬யெ ப஧ளன௉ள்  ஆ. மயர்ஸ் 
இ. இ஬யெ பநன்ப஧ளன௉ள் ஈ. பநன்ப஧ளன௉ள் 

3. கவழ்கண்டயற்றுள் ஋து கணிப்ப஧ள஫ழ ஥ழபல்க஭ின் கதலயனில்஬ளநல் தளக஦ 
ப஧ன௉க்கழக் பகளள்஭வும் நற்றும் இலணத்துக் பகளள்஭வும் பெய்னேம்? 
அ. ஥ச்சு஥ிபல்  ஆ. யளர்ம்ஸ் இ. ஸ்ல஬கயர் ஈ. ட்கபளஜன் 

4. கவழ்கண்டயற்஫ழல் ஋து ஧ன஦ர் இலணன த஭த்லத ஧ளர்லயனிடுயலத 
கண்களணிக்கழ஫து? 
அ. ஸ்ல஧மயர் ஆ. குக்கழகள் இ. யளர்ம்ஸ்  ஈ. ட்கபளஜன் 

5. கவழ்கண்டயற்஫ழல் ஋து தீங்கழலமக்கும் ஥ழபல்கள்? 
அ. யளர்ம்ஸ்  ஆ. ட்கபளஜன் இ. ஸ்ல஧கயர்  ஈ. குக்கிகள் 

6. கணிப்ப஧ள஫ழ யல஬ப்஧ின்஦ல் யமழனளக உள்நுலமனவும், பய஭ிகன஫வும், 
ெநழக்லைகல஭ கண்களணிக்கவும் கட்டுப்஧டுத்தவும் யலக பெய்யது 
அ. குக்கழஸ்  ஆ. ஥ச்சு஥ழபல் இ. ஧னர்யால்  ஈ. யளர்ம்ஸ் 

7. ெழ஧ர் ஋ழுத்தலத த஦ி ஋ழுத்தளக நளற்஫ம் பெய்னேம் ன௅ல஫ 
அ. கு஫ழனளக்கம்  ஆ. நல஫ கு஫ினாக்கம் 
இ. ஥ச்சு ஥ழபல்கள்  ஈ. ஧ிபளக்றழ கெலயனகம் 

8. இ- யணிகம் ஋ன்஧து 
அ. நின்஦ணு யணிகம்  ஆ. நழன்஦ணு தபவு நளற்஫ம் 
இ. நழன்ெளப தபவு நளற்஫ம் ஈ. நழன்ெளப யணிகநனநளக்க 

9. கதலயனற்஫ நழன்஦ஞ்ெல் அடுத்தயர்கல௃க்கு ஧஫ழநளற்஫ம் பெய்தல் 
அ. ஊமல்  ஆ. ஸ்ம஧ம் – நின்஦ஞ்சல் குப்ல஧கள் 
இ. கநளெடி  ஈ. ஸ்ன௄஧ிங் (சுன௉஭ளக்கம்) 

10. ஧஫ழநளற்஫த்தழற்கள஦ ெட்ட அனுநதழலன பெனல்஧டுத்துயது 
அ. நின்஦ணு தபவு உள் ஧஫ிநாற்஫ம் ஆ. நழன்஦ணு தபவு ஧ரிநளற்஫ம் 
இ. நழன்஦ணு தபவு நளற்஫ம்   ஈ. இலணன ெட்டம் 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஹார்யஸ்டிங்  என்஫ால் என்஦? 

 ெட்ட யிகபளதநளக அடுத்த ஧ன஦ரின் ஧ன஦ர் ப஧னர் நற்றும் கடவுச்பெளல்ல஬ 
கெகரித்து ஧ன஦ரின் கணக்குக஭ில் நுலமந்து ஧ன஦லடதல் அபண் உலடத்தல் 
஋஦ப்஧டும். 

2. யார்ஸ் என்஫ால் என்஦? 
 ெட்டயிகபளதநளக ப஧ளதுநக்கல௃க்கு கழலடக்கக்கூடின பநன்ப஧ளன௉ள்கள் யளர்ஸ் 

஋஦ப்஧டும். 
3. கிபாக்கிங் ஧ற்஫ி சிறுகு஫ிப்பு யலபக. 

 ெட்டயிகபளதநளக ஧ி஫பது ஧ன஦ர் ப஧னர் நற்றும் கடவுச் பெளல்ல஬ உலடத்து 
கணிப்ப஧ள஫ழ அல்஬து ஧ிலணனத்தழல் நுலமயது கழபளக்கழங் ஋஦ப்஧டும். 

4. இபண்டு யலகனா஦ இலணனத஭ தாக்குதல் ஧ற்஫ி எழுதுக. 
 ஥ச்சு ஥ழபல்: ஥ச்சு ஥ழபல்கள் தன்ல஦ தளக஦ நீண்டும் நீண்டும் என௉ 

கணிப்ப஧ள஫ழனி஬ழன௉ந்து நற்ப஫ளன௉ கணிப்ப஧ள஫ழக்கு ஧ி஫ ககளப்ன௃கல௃டன் 
இலணந்து ஧பவுகழ஫து. ட்கபளஜன் என௉ ஥ச்ெ ஥ழபல் ஆகும். 

 யளர்ம்ஸ்: கணி஦ி ஥ழபல்க஭ின் உதயினின்஫ழ சுனநளக தழன௉ம்஧ தழன௉ம்஧ யந்து 
இலணத்துக் பகளள்ல௃ம். இலய பதளடர்ந்து ஧ளதழப்ன௃க்குள்஭ளக்கழ 
஧஬ய஦ீங்கல஭ கண்டு஧ிடித்து யளர்ம்றழன் ஥ழப஬ன௉க்கு பதரியிக்கழன்஫து. 

5. குக்கி என்஫ால் என்஦? 
 இலணனத்லத ஧ளர்லயனிடும் க஧ளது, ஧ன஦ரின் இலணன உ஬யினில் இன௉ந்து 

அனுப்஧ப்஧டும் என௉ ெழ஫ழன துண்டு தபவு ஧ன஦ரின் கணிப்ப஧ள஫ழ யன்யட்டில் 
கெநழக்கப்஧டும். இந்த ெழ஫ழன துண்டு தபவு குக்கழ ஋஦ப்஧டும். 

 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஧னர்யா஬ின் ஧ங்கு ஧ற்஫ி எழுதுக? 

 ஧னர்யளல் ஋ன்஧து கணிப்ப஧ள஫ழ யல஬னலநப்ன௃ ஧ளதுகளப்஧ின் அடிப்஧லட 
அலநப்஧ளகும். இலய ஧ளதுகளப்ன௃ அடிப்஧லடனில் உள்யன௉ம் நற்றும் பய஭ிச் 
பெல்லும் யல஬னலநப்ன௃ க஧ளக்குயபத்து க஧ளன்஫யற்ல஫ கண்களணித்து 
கட்டுப்஧டுத்தும்.  

யலககள்: 
 இலணன அடிப்஧லடனி஬ள஦ ஧னர்யளல் 
 கலளஸ்ட் (Host) அடிப்஧லடனி஬ள஦ ஧னர்யளல் 

2. கு஫ினாக்கம் நற்றும் நல஫கு஫ினாக்கம் ஧ற்஫ி எழுதுக. 
 கு஫ழனளக்கம் நற்றும் நல஫கு஫ழனளக்கம் ஋ன்஧து அங்கவகரிக்கப்஧ட்ட ஥஧ர்கள் 

நட்டுகந தகயல஬ அணுக ன௅டினேம் ஋ன்஧லத உறுதழப்஧டுத்தும். 
 கு஫ழனளக்கம்: ஋஭ின தபலய ெவபற்஫ (அ) ெழலதவுற்஫ தபயளக (லெ஧ர் உலப) 

நளற்றும். 
கு஫ழனளக்கத்தழன் யலககள்:1. ெநச்ெவர் கு஫ழனளக்கம்  2. ப஧ளது கு஫ழனளக்கம் 

 நல஫கு஫ழனளக்கம்: லெ஧ர் உலபலன ஋஭ின தபயளக நளற்஫ம் பெய்னேம். 
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3. நல஫ப௃க (proxy) மசலயனகம் - யியரி. 
 என௉ நல஫ன௅க (proxy) கெலயனகம், இறுதழ ஧ன஦ர்கல௃க்கும், யல஬ 

கெலயனகத்தழற்கும், இலடனில் இலடத்தபகபளக பெனல்஧டுகழன்஫஦. 
 ககளப்ன௃ இலணப்ன௃, யல஬ப்஧க்கம் அல்஬து கயகநள஦ கயறு஧ட்ட 

கெலயனகத்தழ஬ழன௉ந்து கழலடக்கும் ஧ி஫ ய஭ங்கள் க஧ளன்஫ ெழ஬ கெலயகல஭ 
஧ன஦ள஭ர் நல஫ன௅க கெலயனளகத்தழடம் கயண்டுகழ஫ளர்.  

 ஧ிபளக்றழ கெலயனகம் ககளரிக்லகலன ஆபளய்கழ஫து. ஥ம்஧கத்தன்லநலன 
ஆபளய்ந்து அதன்஧டி ககளரிக்லக யமங்கப்஧டுகழ஫து.  

 ஧ிபளக்றழ கெலயனகங்கள் ப஧ளதுயளக அடிக்கடி ஧ளர்லயனிடும் த஭ 
ன௅கயரிகள் அதன் தற்கள஬ழக கெநழப்஧ில் கநம்஧ட்ட ஧தழ஬஭ிப்ன௃ க஥பத்தழற்கு 
யமழயகுக்கும். 

4. கணி஦ி  ஧ன஦ர் ஧ின்஧ற்றும் யமி காட்டுதல்கள் ஧ற்஫ி எழுதுக? (அ) ஥ன்த஦஫ி 
யமிகாட்டுதல்கள் னாலய? 
 ம஥ர்லந: இலணனத்லத ஧னன்஧டுத்தும் ஧ன஦ர் உண்லநனேள்஭யபளக 

இன௉த்தல். 
 ஥ம்஧ிக்லக: ஧ன஦ர் அங்கவகரிக்கப்஧டளதயர்க஭ிடம் ன௅க்கழன தகயல்கல஭ 

஧ரிநளற்஫ம் பெய்னளநல் இன௉த்தல். 
 நரினாலத: நற்஫ ஧ன஦ன௉க்கு உள்஭ த஦ி உரிலநக்கு உரின நரினளலதலன 

எவ்பயளன௉ ஧ன஦ன௉க்கும் பகளடுத்தல். 
 ததாமில்ப௃ல஫: பதளமழல்ன௅ல஫னில் எவ்பயளன௉ ஧ன஦ன௉ம் பதளமழல் ன௅ல஫ 

஥டத்லதனேடன் இன௉த்தல். 
 சட்ைத்திற்கு கீழ்஧டிதல்: இலணன ெட்டத்தழற்கு கவழ்஧டிதல். 
 த஧ாறுப்பு: ஧ன஦ர் பெய்னேம் பெனலுக்கு அயகப ப஧ளறுப்க஧ற்றுக் பகளள்ல௃தல் 

5. த஥஫ி ப௃ல஫ சிக்கல் என்஫ால் என்஦? த஧னர்கல஭ எழுதுக. (அ) ஥ன்த஦஫ி 
஧ிபச்சல஦கள் னாலய? 

 ஥ன்ப஦஫ழ ெழக்கல் ஋ன்஧து, த஦ி ந஦ிதனுக்ககள அல்஬து ஥ழறுய஦த்துக்ககள ெழக்கல் 
உண்டளகும்க஧ளது ெரினள஦லதகனள(஥ன்ப஦஫ழ) அல்஬து தய஫ள஦லதகனள 
(஥ன்ப஦஫ழ அல்஬ளதது) நதழப்஧ிடுயது ஆகும். 
஥ன்த஦஫ி ஧ிபச்சல஦கள்: 
 இலணன குற்஫ம்  
 பநன்ப஧ளன௉ள் உரிலநனில்஬ள஥க஬ளக்கம்  
 அங்கவகரிக்கப்஧டளத அணுகுதல்  
 கலக்கழங்  
 கணிப்ப஧ள஫ழலன ஧னன்஧டுத்தழ கநளெடி பெய்தல்  
 ஥ச்சு ஥பல் னெ஬ம் ஥ளெகயல஬ 
 கணிப்ப஧ள஫ழ னெ஬ம் தய஫ள஦ கூற்று உன௉யளக்குதல். 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ி ஧னன்஧டுத்தும் ம஧ாது ஏற்஧டும் ஧ல்மயறு குற்஫ங்கள் னாலய? 

குற்஫ம் தசனல்஧ாடுகள் 
தீம்ப஧ளன௉ள் (Malware) தீம்ப஧ளன௉ள் ஋ன்஧து ஧ல்கயறு இலணனயமழ பதளந்தபவு 

பெனல்க஭ள஦ தழன௉டுதல், நல஫னளக்கம் அல்஬து 
ன௅க்கழனநள஦ தபவுகல஭ ஥ீக்கம் பெய்தல், நளற்றுதல் 
அல்஬து கணிப்ப஧ள஫ழனின் பெனல்஧ளடுகல஭ ஥டத்துதல், 
பெனல்஧ளடுகல஭ அனுநதழ இல்஬ளநல் கண்களணித்தல் 
க஧ளன்஫யற்ல஫ பெய்னேம் என௉ தீங்கழலமக்கும் ஥ழப஬ளகும். 

அபண் உலடத்தல் 
(Harvesting) 

ெட்டயிகபளதநளக அடுத்த ஧ன஦ரின் ஧ன஦ர் ப஧னர் 
நற்றும் கடவுச் பெளல்ல஬ கெகரித்து ஧ன஦ரின் 
கணக்குக஭ில் நுலமந்து ஧ன஦லடதல் அபண் உலடத்தல் 
஋஦ப்஧டும். 

ஸ்க஧ம் (Spam) கதலயனற்஫ நழன்஦ஞ்ெல஬ அதழக ஋ண்ணிக்லகனில் 

இலணனத஭ ஧ன஦ர்கல௃க்கு அனுப்ன௃தல். 
 

2. க஭யாைல் என்஫ால் என்஦? க஭யாை஬ின் யலககள் னாலய? நற்றும் அலத 
எவ்யாறு தடுக்க஬ாம்? 
 பநன்ப஧ளன௉ள் தழன௉ட்டு ஋ன்஧து என௉ த஦ிப்஧ட்ட அல்஬து என௉ ஥ழறுய஦த்தளல் 

ன௅த஬ழல் உன௉யளக்கப்஧ட்ட பநன்ப஧ளன௉ல஭ ஧தழப்ன௃ரிலந ப஧஫ளநல், 
ெட்டயிகபளதநளக கு஫ழனடீுகள், தகயல்கள், ஥ழபல்கள் நற்றும் ஧ி஫ தகயல்கல஭ 
தழன௉டுதல். அங்கவகளபம் இல்஬ளநல், ஥கல்க஭ின் ஧ிபதழகல஭ உன௉யளக்கழ இந்த 
தபலய பெளந்த ஥஬னுக்களக, அல்஬து யணிக இ஬ள஧த்தழற்களக 
஧னன்஧டுத்துயது ஆகும்.  

 ஋஭ிலநனள஦ பெளற்க஭ில் பநன்ப஧ளன௉ள் தழன௉ட்டு ஋ன்஧து ‚பநன்ப஧ளன௉ள் 
அங்கவகரிக்கப்஧டளத ஥கல்‛ ஆகும். 

யலககள்: 
 ஧தழப்ன௃ரிலந ப஧ற்஫ ஥ழபல்கல஭ ஥கப஬டுத்து யிற்஧ல஦ பெய்தல்  
 இலணனத஭த்தழன் யமழனளக ெட்டயிகபளதநளக ஧தழயி஫க்கம் பெய்தல் 
தநன்த஧ாருள் திருட்லை தடுக்கும் அணுகுப௃ல஫: 
 பநன்ப஧ளன௉ள் தழன௉ட்லட தடுக்க பநன்ப஧ளன௉ள் ஧கழர்நள஦ம் யமங்கப்஧டுகழ஫து.  
 இந்த ஥லடன௅ல஫னில் ஧தழப்ன௃ரிநம் ப஧ற்஫ ஧ன஦ர் நற்஫ ஧ன஦ன௉க்கு 

஥கல்கல஭ யமங்க஬ளம். அவ்யளறு ஥கல்கல஭ ப஧றும் ஧ன஦ர்கள் அதற்கள஦ 
஧தழவு கட்டணத்லத ெளர்ந்த ஥ழறுய஦த்தழற்கு பெலுத்த கயண்டும். 
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3. இலணனத஭ தாக்குத஬ின் யலககள் னாலய? 
இலணனத் 

தாக்குதல்கள் 
தசனல்஧ாடுகள் 

஥ச்சு ஥ழபல் ஥ச்சு ஥ழபல்கள் தன்ல஦ தளக஦ நீண்டும் நீண்டும் என௉ 
கணிப்ப஧ள஫ழனி஬ழன௉ந்து நற்ப஫ளன௉ கணிப்ப஧ள஫ழக்கு ஧ி஫ 
ககளப்ன௃கல௃டன் இலணந்து ஧பவுகழ஫து. ட்கபளஜன் என௉ ஥ச்ெ 
஥ழபல் ஆகும். 

யளர்ம்ஸ் கணி஦ி ஥ழபல்க஭ின் உதயினின்஫ழ சுனநளக தழன௉ம்஧ தழன௉ம்஧ 
யந்து இலணத்துக் பகளள்ல௃ம். இலய பதளடர்ந்து 
஧ளதழப்ன௃க்குள்஭ளக்கழ ஧஬ய஦ீங்கல஭ கண்டு஧ிடித்து 
யளர்ம்றழன் ஥ழப஬ன௉க்கு பதரியிக்கழன்஫து. 

ஸ்ல஧கயர் கணிப்ப஧ள஫ழனின் இலணப்ன௃க்கல஭ தழ஫க்கும் க஧ளது 
தள஦ளககய கணிப்ப஧ள஫ழனில் ஥ழறுயப்஧ட஬ளம். 
இலணப்ன௃க஭ில் கழ஭ிக்பெய்னேம் க஧ளதும் ஧ளதழக்கப்஧ட்ட 
பநன்ப஧ளன௉ல஭ ஧தழயி஫க்கம் பெய்யதன் னெ஬ன௅ம் 
ஸ்ல஧கயர் ஥ழறுயப்஧ட஬ளம்.. 

கபன்ெம்கயர் என௉ கணிப்ப஧ள஫ழனில் இலணன தளக்குதல்க஭ில் 
பதளடங்குயதற்கு ஧ி஫கு ஧ணம் ககளரி தீங்கு இலமக்கத் 
தழட்டநழடுதல். இந்த தீம்ப஧ளன௉ள் குற்஫யள஭ி 
கல௃க்கழலடகன ப஧ன௉கழன ன௅ல஫னில் ஧ிப஧஬நலடந்து 
எவ்பயளன௉ யன௉டன௅ம் ஥ழறுய஦ங்கல௃க்கு நழல்஬ழனன் 
கணக்கள஦ பெ஬வுகல஭ ஌ற்஧டுத்துகழ஫து.. 

ஃ஧ரீழங் 

 
ஃ஧ரீழங் ஋ன்஧ து கணிப்ப஧ள஫ழ குற்஫த்தழன் என௉ யலக ஆகும். 

கடவுச்பெளல் நற்றும் கழபபடிட் களர்டு ஋ண்கள் உள்஭டீ்ட 

஧ன஦ர் தபலய தழன௉டுயதற்கு ஧னன்஧டுத்தப்஧டும். 
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஧ாைம் 18 . கணிப்த஧ா஫ினில் தநிழ் 
2 நதிப்த஧ண் யி஦ாக்கள்: 

1. தநிமில் மசலயகல஭ யமங்கி யரும் மதடுத஧ா஫ிகல஭ ஧ட்டின஬ிடுக. 
 கூகுள் (Google)  
 ஧ிங் (Bing) 

2. ஆண்ட்பாய்டு ஧னன்஧ாடு யிலசப்஧஬லக என்஫ால் என்஦? 
 ஆண்ட்பளய்டு ஧னன்஧ளடு யிலெப்஧஬லக ஋ன்஧து ஸ்நளர்ட் லகப்க஧ெழக஭ில், 

ஆண்ட்பளய்டு இனக்க அலநப்஧ில், ஆங்கழ஬ எ஬ழனினல் ன௅ல஫னில் 
஧னன்஧டுத்தப்஧டும் இலடன௅க யிலெப்஧஬லக பநன்ப஧ளன௉ள் ஆகும். 

஋.கள: பெல்஬ழ஦ம், ப஧ளன்நடல் 
3. தநிழ் தநன்த஧ாருள் ஧னன்஧ாட்டு தநாமி - சிறு கு஫ிப்பு யலபக. (அ) தநிழ் 

஥ிப஬ாக்க தநாமி - கு஫ிப்பு யலபக. 
 தநழமழல் ஥ழப஬ளக்க பநளமழ யடியலநக்கும் ன௅னற்ெழகள் ஥லடப஧ற்று 

யன௉கழன்஫஦.  
 அதன் ன௅னற்ெழனளக, ல஧த்தளன் ஥ழப஬ளக்க பநளமழலன அடிப்஧லடனளக 

பகளண்டு, ன௅தல் தநழழ் ஥ழப஬ளக்க பநளமழ ‚஋மழல்” யடியலநக்கப்஧ட்டுள்஭து.  
 இந்த ஥ழப஬ளக்க பநளமழலன பகளண்டு ெழ஫ழன அ஭யி஬ள஦ ஥ழபல்கல஭ 

தநழமழக஬கன ஋ழுத ன௅டினேம். 
4. TSCII என்஫ால் என்஦? 

 கணிப்ப஧ள஫ழ உள்஭ிட்ட நழன்஦ணு ெளத஦ங்க஭ில் ஋஭ிதழல் லகனள஭ 
ப஧ளன௉த்தநள஦ என௉ கு஫ழனடீ்டு ன௅ல஫ ஧ற்஫ழன ஆய்யில், ஥நது தநழழ் 
பநளமழலன லகனள஭ உன௉யளக்கப்஧ட்ட ன௅தல் கு஫ழனடீ்டு ன௅ல஫ தளன் TSCII 

(Tamil Scirpt Code for Information Interchange).  

 இந்த கு஫ழனடீ்டு ன௅ல஫லன தழுயிகன தநழழுக்கள஦ Unicode ன௅ல஫ 
யடியலநக்கப்஧ட்டது. 

5. தநிழ் இலணன கல்யிக்கமகம்  சிறு கு஫ிப்பு யலபக. 
 தநழலம உ஬பகங்கும் இலணனத்தழன் யமழகன பகளண்டு கெர்க்கும் க஥ளக்குடன், 

2001ம் ஆண்டு ஧ிப்பயரி 17ம் ஥ள஭ில், தநழழ் இலணனப் ஧ல்கல஬க் கமகம், 
தநழமக அபெளல் பதளடங்கப்஧ட்டது.  

 இந்஥ழறுய஦ம் இலணனத்தழன் யமழகன தநழழ் பநளமழ, தநழமர் க஬ளச்ெளபம், 
஧ண்஧ளடு க஧ளன்஫யற்ல஫ உ஬பகங்கும் யளழும் நக்கல௃க்கு 
யமங்குயதற்களகவும், நமல஬னர் கல்யி ன௅தல் ஧ட்டப் ஧டிப்ன௃ யலப ஧ல்கயறு 
கல்யித் தழட்டங்கல஭ பெனல்஧டுத்தழ யன௉கழன்஫து. 
 

 

 

 

 

 

 

 

 

 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 82 

 

 
 

இரு஭ில் இருந்து 
தய஭ிச்சத்லதக் காட்டுயமத கல்யி. 

கல்யி கற்஧து தயம், 
அலத கற்஧ிப்஧து யபம். 
னார் லகயிட்ைாலும், 

கற்஫து லகயிைாது உல஦. 
அத்தலகன கல்யிலனப் த஧ற்று 

யாழ்க்லகனில் மநலும் மநலும் ய஭ப 

யாழ்த்துக்கள்.. 
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கணி஦ி ஧னிற்று஥ர் ஥ில஬ - I 
அபசு மநல்஥ில஬ப்஧ள்஭ி,  

சர்க்கார்சாநக்கு஭ம்,  
மகானம்புத்தூர் – 641107. 
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